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1.0 Introduction to PES  

State Highway Agencies (SHAs) need to estimate costs and prepare projects before they advertise 
proposals for bid letting. The Trns•port Proposal and Estimates System (PES) was developed to help 
the SHA define projects, estimate item prices, and create proposals, bid-letting packages, and 
standard reports for the pre-letting phase.  

PES helps you to manage all the complexities of a large construction project, including 
multiple funding sources, differing engineering and contingency (E&C) percents, non-
participating items, alternate item and item-category specifications, identification of 
special provisions and supplemental specifications, and addendum processing.   

Used with the Trns•port BAMS/DSS database, PES can access item price information and produce 
bid-based item price estimates.   

PES interfaces with the Trns•port Letting and Award System (LAS), which manages the bid letting 
phase.  You can enter proposal changes (addendums) in PES after the proposals have been 
distributed but before an award has been made.  These changes will automatically be integrated into 
the bid analysis and tabulation programs and properly displayed in the contract schedule.  

 
Figure 1- 1. PES Application Banner 

1.1 PES Workflow  

The Trns•port PES workflow is as follows:  

Enter the project header  

The initial step in defining a set of project estimates in Trns•port PES is to enter the 
header information for the project. You can enter header information defining the project 
(for example, project control number and project description). You can batch load 
project header data from an external file.   

Interactive 
Process: Maintain Prime Projects 
Location:  Prime Projects List Window 

                 Add Prime Project Detail Window  
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Interactive 
Process: Maintain Projects 
Location:  Projects List Window 
 

Batch 
Process: Load Projects 
Location:  File Menu, Import Option 

Enter details about the project estimate  

After you enter the project header information, you can enter the project estimate 
information, which consists of categories of work (segments of work, such as bridge or 
roadway) and the work items for each category of work. You can also batch load 
project estimate data.   

Trns•port maintains master reference lists of work items and funds in the system. These 
reference lists might need periodic maintenance as new specification books or new items 
are issued and new funds become available.    

Interactive 
Process: Maintain Projects 
Location:  Tabbed Folder Change 

                 Projects List Window 
                 Categories List Window 
                 Funding List Window 
                 Items List Window 
                 Project Estimate Items Worksheet 
                 Counties List Window 
                 Pay Adjustment Index List Window 
 

Batch 
Process:  Load Project Estimate Data 
Location:  File Menu, Import Option 

Set estimated item prices   

There are several ways to set estimated item prices.  You can set prices interactively at 
the project item level or you can import item prices from CES.  For items where the 
prices are known they are entered manually in PES, where the prices are not known they 
will be imported from CES.  

Interactive 
Process:  Maintain Project Estimates 
Location:  Manage Project Estimates Menu 
 

 

Interactive 
Process:  Set Contract Price Estimates 
Location:  Manage Contract Proposals Menu 
                 Define Contract Proposals Submenu  

Introduction to PES                                                                               1-2 
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Interactive 
Process:  Load Contract Price Estimates 
Location:  Manage Contract Proposals Menu 

Define Contract Proposals Submenu  

 

Batch 
Process: Generate Project-Level Bid-Based Prices 
Location:  Projects List Window 

                 File Menu, Run Process Option  

Generate Preliminary Detail Estimates report  

This report details the estimate items and their groupings by category, fund, and unit. It 
documents the project cost estimate and identifies necessary funding sources to cover 
the estimated costs.  

Batch 
Process:  Generate Preliminary Detail Estimates 
Location:  Prime Projects, Projects or Proposals List Window, or Bid Letting List Window 
                 File Menu, Run Process Option 

Enter the proposal header  

After you complete the project estimates, you can define the proposal. The initial step in 
defining the proposal is to enter the proposal header information, such as contract ID, 
description, and DBE/WBE goals.  

Interactive 
Process: Add Proposal 
Location:  Proposals List Window 
                 Add Proposal Detail Window  

Enter proposal sites  

Proposal site information, such as specifying contract time, defines the proposal work 
sites. Trns•port supports three time methods: completion date, calendar days, and 
available days. You can use a special 00 site to define the contract time for the contract 
as a whole. The time component of a Cost Plus Time bid can be entered at the Proposal 
site level.  

Interactive 
Process: Add Site Location 
Location:  Proposals List Window 
                  Site Locations List Window 
                  Add Site Location Detail Windo 

Assign projects to the proposal  

After you define projects, you can assign them to the appropriate proposals. You can 
assign one or more projects to a proposal and you can assign projects from different 
prime projects to the same proposal. Typically NJ assigns one project to one proposal.  
Do not assign an individual project to multiple proposals.  

Interactive 
Process: Add Projects 
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Location:  Proposals List Window 
                 Proposal Project List 
                 Add Projects List Window 
Assign special provisions to the proposal  

Typically NJ does not have Special Provisions in proposals.  If there are special provisions 
in the proposal, you can assign them to the proposal.  

Trns•port maintains a master reference list of special provisions in the system. This 
reference list might need maintenance as new special provisions are developed.  

Interactive 
Process: Add Special Provisions 
Location:  Proposals List Window 
                 Special Provisions List Window 
                 Add Special Provisions List Window 

Generate proposal section and line numbers  

Trns•port provides an automated facility to generate proposal section and line numbers 
for the project estimates. For projects assigned to the proposal, Trns•port combines the 
project categories of work into proposal sections that are based on the category federal 
construction class. Trns•port combines project line items into proposal items according 
to item number.  

Rerun this process on a proposal whenever you add or delete categories or items from 
one of the proposal's member projects or you change the list of member projects for the 
proposal.  

Batch 
Process: Generate Section and Line Numbers 
Location:  Proposals List Window 
               File Menu, Run Process Option  

Generate Proposal Schedule reports  

After you define a proposal, you can run the Proposal Schedule reports.  These reports 
list the proposal-level items, which can be submitted to contractors for bids. A blank 
section is also provided for contractors to bid the number of days for each site in a Cost 
Plus Time bid.  Additional reports, for internal or external use can be generated as well.  

Batch 
Process: Generate Proposal Schedule 
Location:  Proposals List Window 
                 File Menu, Run Process Option  

Enter bid letting header  

After you define the proposals for a bid letting, you can enter the header information for 
the bid letting, such as bid letting number, location of letting, and time of letting.  

Interactive 
Process:  Add Bid Letting Package 
Location:  Bid Letting List Window 
                 Add Bid Letting Package Detail Window 
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Assign proposals to the bid letting  

You can assign proposals to a bid letting in the order that the proposals will be called. 
Each proposal assigned to the bid letting will be given a Call Number.  

Interactive 
Process: Add Letting/Proposal 
Location:  Bid Letting List Window 
                 Letting/Proposals List Window 
                    Add Letting/Proposal Detail Window 

1.2 Logging-on to the NJDOT Network 

Access to the PES application will be via a Citrix server or, if installed on a workstation, 
through the workstation.  This section outlines the hardware requirements and 
procedures for accessing the NJDOT network. 

1.2.1 System Requirements 

The minimum system requirements that a user will need to use Trns*port through Citrix 
are: 

• Pentium 3, 1GHz Processor 

• 256 Mb RAM 

• 10 Mb hard disk space 

• Microsoft Windows 2000 or XP 

• Internet Explorer 5.0 through 6.0, Service Pack 1 or Netscape 6.2 through 7.1 

High-speed connection to the internet (DSL, Broadband, T1, etc.)

1.2.2 Login Procedure 

In order to access the NJDOT network, a user needs a Citrix account and a PES 
Trns*port account. These will be provided by NJDOT.  For further assistance with 
obtaining the necessary user accounts, please email trnsport.support@dot.state.nj.us or 
call 609-530-3582. 

Steps for logging-in are:  

Login to Citrix 

• Access the link via an internal connection using the following link: 
https://dotfarm.njes.state.nj.us/Citrix/MetaFrame/auth/login.aspx 

The Citrix login window will open as shown in Figure 1-2. Enter the username and 
password that was provided for you by NJDOT. The domain is “njdot.” Note: The 
username field is not case-sensitive but the password field is. 
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Figure 1-2. Citrix Login Window 

Once logged-in you should be able to see the Citrix desktop, Figure 1-3. 

 

Figure 1-3. Citrix Desktop 

Once connected to the NJDOT network you may open the PES application by either 
double-clicking on the PES icon on the desktop or by navigating to the application from 
the Programs List by selecting from the Start menu Programs>AASHTO Client-Server 
Trns*port>PES 5.9b-1. 

PES displays an information window and then an Enter User Information window.  

 

 

 

 

 

 

 

    Figure 1-4.  Enter User Information Window 
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1.3 Changing Your Password 

To change your password, choose Change Password from the Utilities menu (see Figure 
1-5). 

 
Figure 1-5.  Utilities Menu 

Change password window as shown in Figure 1-6. 

 

Figure 1-6. Change Password Window 

Enter your old password, press TAB, enter your new password, press TAB, and enter your 
new password again for verification.  Click OK to change your password or CANCEL to close 
the window without changing your password. 

If you click OK, your password changes.  If you exit the software and attempt to log on 
using your old password, you receive an error message. 

If you forget your password or exceed the maximum number of login attempts allowed, 
please contact NJDOT PES Support at trnsport.support@dot.state.nj.us to reset your 
password. 

1.4 Using Online Help  

When you have PES running, you can use the online help system to find specific 
information and instructions for using the application. The online help window contains 
three tabs, each of which gives you a different tool for finding information.  

The Help Index window opens on the Contents tab, which is most useful when you 
already know the section for which you want Help. It is organized by category and 
displays the list of topics available in the Help system in a Windows Explorer type.  
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You can locate help topics by navigating the expandable/collapsible books and pages in 
the left pane of the window. A book represents a category of topics, and a page 
represents an individual topic. When you double-click on a book, it opens to reveal 
additional books and pages. To access a topic, double-click on the desired page and the 
topic information appears in the right pane of the Help window.   

The Index tab works like a traditional book index. It lists keywords or phrases 
alphabetically. The Index tab is particularly useful when you need to search for 
information on a specific topic and the exact wording of the topic is not known. To 
display a topic from the Index tab, click the Index tab and enter the first few letters of 
the desired search topic in the text box above the Index entry list. The list scrolls to 
reveal the topic that matches the keyword(s) you entered.  Click a topic in the list to 
display the information in the right pane of the Help window.  

The Search tab provides access to a rapid full-text search. To use the Search tab to find 
a specific topic, enter the search word in the Section 1 text box. Section 2 displays words 
that match the results of the preliminary search completed in Section 1.  If the overall 
search still needs to be narrowed, select the best match from the list in Section 2. 
Section 3 then displays a more specific list of topics.  Click the best topic match from the 
search results in Section 3 to display the information in the right pane of the Help 
window (see Figure 1-7 PES Help Window). 

 
Figure 1-7. PES Help Window 

1.5 Using Field Help  

Field help is available in Trns•port for any field into which you can enter data. To get 
more information about a field, right-click the field and select Field Help.  

To get field help about a field displayed in a grid (except calculated fields), click the 
column header with the right mouse button and select Field Help.  

1.6 Working with List, Tab, and Tabbed Folder Windows  

Trns•port displays information in three kinds of windows:  list, detail and tabbed folder.  
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Figure 1-8. List Window 

A list window (see Figure 1-8) is usually the first window you see when you begin a new 
task. List windows contain lists of records for a type of data, such as projects, proposals, 
or categories. You can browse list window information by clicking on the scroll bar 
buttons on the right or bottom of the window.  From a list window, you can select a 
specific record and open a detail window or a tabbed folder window.  

Detail windows contain fields and data associated with a specific record. Different kinds 
of data are contained in different detail windows (for example, funding, counties, and 
categories).  Detail windows allow you to add, change, or browse this information.  Much 
of the information that is available in detail windows is also available in tabbed folder 
windows.  

 
Figure 1-9. Tabbed Folder Window 

Introduction to PES                                                                               1-9 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

In a tabbed folder window, a different kind of information is available on each tab. You 
can move from tab to tab by clicking the tab labels.  When you click a tab, Trns•port 
makes that tab active, displaying it in the foreground with the tab label in bold text. Tabs 
with more than one screen of information contain option buttons that allow you to page 
through the individual screens.  

1.7 Adding, Changing, and Deleting Information  

In list windows you can use the right mouse button menu to add, change, delete, 
produce reports or perform other tasks.  Menu items on the right mouse button menu 
are context specific and will change as the data type in the list window changes.  

Detail and tabbed folder windows can be used in three modes:  add, change and browse. 
Add mode is used to add new records to the active list window. Change mode is used to 
change or add new information to an existing record in the active list window.  Browse 
mode is used to simply view the current information in an existing record in the active 
list window.  

The Add and Tabbed Folder Add commands open a window in which you can add 
information to create a new record.  The Change and Tabbed Folder Change commands 
open a window for the active record where you can modify information.  The Delete 
command deletes the selected record or records.  

Tabbed folder windows are a more convenient way to work with data than detail 
windows. This is because a tabbed folder allows you to access many different kinds of 
information associated with the record without leaving the tabbed folder window or 
opening additional windows, as you must when using detail windows.    

1.8 Using Tabbed Folder Grids, Lookups, and Detail Areas  

Some tabs in a tabbed folder window contain lists of data fields in a grid. You can resize 
and reorder the columns in a grid.  You can also sort the records displayed in a grid 
quickly by double clicking on the column header.  

A tab containing a grid also contains a standard Trns•port filter and a quick find box you 
can use to search selected single columns of data.  To use the quick find box, double-
click on the header of the column you want to search. Type the string of characters you 
want to find in the quick find box and Trns•port highlights the first row containing 
characters that match in the active column.  

 
Figure 1-10.  Using Grids 
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You can divide a grid into two regions that scroll independently of each other. This 
feature, known as “split horizontal scrolling,” allows you to leave one or more columns 
fixed in one half of the grid, while being able to scroll through the rest of the columns in 
the other half of the grid. To use this feature, position the mouse pointer over the small 
vertical black bar at the left end of the horizontal scroll bar (see Figure 1-10).  

 
Figure 1-11.  Split Grid 

The mouse pointer changes to a double-headed arrow.  Press and hold the left mouse 
button and drag the mouse to the right to create a new horizontal scrolling border. When 
you release the mouse button, you will have two independently scrolling regions in the 
grid (see Figure 1-11).  

Figure 1-12. Grid and Detail View 

Some tabs contain both a grid and a detail area (see Figure 1-12).  You can enter 
information on this type of tab in one of two ways:  
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Display the detail area by selecting Show Detail from the right mouse button menu and 
enter information into the fields of the detail area.  

Hide the detail area by selecting Hide Detail from the right mouse button menu and 
enter information directly into the cells of the grid.  

1.9 Filtering Information  

You can use Trns•port’s filter to compare and match information in order to find and list 
all the records that meet certain criteria.  You can filter data in a list window or in a 
lookup window for a detail window field (see Figure 1-13).  

 
Figure 1-13.  Filter Window 

To use a filter, click the   (FILTER) button on any list window to display a Filter 
window.  

You can click in the Column, Operator and Value fields to display a list of values from 
which you can choose the information you want filtered.  

Column  The Column field contains the names of the most commonly used columns in the table 
from which the list window is built. When you click on the down arrow in the column field, the list of 
columns to choose from will appear.  

Operator  The Operator field contains the operators equal to (=), greater than (>), less than (<), 
greater than or equal to (>=), less than or equal to (<=), not equal to (<>), Contains, Does Not 
(contain), and Like and Not Like (operators used for pattern matching) to narrow your filter.  

Value  The information you type in the Value field is the filter criterion you are 
using as a delimiter or are trying to match.    

1.9.1 Using the Advanced Filter  

You can also filter information using a more complex set of criteria.  Click the ADVANCED 
button in the Filter window and Trns•port displays the Advanced Filter. This window 
allows you to use numerous combinations of conditions to filter with various operators, 
values and logicals (see Figure 1-14).  
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Figure 1-14. Advance Filter Window 

Use the Advanced Filter window to build a set of conditions you want Trns•port to use to 
filter information.  This set of conditions consists of a series of “where conditions” 
combined with logical options, such as And/Or, (+ and (–.  

Create each where condition by choosing a value in each of the Column, Operator, and 
Value fields and then clicking the ACCEPT button.  

Column  This field contains the names of all the columns in the table from which the list window 
is built.  When you click on the down arrow in the column field, the list of columns to choose from will 
appear.  

Operator  This field contains all the operators found in the basic filter.  

Value  The information you type in this field is the filter criterion you are using as a delimiter or are 
trying to match.  

You can use * as a wild card to match any value or ? to match a single character only with the LIKE or 
NOT LIKE operators.  

If you want to search for a value that contains the characters * or ?, you 
can use the backslash character (\) just before the * or ?. For example, 
Quantity \* Item would search for Quantity * Item.  If you want to 
search for the \ character, put a backslash in front of the \; for example 
use \\job to search for \job.) 

Trns•port displays each where condition in the Select Where area of the Advanced Filter 
window in the order that you created them.  After all the where conditions you need for 
your filter are listed, combine them into a “where clause” by clicking in the And/Or 
column to the right of each condition line and selecting the appropriate option from the 
menu for each line.  Typically, all lines requiring Or should be combined before the lines 
requiring And.  Use the logical options (+ and (– to override the And/Or combinations 
where necessary.  
1.9.2 Saving Filters  

When you have finished creating a filter, the Name field at the top of the Advanced Filter 
window allows you to name and save it so that you can use it again later. The name can 
be up to 30 characters long.  To save a filter, enter a unique name in the Name field and 
click SAVE. When you want to use the filter again, select the filter name from the list box 
and Trns•port automatically loads the filter parameters.  To remove a saved filter from 
the database, select the filter name from the list and click DELETE.  
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1.10 Sorting Information  

You can sort the information in list windows so that the records are grouped in a way 
that makes it easier for you to do your work (see Figure 1-15).  

 
Figure 1-15. Sort Window 

To use the sort function, click the  (SORT) button on any list window to display a 
Sort window.  

The Column field contains the names of all columns in the table that are used to build 
the list window. When you click on the down arrow in the column field, the list of 
columns to choose from will appear.  

You can click Asc or Desc to select an ascending (A-Z) or descending (Z-A) sort order for 
the selected column.  When values containing both numbers and letters are listed in 
ascending order, numbers precede letters, and vice-versa for descending order.  

If you click APPLY, Trns•port sorts the rows in the order you specified.  

If you click ADD, Trns•port adds another row for sort criteria.  

If you click INSERT, Trns•port inserts another row for sort criteria before the currently 
selected row.  

If you click DELETE, Trns•port deletes the currently selected row of sort criteria.  

If you click HELP, Trns•port displays a help window with information about sorting a list 
window.  
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2.0 Managing Projects 

A Trns•port project is a group of work or work items associated with 
transportation-related construction. It is the smallest group of items that can 
be let to a vendor. 

The way you structure a project will affect Trns•port processing through 
Trns•port PES, Trns•port LAS, and SiteManager.  Trns•port produces 
vouchers for an individual project; therefore, how you define them in PES 
determines how SiteManager will produce the vouchers. The way bidders see 
the proposal also depends on the way you define the project and item data. 

2.1  Adding Projects 

Projects are added in Trns•port PES by entering a project manually through 
the PROJECT TABBED FOLDER ADD window. 

2.1.1  Adding a Project through the Tabbed Folder Window 

To add a project, click the projects button on the Trns•port PES button bar to 
display the Projects list window. 

Select any Project in the list and choose Tabbed Folder Add from the right 
mouse button menu.  (You can display the right mouse button menu by 
clicking the right mouse button on any project in the Projects list window.) 

Trns•port displays the General tab of the Add Project tabbed folder window 
as shown in Figure 2-1. 

 
Figure 2-1.  General Tab of the Project Tabbed Folder Window 

The GENERAL tab contains general information fields used for identifying the 
project on two pages.  To create a complete record you must enter 
information in these fields: 
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DP Number A unique alphanumeric or number used by Trns•port to identify a 
project.  (DP#) 

UPC Number Enter the UPC Number. 

Federal/State 
Project Number 

If there is Federal funding and a Federal Project Number it should 
be entered. 

Spec Year Select Spec year from drop-down menu. 

Description This description should match the name of the project as listed  
on the plans, key sheet and advertising memo.  Trns•port prints 
on most project reports. These two lines of data allow you to 
enter a brief description (maximum 120 characters). 

Location The location of the primary work performed in the project.  

Unit System This field will default to E (English).   

CES Job 
Number 

Entry into this field is not required. 

Road Name The name of the primary road on which project work is being 
performed.  If the work is being performed on various roads or 
Statewide enter Various or Statewide. 

Route The route number or road number of the road affected by a 
project.  This field can be left blank if there is no Route indicated. 

Road Section 
No. 

Leave Blank. 

Beginning 
Termini 

Milepost at the beginning of the project.  (This is not a required 
field). 

Ending Termini Milepost at the end of a project.  (This is not a required field). 

Latitude of 
Midpoint 

Trns•port BAMS/DSS uses this field to draw maps with the 
project correctly placed; you can leave it blank until DSS. Enter 
latitudes in the form degrees, minutes, seconds. 

Status Select the current status of the Job from the drop-down menu. 

Cons. Pct This field defaults to 0.00.  Do not change it from the default. 

District Select the Region where a project or contract is located as well 
as who will be running the project during construction 
(maintenance or construction) from the drop-down menu. 

Project Grade This field will NOT be used. 

Project Work 
Type 

Select work type from the drop-down menu.  Appendix A 
identifies and defines work types. 

Project Type Select the project type from the drop-down menu. 
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When you finish adding information to Page 1, click the Page 2 
option button located in the upper left corner of the GENERAL tab 
to move to Page 2.  All the required information is located on 
Page 1. 

 
Figure 2-2.  Page 2 of the Add Project Tabbed Folder Window 

Estimated  
Amt.  of Project 

This field will default to 0.00.  An amount may carry over from 
CES at a later point in time.  This is not a required field. 

Reviewed By Select reviewer or estimator’s name from the drop-down menu. 

Date of 
Estimate 

Enter today’s date.  Date can be entered using the calendar or by 
manually entering it. 

Prices by Enter the same person as the Reviewed by entry. 

Date Priced Enter the date pricing was performed either by manual entry or 
using the calendar provided. 

Revised by If revisions have been made enter the name of the person 
making the revisions. 

Last Revision The date the estimate was last revised.  Enter manually or use 
the calendar provided. 

Control Group DO NOT alter this field. 

Type of Road Select the type of Highway from the drop-down menu (see 
Appendix B  - NJDOT Project/Job/Proposal Construction 
Classifications for definitions). 

Urban/Rural 
Class 

Select Urban or Rural.  This is a required field. 
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Securities in 
Lieu of 

Skip this field. 

Latitude of 
Midpoint 

The latitude of the midpoint of construction.  For Statewide 
projects use 401838; for regional projects use the following: 
North, 405493; South, 395487; Central, 401435; and HQ, 
401530.  If the project is not Statewide or Regional use the 
actual midpoint latitude of construction.  The coordinate entered 
MUST be within the first County selected in the County tab. 

Longitude of 
Midpoint 

The longitude of the midpoint of construction.  For Statewide 
projects use 0746452; for regional projects use the following: 
North, 0743459; South, 0750042; Central, 0741630; and HQ, 
0744788.  If the project is not Statewide or Regional use the 
actual midpoint longitude of construction.  The coordinate entered 
MUST be within the first County selected in the County tab. 

Field Book Skip this field. 

When you have finished adding information, save the new project to the 
Trns•port database by clicking the SAVE button or selecting Save from the File 
menu.  Trns•port displays the new project in the Project list window. 

2.2  Changing Project Information 

You can change project information through windows.  Select the project you 
want to change in the Projects list window and select Change from the right 
mouse menu. Trns•port displays the Project window with all known 
information.  

You can add or change information in any field except Project Number. When 
you finish adding or changing information, click OK to save your changes or 
CANCEL to return to the Projects list window without saving. 

2.2.1  Changing Project Information through the Tabbed Folder 
Window 

You can change project information through the Project tabbed folder 
window.  It is recommended any adds or changes through PES and 
LAS are accomplished through a Tabbed Folder Add or a Tabbed 
Folder Change when the application presents the option.  Select the 
project you want to change in the Projects list window and select Tabbed 
Folder Change from the right mouse button menu.  Trns•port displays the 
Project Tabbed Folder window with all known information.  

You can add or change information in any field except Project Number.  
When you finish adding or changing information, save your changes to the 
database by clicking the SAVE button or selecting Save from the File menu.   

2.3  Deleting a Project 

To delete a project, select the project in the Projects list window and select 
Delete from the right mouse menu. Trns•port displays a series of two Delete  
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Warning windows and a Confirm Delete window. See “Adding, Changing or 
Deleting Information” in Chapter 1 for more information about deleting. 

2.4  Listing Projects 

To produce a hard copy listing of project information, select the project or 
projects you want to list in the Projects list window. You can select more than 
one project by holding down CTRL while you select projects with the mouse. 
Then select Run Process from the right mouse button menu. Trns•port 
displays a Processes window. 

Select List Projects from the Processes window and click OK to run a process. 
Click CANCEL to return to the Projects list window without running the 
process. 

2.5  Copying Project Information to a New Project 

The Copy Special command on the Edit menu allows you to copy similarly 
defined projects and eliminates the need to reenter data for each new 
project.  After you copy the project, you can enter any minor changes to the 
new project. 

To copy a project header and its associated category, funding, breakdowns, 
estimate item and breakdown item records to a new project, select the 
project you want to copy in the Projects list window and select Copy Special 
from the Edit menu. Trns•port displays the Copy Project window. 

 
Figure 2-3. Copy Project Window 

Enter the project number in the New Project Number field and click OK to 
save the new project or CANCEL to return to the Projects list window without 
saving (see Figure 2-3). 

This is helpful in setting up TEMPLATE projects for use on similarly defined 
projects. 

2.6  Maintaining County Information 

Work might be performed in multiple counties for a single project.  Trns•port 
allows you to select multiple counties and allocate the percentage of the 
project work that is being performed there.  

 Note:  At least one county must be added to the project 
before the proposal to which it is associated is initialized into 
LAS. 
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2.6.1  Maintaining County Information Through the Tabbed Folder 
Window 

To designate the counties in which contractors will perform the work, click on 
the Projects list window to make it active.  Select the project to which you 
want to add county information and choose Tabbed Folder Change from the 
right mouse button menu.  Trns•port displays the Project tabbed folder 
window.   

Click the COUNTY tab.  Trns•port displays the COUNTY tab window listing all the 
counties associated with the selected project (see Figure 2-4). 

 
Figure 2-4.  County Tab in the Project Tabbed Folder Window 

2.6.2  Adding County Information 

To add county information, click inside the Counties list and select Add from 
the right mouse button.  Trns•port adds a blank row to the list (see       
Figure 2-5). 

 
Figure 2-5.  Adding a County on the County Tab 
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Select a county from the drop down list.  The code will display in the box.  
Change the Approximate Percent of Project Length field if necessary and click 
OK or ADD MORE. 

To add county information you must enter information in these fields: 

 

County or 
Cong. Dist 
Code 

 

A code value indicating that the project will perform work in that 
county.  For Statewide projects ONLY put Mercer County prior to 
checking the project out of PES.  Once the project is checked back 
in to PES from CES make sure to ADD Statewide under Mercer.  It 
is important to remember that the first County listed MUST be the 
County where your latitude and longitude are in from the general 
tab. 

Percent of 
Project 
Length 

An approximate percentage of the portion of the project that lies 
within this county. 

2.6.3  Changing County Information 

To change information about a county, select a county record on the COUNTY 
tab and click in the field you want to change.  You can only change 
information in the Approximate Percent of Project Length field.   

When you finish making changes, click OK to save your changes or click 
CANCEL to return to the Counties list window without saving.  Before leaving 
the tabbed folder window, save all your changes to the database by clicking 
the SAVE button or selecting Save from the File menu. 

2.6.4  Deleting County Information 

To delete a county designation, select the county record in the COUNTY tab 
window and choose Delete from the right mouse button menu.  Trns•port 
displays a Delete Warning window. 

Click YES in the window to complete the delete process. 

2.7  Adding Categories to a Project 

Trns•port uses categories to separate items of work into specific groups. You 
must create categories before you can add work items.  You should group 
items into categories if they meet these criteria: 

 All the items have the same funding source and participation 
percentages. 

 All the items are for the same type of work (roadways or bridges). 

 Users want items to be distinguished from all other items (for 
example, separating items for three different bridges into three 
separate categories). 

 Each bridge should have its’ own Category assigned to it. 
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You should group roadway and structure items in separate categories.  If you 
have multiple funding scenarios within roadway or structure items, you 
should create additional categories. 

2.7.1  Adding Categories Through the Tabbed Folder Window 

To add a category to a project, select the project from the Projects list 
window and choose Tabbed Folder Change from the right mouse button 
menu.  Trns•port displays the Projects tabbed folder window.  Click the 
CATEGORIES tab to display the CATEGORIES tab window (see Figure 2-6). 

 
Figure 2-6.  Categories Tab of the Project Tabbed Folder Window 

The top part of the CATEGORIES tab contains a list of all the existing categories 
in the project.  The bottom part of the CATEGORIES tab contains category 
detail information for the category selected in the list.   

To add a new category, click in the Category list and select Add from the 
right mouse button menu.  Trns•port adds a blank row to the list of 
categories.  Enter data into the blank fields displayed in the detail area of the 
CATEGORY tab.   

To create a complete category record you must enter information in these 
fields:  When the details portion of the screen is open (as pictured above) the 
information must be entered into the lower detail section of the screen.  If 
the details section of the screen is closed you are then able to 
enterinformation directly into the top portion. 

Category 
Number 

A four digit unique identifier for a project category.  Start with 
0001 and number consecutively by ones. 

Category 
Description 

Roadway or Bridge.  This is a required field. 

Proposal 
Section 

This field is not required. 
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Combine 
with Like 
Categories 

Make sure the box is NOT selected.   

Category 
Work Class 

Select the work class category.  This field is not required for state 
projects. 

Federal 
Work 
Category 

Select the Federal Work Category for Federal projects. 

Catg. Suppl. 
Work Code 

This field will not be used. 

Bridge ID This is a REQUIRED field when structures are involved in the 
project.  The NJDOT structure # should be used.   

Bridge 
Length 

The length of the bridge represented by the category.  Not needed 
for roadway projects. 

Bridge 
Width 

The width of the structure represented by the category. 

Category Alt 
Code 

This field will not be used. 

Federal 
Construction 
Class 

Describes the type of construction used for the category.  Select 
from the drop-down menu. 

Construction 
Eng. Pct. 

This field will NOT be used. 

Category 
Length 

The length of the project in miles represented by a given   

Category 
Width 

The width of the portion of the project represented by the category 
in feet. 

Category 
Depth 

The average pavement depth in inches. 

Lane Mi Calculate and fill in the lane miles for the category.  

Number of 
Spans 

Fill in the number of spans of the structure represented by the 
category. 

Bridge Type Select the type of bridge from the drop-down menu. 

When you finish entering information on Page 1 of the detail area, click the Page 
2 option button to display more fields (see Figure 2-7). 
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        Figure 2-7. Page 2 of the Category Tab 

Highway 
Type 

Select the highway type from the drop-down menu (see Appendix 
B – NJDOT Project/Job/Proposal Classifications for definitions). 

Highway 
Number 

This field will not be used. 

Beginning 
Termini 

This field will not be used. 

Ending 
Termini 

This field will not be used. 

Beginning 
Station 

Fill in the station at the beginning of the project.  If the category 
represents a structure fill in the beginning station of the structure. 

Ending 
Station 

Fill in the ending station of the project.  If the category represents 
a structure fill in the ending station of the structure. 

Road 
Section 
Number 

 

This field will not be used. 

Unit 
Number 

This field will not be used. 

Adj. Code This field will not be used. 

Adj. # This field will not be used. 

String This field will not be used. 

Flag 1 This field will not be used. 

Code 1 This field will not be used. 

Number 1 This field will not be used. 
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When you finish entering information for a category, you can click ADD MORE 
to enter information for another category.  Click OK when you finish adding 
category information or click CANCEL to return to the Categories list window 
without saving the new record. 

Before leaving the tabbed folder window you must save the new category 
record to the database by clicking on the SAVE button or selecting Save from 
the File menu. 

You can create a Category 0000 when most of the work being performed in a 
category has the same funding sources and funding percentages (see Figure 
2-8). Funding at this level is the default, project-level funding.  

 Note: You should not add items to Category 0000, just 
funding. 

Category 
0000

Category 0001 
Roadway

Category 0002 
Bridge 1

Category 0003 
Bridge 2

Category 0004 
Bridge 3

 
Figure 2-8. Category 0000 Example 

All four categories, which have no defined funding in this example, revert to 
the Category 0000 funding. In another example, if Category 0003 bridge 
items have different funding, then you could specify funding for that category 
and the other three categories would use the default funding set up in 
Category 0000. 

2.8  Changing and Deleting Category Information Through the 
Tabbed Folder Window 

To change information about an existing category, select a category on the 
list in the CATEGORIES tab of the Projects tabbed folder window.  Trns•port 
displays all the existing information about the selected category in the detail 
area of the CATEGORIES tab below the list. 

You can change any of the fields on the CATEGORIES tab except the blue 
fields.  To change information, click in a text box and add or delete 
information.  When you finish making changes, click OK.  If you want to 
return to the CATEGORIES tab without saving your changes, click CANCEL. 

To delete an existing category and the related funding and item data, select 
the category in the Categories list and choose Delete from the right mouse 
button menu.  Trns•port displays a Delete Warning window. 

Click YES in the window to complete the delete. 

2.9  Copying Category Information to a New Category 

Selecting Copy Special from the Edit menu item allows you to copy similarly 
defined categories, eliminating the need to reenter all the data for each new 
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category.  After you copy the category, you can enter the modifications to 
the new category. 

Copy Special copies the category header information, all funding sources, 
and estimate item records, quantities and prices.  To copy category, funding 
and item data to a new category, select the category you want to copy from 
the Categories List window or the CATEGORIES tab of the Project tabbed folder 
window.  Then select Copy Special from the Edit menu or the right mouse 
button menu.  Trns•port displays the Copy Category window. 

 
Figure 2-9. Copy Category Window 

Enter the new project and category numbers in the New Project Number and 
New Category Number fields. Click OK to save the new category or Cancel to 
return to the Categories list window without saving (see Figure 2-9).  Copy 
Special will not copy breakdown item data.  

Trns•port performs Category Copy only if these conditions are satisfied: 

 The Spec Year for the project in the copied from category must 
match the destination project’s Spec Year. 

 Your control group must match the control group of the destination 
project. 

 The unit system (English or metric) of the current project must 
match the destination project’s unit system. 

Because copying a category to another category can result in estimate items 
with the same project estimate line number, renumber the project estimate 
items after categories are copied. 
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3.0 Using the PES Worksheet 

You can use the PES Worksheet to add or change multiple items at one time.  You must 
create a project header record and category headers before you can add items to 
categories through the PES Worksheet. 

This section describes how to add items through the PES Worksheet. You can add items 
quickly with the PES Worksheet, which makes this an easier way to add or change item 
data.  This chapter covers entering and maintaining estimate data through the 
worksheet. 

3.1 Opening the PES Worksheet 

When you open a project in the PES Worksheet, Trns•port closes the project data for all 
other users. No other users can change or delete project item information while it 
resides in your PES Worksheet. 

To use the PES Worksheet, click on the Projects list window to bring it to the front (make 
it active). Select the project to which you want to add items by clicking on the project 
record and then clicking the WRKSHEET button or selecting PES Worksheet from the right 
mouse menu button.  The PES Worksheet is also available on the WORKSHEET tab of the 
Project tabbed folder window. 

Trns•port displays the PES Worksheet grid window (see Figure 3-1). 

 
Figure 3-1. PES Worksheet List Window 

The PES Worksheet contains data in columns and rows which identify items. Each row in 
the Worksheet represents one project estimate item.   

The Worksheet contains these fields displayed as columns: 

Category 
Number   

The Category Number field is an identifier for a project 
category, derived from the list of categories attached to a 
project.  You must enter a value in this required field.  Range 
fill from the edit menu can be used to add this number if they 
are all the SAME. 
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Item Number The entry in the Item Number field must be a value from the 
ITEMLIST code table (see arrow directly below the field) or it 
can be manually entered if it is known. 

Item Description   The Item Description is the ITEMLIST short description that is 
printed on any report that includes descriptions.  You cannot 
edit this field on the Worksheet as it will be automatically 
entered for standard items once the item number is entered. 

Item Units   The Item Units field identifies the type of measurement used 
to determine the units of the item.  The entry in the Item 
Units field must be a value from the UNITS code table. If the 
item is a lump sum item or a hybrid lump sum item, the field 
must contain the value "LS."  You cannot edit this field on the 
Worksheet, it is also automatically filled. 

Lump Sum Units This field is not being used. 

Est. Unit Price This field will be filled in from CES unless the price is known, 
in which case it can be entered manually. 

Extended 
Amount  

The product of the quantity times the price. Trns•port 
automatically calculates this field base on the entries in the 
Project Item Quantity and Estimated Unit Price fields. 

Supplemental 
Description Reqd 

This box should be checked for all Non-Standard Items and 
Parcels being demolished. 

Supplemental 
Description 

This field will be required for all Non-Standard Items and 
parcels that are to be demolished in order to identify the 
actual item of working being constructed. 

Supplemental 
Description Part 
Two 

The Supplemental Description Part 2 field contains an 
additional 40 characters of space you can use to add 
supplemental information about an item. 

Project Item 
Quantity  

The quantity of a single project item.  Used by Trns•port to 
determine the extended cost of an item. 

Project Item Line 
Number 

The Project Item Line Number field is a four digit number 
Trns•port uses to identify the item.  Trns•port automatically 
enters this value. 

Price Lock Flag The Price Lock flag field indicates whether or not manually-
entered estimate price information for items will be updated 
by the Trns•port PES Generate Bid Base Prices process.  Enter 
“Y” in this field to restrict modifications to manually entered 
information, in other words, to “lock” the manually entered 
prices. 

Price Source  The Price Source field identifies the source of the Estimated 
Unit Price.  The entry in the Price Source field must be a value 
from the PRICSRC code table.  You cannot modify this field. 

Combine Like 
Items 

This will default to NO, leave this as NO. 
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Project Item 
Generic Code 1 

The Project Item Generic Code 1 field is a generic field 
individual agencies can use for their specific purposes. 

Pre-established 
Price Flag 

The Pre-established Price Flag field determines whether or not 
the Estimated Price of an item will be automatically entered on 
bidders’ proposal schedules.  Enter a “Y” in this field to force 
bidders to bid the engineer’s estimated amount for the item 

The remaining fields will not be used. 

The PES Worksheet contains more fields than can be displayed in the window at one 
time. To view all the fields, drag the scroll box at the bottom of the window to the left or 
right or click and hold the arrows at the top and bottom of the scroll bar. 

To get more information about a field contained in the PES Worksheet window or the 
WORKSHEET tab, click on the column header with the right mouse button and select Field 
Help.  Field help is available for any field into which you can enter data. 

 Note:  When a project contains addendum items, the only fields in the 
PES Worksheet that may be changed are:  Estimated Unit Price, Revised 
Item Price, Price Source, Non-Par Fund Code, Est. Price Lock Flag, 
Generic Code 1, and Breakdown Item Line No. 

3.2 Customizing the PES Worksheet Display 

You can customize the PES Worksheet to display the fields you work with most often 
when you open the worksheet. To do this, you hide, move, and re-size columns. 

When you close the worksheet, Trns•port stores your customized worksheet 
configuration on your hard drive. When you start a work session, Trns•port looks for 
your customized set-up first. If Trns•port does not find a customized version, it opens 
the worksheet with all the columns visible in the default order. 

3.2.1 Hiding Columns 

To hide and display columns, choose Hide Columns from the Edit menu. Trns•port 
displays the Hidden Columns window in which you can choose the columns you want to 
hide (see Figure 3-2). 

 
Figure 3-2. Hide Columns Window 

The Hidden Columns window displays all the possible columns in the PES Worksheet.  
The Worksheet hides any highlighted column in the list.  You highlight a column by 

Using the PES Worksheet                                                                  3-3 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

simply clicking on the column name. 

Click on any of the columns you want to hide.  To display all hidden columns, click the 
SHOW ALL button in the window.  To display individual hidden columns, click on the 
highlighted name to clear the selection.  Click OK when you have made your selections.  
Trns•port adjusts the display of the Worksheet accordingly. 

 Note:  Trns•port displays hidden columns you select to display on the 
far right of the worksheet; you may have to scroll to the right to view 
any recently displayed columns. 

3.2.2 Moving Columns 

You can drag the columns you use most often to the left of the window so they are 
visible each time you open the worksheet, or position related columns next to each other 
so information displays in logical units. 

To move columns, click and hold down the left mouse button in the column title to 
highlight the column (the entire column should be shaded in black) and display a gray 
bar that extends the length of the Worksheet window.  Drag the bar to the right or left 
and release the mouse button when it rests in the position where you want the column 
displayed.  The column shifts to its new position and Trns•port adjusts all other columns 
in the worksheet.   

3.2.3 Changing Column Widths 

Sometimes a Worksheet column may be larger than is necessary for the information 
displayed in that column.  To maximize you use of the display space you may want to 
adjust the width of the column.  To change column widths, position the mouse pointer so 
that it rests on the border between two columns.  When the pointer is in the right 
position, it changes to a cross-hatch with left and right arrows.  Click the mouse on the 
border line and hold the left mouse button down as you drag the line to the right or left 
to make the column to the left of the line wider or more narrow. 

3.2.4 Sorting Rows 

You can sort rows in ascending or descending order according to specific columns.  
Choose Sort from the Edit menu or click the Sort button on the button bar.  Trns•port 
displays the Sort window (see Figure 3-3).       

      
         Figure 3-3.  Sort Window 

You can sort the Worksheet rows in ascending or descending order according to a 
column in the Worksheet.  Use the drop-down list in the Column field to select a column 
and click the Asc or Desc option button to designate the order of the sort. 

Click add to add another row of sort criteria or click insert to insert another row of sort 
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criteria before the currently selected row.  If you add another row of sort criteria to the 
sort, Trns•port sorts the list in the order that the sort criteria are listed in the sort 
window. 

To delete a row of sort criteria, select the row and click delete. 

Click apply to apply the sort to the Worksheet or click cancel to return to the Worksheet 
without sorting the information. 

3.3 Adding, Inserting or Deleting Rows 

When you open an empty Worksheet you must add a row to the worksheet before you 
can perform any Worksheet operations.  You can add, insert, and delete rows. 

Select Add Row to End from the Edit menu to add a row to the end of the Worksheet.  
You can scroll to the bottom and enter values. 

Choose Insert Row from the Edit menu to insert a row at a specific position in the 
Worksheet.  When you select this command Trns•port inserts a row above the row 
selected when the command is invoked.  For example, to insert a row in the fourth 
position of the Worksheet you click in the fourth row and choose Insert Row from the 
Edit menu. 

To delete a row, click on the row and select Delete from the Edit menu or press 
SHIFT+DELETE.  You can delete several rows at one time by holding down the CTRL key 
while you select rows with the mouse and then selecting Delete.  If you attempt to 
delete several rows at once, Trns•port displays two warning messages.  The first 
message asks you to confirm the delete, and the second message identifies the number 
of rows that will be deleted. 

 Note:  If you want to save a temporary copy of the PES Worksheet 
while you are working in the Worksheet, choose Temporary Save from 
the File menu.  See “Saving Information” in Section 3.8 for more 
information on Temporary Save. 

3.4 Adding Information to the Worksheet 

To enter information in the Worksheet you simply click in a row and enter values for 
each column in the row.  When you open an empty worksheet you need to insert a row 
before you can begin working in the Worksheet.  (See Section 3.3 Adding, Inserting or 
Deleting Row).  You can add or change data in most blank column fields (except those 
fields calculated by Trns•port) or fields with red data. You cannot change blue field 
values. 

Some of the column fields, such as category number and item number, have down 
arrows at the bottom. You can click on the arrow to view supporting reference data and 
select appropriate values.  

You can use filter and sort to help you find the information you are looking for.  To save 
time when adding items to a project, you can create a default filter that will 
automatically filter the list to show only those items with which you typically work. 

If a column does not have an arrow displayed at the bottom, you must enter values 
directly into those fields. 

 Note: You cannot access the blue values, such as the item description. 
Trns•port automatically calculates and enters values for these fields. 
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You need to enter several fields in the worksheet in order to save the data in the 
worksheet.  You might need to scroll to the right to find some of these required fields:  
Category Number, Item Number, Line Number, and Estimated Unit Price. 

The Supplemental Description fields are each 40 characters long. Use them to identify 
miscellaneous items or to extend the definition of the standard item. These descriptions 
stay with the items throughout the life of the project. 

You can price items manually in the PES Worksheet by entering prices in the Estimated 
Unit Price field. 

3.5 Entering Data in a Range of Cells 

You can select Range Fill from the Edit menu to enter values in columns. If you add or 
change information in a column you can select cells in the column and copy the value 
down or up in the selected portion of the column. Range Fill is a valuable way to enter 
category numbers or item estimate numbers multiple times. You enter the value once 
and then copy the value in all related records (see Figure 3-4). 

 

 
Figure 3-4. Range Fill on the Edit Menu 

To select a portion of a column, click in the top left corner of the box with the value you 
want to copy down or up the column.  If your mouse pointer displays as an I-beam, 
move it around the top left corner until it displays as an arrow again. When the mouse 
pointer displays as an arrow, hold down the left mouse button and drag up or down to 
select other cells in the column.  To select an entire column, click once in the column 
title.  Select Range Fill from the Edit menu and choose Fill Up or Fill Down.  Trns•port 
populates all the selected fields with the value from the first cell. 
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 Note:  The row of data that contains the value you are using to enter 
the values for other records will remain highlighted throughout this 
process.  Other data in the row is not affected. 

3.6 Checking Data Consistency 

You can check the consistency of data in the PES Worksheet before you save. (Trns•port 
does not save data until you choose Update Database from the File menu.)  

Select Consistency Checking from the Edit menu to check the consistency of the data in 
the Worksheet.  For all the fields that have identical Category Number and Project Item 
Line Number values it checks that the estimated item columns (Estimated Unit Price, 
Item Number, Supplemental Description, Supplemental Description Part Two, Price 
Source, Price Lock Flag) have identical values.  

Trns•port runs through the validations, but does not save the file. If Trns•port finds an 
error, it displays the cursor in one of the cells with an error and indicates the error in a 
pop-up window. 

3.7 Assigning Estimate Line Numbers 

You can manually enter project item and breakdown item line numbers or let Trns•port 
enter them automatically. You must assign line numbers to all rows before you can 
permanently save the Worksheet. 

To enter the Line Number field in the Worksheet automatically, select Assign Line 
Numbers from the Edit menu and choose Project Items. 

This option sequentially numbers all project items. 

3.8 Saving Information 

If you want to save a temporary copy of the PES Worksheet while you are working in the 
Worksheet, choose Temporary Save from the File menu.  You can use Temporary Save 
frequently to protect information you've entered in the worksheet from a power failure or 
other problems that can occur before you update the database.  

Only one temporary version of the worksheet is allowed per worksheet, however, you 
can temporarily save several different worksheets using the Temporary Save option.   

 Note: Temporary Save locks selected records in a temporary format. No 
one can access the selected records except the person who locked 
them; therefore, use this option with care. 

Trns•port will not validate fields until you choose Update Database from the File menu.  
When you perform this action, Trns•port deletes any existing temporary version of the 
worksheet. 

To save the data in the Worksheet, select Update Database from the File menu.  Each 
time you choose Update Database from the File menu Trns•port validates the Worksheet 
fields. 

Trns•port validates all fields as it updates the tables.  A blank row, which  cannot be 
verified, generates an error message for this reason;  be sure to delete all blank rows 
from the Worksheet before you update the database.   When you update the database, 
Trns•port performs calculations and checks data for consistency (see 3.6 Checking Data 
Consistency).  For example, two items cannot have the same breakdown number and 
breakdown item line number; Trns•port checks to be sure each item has a unique 

Using the PES Worksheet                                                                  3-7 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

combination of values in these two fields. 

 Note: Use Save Folder frequently to save your changes in case of a 
power failure or program error. By doing so, you will only have to enter 
the data you entered since the last save if a problem occurs. 

If you enter incorrect or insufficient information in the Worksheet, Trns•port displays an 
error message like the one in Figure 3-5.  You must correct any errors before it will save 
the data. 

 
Figure 3-5.  Add Item Error Message 

If you attempt to close a Worksheet that has been changed but not saved (by clicking 
the CLOSE button on the button bar or double-clicking the Control menu box), Trns•port 
displays the PES Worksheet window.  Click YES to update the database, NO to ignore the 
changes and close the worksheet, or CANCEL to return to the worksheet. 

 

3.9 Managing Category Funds 

3.9.1 Understanding Funding 

You do not need to add funding to each work item, but you must add funding at the 
category level before you can run the Detail Estimate report.  You must identify and 
enter each funding source for a category separately with the fund’s percent participation. 
Every item in the category should have the same type of funding.  

All items in a category must have the same funding scenario. This does not mean that 
they must be funded by a single source. Trnsport allows for categories to have multiple 
funding sources. Each source must be identified and the funding participation percentage 
must be entered. These percentages must add up to 100 percent. Trns•port will not 
interactively check to make sure the percentages add up, but if they do not an error will 
occur when you run the Detail Estimate report.  

A single category could have simple funding, where 100 percent of the funding is from 
one source such as a local agency. On the other hand, the funding could be more 
complex with the federal government funding 50 percent of the total project, the state 
funding 30 percent and a local agency funding the remaining 20 percent.  

To illustrate a more complex arrangement, suppose the local agency will fund 20 percent 
but only up to $10,000. After that the state must pickup the entire share and the project 
will be funded 50 percent by state and 50 percent by federal dollars. Figure 3-6 shows 
how this would be set up in Trns•port with Funding priorities: 
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Figure 3-6. Funding Example 

Priorities in funding determine which funds get expended or used up first, which is 
advantageous when funding sources have dollar limitations such as the local agency in 
the example.  

3.9.2 Adding Funds to Categories  
To add funds to categories, select one of the categories from the Categories list window 
and click FUNDING on the button bar or select Project Funding List from the right 
mouse button menu. Trns•port displays a Funding list window (see Figure 3-7). 

 
Figure 3-7.  Funding List Window 

To add funds to the category you selected, press INSERT or select ADD from the right 
mouse button menu. Trns•port displays the Add Funding Source window (see Figure 3-
8). 
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Figure 3-8. Add Funding Source Window 

Click ADD MORE on the FUNDING tab until you have funded the category 100 percent.  
You will have to keep track of the total funding percentage; Trns•port does not check to 
make sure you have funded each category 100 percent. (see Figure 3-9 and 3-10).  

 

 
Figure 3-9. Add More Funding Window 

 
Figure 3-10. Fund List Window 
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When you have funded the category 100 percent, click OK to save your work. Trns•port 
displays the new funding record in the list on the FUNDING tab.  

Before leaving the tabbed folder window you must save all your changes to the database 
by clicking on the SAVE button or selecting Save from the File menu.  

3.9.3 Changing and Deleting Funding  
To change information about an existing funding source, select the funding record in the 
Funding list window and choose Change from the right mouse button menu. Trnsport 
displays the Fund Detail window.  

Trns•port displays existing information about the funding record. You can change 
information or add information to blank fields. When you finish making changes, click OK 
to save your changes or click CANCEL to return to the Funding list window without 
saving.  

To delete an existing funding record, select the record in the Funding list window and 
choose Delete from the right mouse button menu. Trns•port displays a Delete Warning 
window. Click YES in each window to continue the delete process.  

3.9.4 Changing and Deleting Funding Through the Tabbed Folder Window 
It is recommended changes and deletions occur in a “Tabbed Folder” window.  To 
change information about an existing funding source, select the funding record in the list 
on the FUNDING tab of the Project tabbed folder. Trns•port displays all the existing 
information about the funding record in the detail area of the FUNDING tab below the 
list.  

You can change information in any of the fields on the FUNDING tab except the blue 
fields. When you finish making changes, click OK. If you want to return to the FUNDING 
tab without saving your changes, click CANCEL.  
To delete an existing funding record, select the record in the Funding list and choose 
Delete from the right mouse button menu. Trnsport displays a Delete Warning window.  

Click YES in the window to complete the delete process.  

Before leaving the tabbed folder window you must save all your changes to the database 
by clicking the SAVE button on or selecting Save from the File menu.  
3.10 Managing Breakdowns and Breakdown Items  
Breakdowns and Breakdown Items are optional features of the PES, LAS and 
SiteManager modules. Currently NJ does not breakdown items.  If you wish further 
information on this optional feature it can be found in the standard Trns*Port PES User’s 
Guide. 
3.11 Listing Project Estimates  
To produce a hard copy listing of project estimate information, select the projects for 
which you want to list information in the Projects list window. You can select more than 
one project by holding down CTRL while you select projects with the mouse.  

Choose Run Process from the right mouse button menu. Trns•port displays a Processes 
window.  

Select List Project Estimates and click OK to run a process or CANCEL to return to the 
Projects list window without running the process. 
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4.0 Defining a Proposal   

After you define projects and enter project details, you are ready to create a proposal.  A 
Trns•port proposal is one or more projects grouped together for bidding.  A proposal is 
similar to a project in that it contains items of work, but it also contains bidding 
information (such as DBE and WBE goals).  Just as a project groups items into 
categories, a proposal groups project line items into proposal line items and project 
categories into proposal sections.  Your highway agency might want to combine various 
projects into a single proposal, but a proposal can also contain a single project of 
biddable items. Typically NJ only assigns one project to a proposal.  Trns•port will roll 
like items up to a proposal view in the proposal process so bidders only have to view and 
price items once.  Trns•port PES automatically generates proposal line numbers and 
proposal section numbers.  

To create a proposal, you do not have to define all the proposal details, just the proposal 
header information. You tell Trns•port which projects you want to assign to the proposal 
and then allow Trns•port to create all the proposal details for you.  After you create the 
proposal, you will need to assign it to a bid letting and produce the proposal documents.  

4.1 Proposal Header  

To define a proposal header record, you need to open a proposal list and add information 
for a new proposal record.  

Click the PROPOSALS button to open the Proposals list window (see Figure 4-1).  

 
Figure 4-1. Proposals List Window 

4.1.1 Adding a New Proposal Header Record Through the Proposal Window  

To add a new proposal, press INSERT or choose Add from the right mouse button menu. 
Trns•port displays the first page of the Add Proposal detail window (see Figure 4-2).  
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Figure 4-2. Page 1 of Add Proposal Window 

To create a complete record you must enter information in the fields listed in section 
4.1.2.   Click the PAGE 2 tab to display more proposal fields (see Figure 4-3).  

 
Figure 4-3.  Page 2 of Add Proposal Window 
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Click OK to add the new proposal to the Trns•port database. Trns•port displays the new 
proposal in the Proposal list window.  

4.1.2 Adding a New Proposal Header Record Through the Tabbed Folder 
Window  

Adding a new proposal header record though the Tabbed Folder window is a 
recommended method.  To add a new proposal, select any Proposal in the Proposals list 
window and choose Tabbed Folder Add from the right mouse button menu.  

Trns•port displays the GENERAL tab of the Add Proposal tabbed folder window as shown 
in Figure 4-4.  
 

 
Figure 4-4. General Tab of the Add Proposal Tabbed Folder Window 

The GENERAL tab contains general information fields used for identifying the proposal on 
two pages.  To create a complete record you must enter information in these fields:  

DP Number  A unique identifier for a proposal or 
contract.  Enter the DP Number. 

Counties  You can enter up to four counties for 
each proposal (select from the drop-
down list). Only the first county is 
required. Trns•port prints this 
information on some reports, but does 
not use it in processing. 

Description  A short description of the proposal. 
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Primary District  The primary district in which the work for 
a contractor project will be performed.  
Enter the NJDOT Region. 

Spec Year  This field identifies the specification year 
item list used on the project or proposal. 

You are not required to, but you can enter information in these fields to record  
additional information about a proposal: 

Bid Bond  A dollar amount required to bond contractors. This field is 
printed on some Trns•port reports but not otherwise used 
in any processing. (Your highway agency might choose not 
to use this field if bid bonds are calculated on a contract 
percentage basis instead of a set dollar amount.)  

Cont Alt ID 1  

 

You can use this field and Cont Alt ID 2 to store identifiers 
your agency will use for this contract in addition to the 
Contract ID Trns•port requires. Trns•port does not use this 
field in any Trns•port processing.  

Cont Alt ID 2  

 

You can use this field and Cont Alt ID 1 to store identifiers 
your agency will use for this contract in addition to the 
Contract ID Trns•port requires. Trns•port does not use this 
field in any Trns•port processing.  

Contract Type  

 

A value, which must be selected from the attached 
CONTTYP code table, that your agency can use to store a 
classification of the type of contract this proposal will 
become (for example, a safety contract). Trns•port prints 
this field on some reports but does not use it in processing.  

Contract Work 
Type  

 

A value, which must be selected from the attached 
WRKTYP code table, which your agency can use to store a 
classification for the work type for this contract.   

Contracting Class A value, which must be selected from the attached 
CONTCLS table, which indicates the class of contract.  

Control Group  

 

A group of users who can access the same set of projects, 
proposals, or contracts (for example, only users in the 
Aeronautics control group can access Aeronautics 
projects). Each control group can only view, change, and 
delete projects, contracts, or proposals in their own control 
group. To pass a project, contract, or proposal to another 
control group for processing, a user can change their 
control group code to the new group code. When the user 
saves the project, contract, or proposal, the original control 
group will no longer have access. 

Controlling PCN  

 

Indicates which project is the controlling project in a multi-
project contract.  Enter the DP# in this field to 
automatically populate the proposal fields. 
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Cost of Plans  Used for planholder invoicing in the LAS module. Trns•port 
will bill this cost to purchasers of complete plans for a 
proposal. 

Cost of Proposal Used for planholder invoicing in the LAS module. Trns•port 
will bill this cost to purchasers of plans for this proposal. 
The next fields—Cost of Plans, Cost without X-Section, and 
Cost Per Plan Sheet—are used for the same purpose. 

Cost per Plan 
Sheet  

 

Used for planholder invoicing in the LAS module. Trns•port 
will bill this cost to purchasers of plans with cross-sections 
for this proposal. 

Cost w/o X-
Section  

 

Used for planholder invoicing in the LAS module. Trns•port 
will bill this cost to purchasers of complete plans without 
cross references for this proposal. 

DBE Goals  A value, which must be selected from the attached 
DBENOTE code table that indicates which of the two goals 
described above apply to this proposal. If you choose 
NONE, Trns•port will not print goals on any report. If you 
choose DBE, Trns•port will only print the DBE/MBE goal 
and label it a DBE goal. If you choose BOTH, Trns•port will 
print both the DBE/MBE goal (labeled as an MBE goal) and 
the WBE goal. 

DBE/MBE Goal 
(PCT) 

A percentage goal set for disadvantaged (DBE) or minority 
(MBE) business enterprises for a proposal. 

Federal/State 
Project Number 

 

The federal or state project number identifying a project, 
proposal or contract. In general, a prime project and all the 
projects comprising it should have the same Federal State 
Project number although this is not enforced by Trns•port. 

Highway Number  The identifier for the road being worked on in a project. 

Highway Type  A value, which must be selected from the attached 
HWYTYP code table, that indicates the type of road being 
worked on (for example, asphalt, concrete, or dirt or two-
lane or four-lane limited access). 

Last Addendum 
Number 

The last addendum number used for a proposal. Trns•port 
enters this field automatically. 

Last Description 
Number 

Trns•port enters this field automatically when you enter 
long descriptions. 

Location  The site where work is being performed for the proposal. 

Previously Let As 
CONTID 

Indicates the contract ID under which a proposal was 
previously let. 
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Proposal Fund 
Type  

A value, which must be selected from the attached 
FUNDTYP code table, which indicates the kind of funding 
used for the proposal. 

Proposal Type  A value, which must be selected from the attached 
PROPTYP code table, which indicates the type of proposal 
(for example, a proposal specifically for small businesses). 

Qualification 
Class  

A classification of work for which a vendor is qualified. 

Road System  A coded value indicating the road system of which this 
highway is a part (for example, interstate or federal, state 
or county highway). 

Section 
Assignment  

Flag telling Trns•port if you want to assign project 
categories to proposal sections automatically or do it 
yourself manually by entering section numbers in the 
category records. The default value is Y, which means 
Trns•port will automatically assign categories to sections. 

Set Aside 
Proposal  

A value, which must be selected from the attached 
SETASID code table, that indicates you have set aside a 
proposal for a particular purpose (for example, to provide 
contracts to small, minority-owned businesses). 

Special 
Provisions  

Flag used to tell Trns•port if you will assign special 
provisions to this proposal that it should print with the 
proposal schedule. The default value is N (you have 
assigned no special provisions). 

Supplemental 
Spec Year 

 

Can be used by your agency to denote a supplemental 
specification year in addition to the primary specification 
year. Trns•port does not use this field in any processing 

WBE Goal (PCT)  A percentage amount indicating the goal your agency has 
set for women business enterprises for the proposal. 

When you finish adding information to Page 1, click the Page 2 option button located in 
the upper left corner of the GENERAL tab to move to Page 2 (see Figure 4-5).  
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Figure 4-5. Page 2 of the Add Proposal Tabbed Folder Window 

When you have finished adding information, save the new proposal to the Trns•port 
database by clicking the SAVE button or selecting Save from the File menu. Trns•port 
displays the new proposal in the Proposal list window.  

4.1.3 Changing Proposal Header Information in the Proposals Window  

To change information about an existing proposal, select the proposal in the Proposals 
list window and then choose Change from the right mouse button menu. Trns•port 
displays a Proposal window.  

You can add or change information in any fields except Contract ID. When you finish 
making changes, click OK to save your changes or CANCEL to return to the Proposals list 
window without saving.  

4.1.4 Changing Proposal Header Information in the Tabbed Folder Window  

To change information about an existing proposal, select the proposal in the Proposals 
list window and then choose Tabbed Folder Change from the right mouse button menu.  
Trns•port displays the Proposal tabbed folder window with all known information.  

You can add or change information in any fields except Contract ID.  When you finish 
making changes, click OK to save your changes or CANCEL to return to the Proposals list 
window without saving.  

4.2 Associating Projects with a Proposal  

To associate projects with a proposal, select the proposal from the Proposals list window 
to which you want to add projects. Then select Proposal Project List from the right mouse 
button menu (or click the PROJECTS button) to display the Proposal Projects list window 
of all Trns•port projects that match your control group.  
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Figure 4-6. Proposal Projects List Window 

When you assign a project to a proposal, you tell Trns•port to associate the selected 
project with the originally selected proposal.  Press INSERT or select Add from the right 
mouse menu to display the Add Projects list window (see Figure 4-6).  

 
Figure 4-7.  Proposal Add Projects List Window 
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Select a project to add to the proposal. You can select more than one project by holding 
down CTRL while you select projects with the mouse. When you finish selecting projects, 
press INSERT to add the projects to the proposal. Click the CLOSE button on the button 
bar to close the Proposal Add Projects list window. Trns•port displays the projects you 
selected to add to the proposal in the Proposal Projects list window (see Figure 4-7).  

4.2.1 Associating Projects with a Proposal Through the Tabbed Folder Window  

It is recommended the Tabbed Folder Change method be used to make proposal 
changes.  To associate projects with a proposal, select the proposal to which you want to 
add projects from the Proposals list window. Then select Tabbed Folder Change from the 
right mouse button menu.  Trns•port displays the Proposal tabbed folder window (see 
Figure 4-8).  

 

 
Figure 4-8. Proposal Tabbed Folder Window 

When you assign a project to a proposal, you tell Trns•port to associate the selected 
project with the originally selected proposal.  To associate projects with a proposal, click 
the PROJECTS tab. Trns•port displays the PROJECTS tab window (see Figure 4-9).  
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Figure 4-9. Projects Tab on the Proposal Tabbed Folder Window 

The top part of the PROJECTS tab contains a list of all the existing projects associated 
with the proposal. The bottom part of the PROJECTS tab is a master list of projects from 
which you can choose to add to your proposal.  This master list will contain only those 
projects that meet these criteria:  

All the projects have the same spec year as the proposal.  

All the projects are in your control group.  

None of the projects have been assigned to another proposal.  

All the projects match the Unit System of any other projects already assigned to the 
proposal.  

You can view all the details of any project listed on the PROJECTS tab by clicking on the 
project record and selecting Zoom from the right mouse button menu.  

To add a project to the proposal you selected, select the project in the master list and 
click the ADD SELECTED button. Trns•port displays the project in the list of projects for 
the proposal.  

Defining a Proposal                                                                              4-10 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

 
Figure 4-10. Projects Tab on the Proposal Tabbed Folder Window 

You can select more than one project by holding down CTRL while you select projects with 
the mouse, or you can add all the projects by clicking the ADD ALL button (see Figure 4-
10).  

When you have finished adding projects to the proposal, save your changes to the 
database by clicking the SAVE button or selecting Save from the File menu.  

4.3 Deleting Projects from a Proposal  

To delete projects from a proposal, first select a proposal. Then select Proposal Project List 
from the right mouse button menu.  Trns•port displays a list of associated projects.   

To delete or disassociate projects from a proposal, select the project or projects in the 
Projects list window and choose Delete from the right mouse button menu. Trns•port 
displays a Delete Warning window.  

Click YES in each window to complete the delete process.  

You can also delete projects from a proposal while inside the Proposal tabbed folder 
window. Click the PROJECTS tab. Select the project(s) to be deleted and click the REMOVE 
SELECTED button. You can delete all the projects associated with the proposal by clicking 
the REMOVE ALL button.  

! Caution: Deleting a project from a proposal after the proposal has been passed 
from PES to LAS via the LASINIT process will also delete any proposal items that 
were generated.  

4.4 Copying Proposal Information to a New Proposal  

The Copy Special command on the Edit menu allows you to copy similarly defined 
proposals and eliminates the need to reenter data for each new proposal. After you copy 
the proposal, you can enter any minor changes to the new proposal.  
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To copy a proposal header and its associated proposal level data to a new proposal, 
select the proposal you want to copy in the Proposals list window and select Copy Special 
from the Edit menu. Trns•port displays the Copy Proposal window (see Figure 4-11).  

 
Figure 4-11. Copy Proposal Window 

Enter the proposal number in the New Proposal Number field and click OK to save the 
new proposal or CANCEL to return to the Proposals list window without saving.  

4.5 Assigning Site Locations  

Trns•port maintains all time changes to a contract or proposal at the site level. Each 
proposal must have at least one site. Sites can be set up for the proposal as a whole 
or as an individual group of time in which to accomplish the work.  Sites can be set up 
for road versus structure work or when a known head to head situation is going to occur 
and the contractor will have a set number of days to perform the work.  

To set the type of work days for the proposal, the length of the project in days or a 
completion date, and the liquidated damages rate, you must enter a proposal site 
record.    

Each proposal must have at least one site numbered 00 to specify time limitations and 
liquidated damages for the contract as a whole in Trns•port SiteManager as shown in this 
example:  

 
� Note: The Site 00 must be added to the proposal record before it is initialized 

into LAS.  

Proposals can have additional sites as well. In the following example, the contractor has 
200 days to complete the project, but only 50 days to complete work on each of the 
bridges.  
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Trns•port allows three types of work days:  available days, calendar days, and 
completion date.  

Cost Plus Time bidding information is also entered at the proposal site level.  The total 
number of calendar days you enter for the contract site (Site 00) becomes the contract 
time component of a Cost Plus Time bid. A valid Cost Plus Time bid also requires that 
you enter cost per day information in the Road User Cost Per Day field on the Sites tab 
of the Proposal tabbed folder. See Section 4.5.2 for more information about the Road 
User Cost Per Day field.  

4.5.1 Adding, Changing, and Deleting Site Information  

To define the site location for a proposal, select the proposal for which you want to 
define a site from the Proposals list window and select Site Locations List from the right 
mouse button menu. Trns•port displays the Site Locations list window (see Figure 4-12).  

 
Figure 4-12. Site Locations List Window 

To add information about a site location, press INSERT or select Add from the right mouse 
menu to view the Add Site Location detail window (see Figure 4-13).  
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Figure 4-13. Add Site Location Window 

To create a complete record you must enter information in the fields listed in section 
4.5.4.  

Click OK to save the site location or ADD MORE to add more sites.  

Trns•port displays the Site Locations list window for you to view the sites you entered. 
Click the CLOSE button to close the window and return to the Proposals list window.  

4.5.2 Changing Site Information  

To change information about an existing proposal site, select the site record in the Site 
Locations list window and choose Change from the right mouse button menu. Trns•port 
displays a Site Location detail window.  

You can add or change information in any field except Site Number. When you finish 
making changes, click OK to save your changes or click CANCEL to return to the Site 
Locations list window without saving.  

4.5.3 Deleting Site Information  

To delete site information, select the site record or records you want to delete in the Site 
Locations list window and choose Delete from the right mouse button menu. Trns•port 
displays a Delete Warning window.  

Click YES in each window to complete the delete process.  

4.5.4 Adding, Changing, and Deleting Site Information Through the Tabbed 
Folder Window  

To define the site location for a proposal, select the proposal from the Proposals list 
window and choose Tabbed Folder Change from the right mouse button menu.  Trns•port 
displays the Proposal tabbed folder window.  Click the SITES tab (see Figure 4-14).  
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Figure 4-14. Sites Tab on the Proposals Tabbed Folder Window 

The top part of the SITES tab contains a list of all the existing sites associated with the 
proposal. The bottom part of the SITES tab contains detail information for the site 
currently selected in the list.    

To add a site, select Add from the right mouse button menu.  Trns•port adds a blank row 
to the list of sites. You can enter data about the new site into the blank fields displayed 
in the detail area of the Sites tab.  

To create a complete record you must enter information in these fields:  

Description  A short description of the site. 

Liquidated Damages Per Day The amount to be charged, in whole 
dollars, for each day that a contractor 
exceeds the allowed time for a 
contract. 

Number of Days or Completion Date The number of available or calendar 
days that are available for completion 
of a contract site, or the date that the 
work is to be completed. For Cost 
Plus Time bids, the value entered in 
this field for Site 00 represents the 
total contract time component of the 
bid. 
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Road User Cost Per Day 

 

The cost per day value used to 
determine the low bidder in a Cost 
Plus Time bid. A value can only be 
entered in this field if the value in the 
Type of Days field is CD or AD. A 
non-blank value in this field indicates 
the Site is a Cost Plus Time Site. The 
value is the cost per day of the 
inconvenience of the construction. 

Site Number  A unique identifying sequence 
number for each site. Each contract 
must have a site 00, which 
represents the contract as a whole, in 
addition to any other sites. 

Type of Days  A coded value indicating whether 
Trns•port should base contract time 
on available working days, calendar 
days or a completion date. 

You are not required to, but you can enter information in these fields to record additional 
information about a site:  

Specified Completion Date The projected date when the 
contractor will complete work for a 
given site. 

Specified Start Date The project date when the contractor 
will start work on a given site. 

When you have finished adding information, click OK to save the site location or ADD MORE 
to add more sites.  Trns•port displays the new site in the Site list.    

Before leaving the tabbed folder window you must save all your changes to the database 
by clicking the SAVE button or selecting Save from the File menu.  

4.5.5 Changing Site Information  

To change information about an existing proposal site, select the site record in the list on 
the SITES tab of the Proposal tabbed folder window. Trns•port displays all the existing 
information about the selected site in the detail area of the SITES tab below the list.  

You can add or change information in any field except Site Number.  To change 
information, click in a text box and add or delete information.  When you finish making 
changes, click OK. If you want to return to the site list without saving your changes, click 
CANCEL.  

Before leaving the tabbed folder window you must save all your changes to the database 
by clicking the SAVE button or selecting Save from the File menu.  

4.5.6 Deleting Site Information  

To delete site information, select the site record or records you want to delete in the Site 
list window on the SITES tab and choose Delete from the right mouse button menu.  
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Trns•port displays a Delete Warning window.  

Click YES in the window to complete the delete process.  

4.6 Entering or Modifying a Long Description of the Proposal  

Once you assign site locations, you enter a long description of the proposal.  Trns•port 
allows you to add multiple lines of free-form text to describe the type of work, 
description, or other relevant information about the proposal. The long description can 
appear on proposal-related reports.  

Select a proposal from the Proposal list window and select Proposal Description from the 
right mouse button menu or click the DESCR button on the button bar. Trns•port displays 
the Long Description window (see Figure 4-15).  

 
Figure 4-15. Long Description Window 

You can enter a description of about 32,000 characters or 400 lines.  

Do not press ENTER at the end of each line; Trns•port automatically wraps text to a new 
line. If you want to start a new paragraph, then press ENTER. You can use the Windows 
Copy (CTRL+C) and Paste (CTRL+V) commands from the Edit menu to copy and paste text 
from other windows.  

Click OK when you finish entering information and Trns•port displays the Proposals list 
window.  

4.6.1 Entering or Modifying a Long Description of the Proposal Through the 
Tabbed Folder Window  

In the Proposal tabbed folder window, click the DESCRIPTION tab. Trns•port displays the 
DESCRIPTION tab window (see Figure 4-16).  
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Figure 4-16. Description Tab on the proposal Tabbed Folder Window 

You can enter a description of about 32,000 characters or 400 lines.  

Do not press ENTER at the end of each line; Trns•port automatically wraps text to a new 
line. If you want to start a new paragraph, then press ENTER. You can use the Windows 
Copy (CTRL+C) and Paste (CTRL+V) commands from the Edit menu to copy and paste text 
from other windows.  

Before leaving the tabbed folder window you must save all your changes to the database 
by clicking the SAVE button or selecting Save from the File menu.  

4.7 Specifying Sections and Line Numbers  

You can add, change and delete proposal sections manually, but Trns•port will also 
generate section and line numbers automatically.  

When you create a proposal that consists of more than one project, Trns•port combines 
the projects and project items in the following way:  

Trns•port combines project categories when the categories have the same category 
types. The combined category becomes a section in the proposal. The Federal 
Construction Class field controls whether Trns•port combines categories into a single 
section. If the FEDCCLS field matches, Trns•port will combine categories except when a 
category is an alternate. Items from alternate categories are combined with alternate 
categories in other projects only when the alternate codes for the categories in those 
projects are identical. Trns•port assigns a unique section number to each proposal 
section. Trns•port updates the database record for every category in that section to 
reflect the section to which it now belongs.  

Trns•port aggregates items within combined categories (that is, proposal section) when 
the items have the same item number and supplemental description. Trns•port removes 
items that are members of an alternate item set from the section and places them in a 
section describing the alternate relationship. If you have designated an item not to fold, 
Trns•port will not combine it. Trns•port combines alternate items across projects only 
when the same alternate codes are used in both projects to identify the alternates.  

Trns•port does not combine common items if you have flagged the item not to fold. 
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Currently, it is NJDOT policy to not combine common items. 

The aggregation procedure for combining common items is as follows:  

Sum the quantities (except for lump-sum items).  

Calculate a weighted average of the price estimate (Σ means sum).  

 
 
Trns•port calculates price estimates for lump-sum items by summing individual item 
price estimates and retaining the quantity amount of lump sum.  

 
 

After Trns•port combines like items, it assigns unique proposal line numbers. Trns•port 
then updates every database item record to reflect the proposal line item number to 
which the record now belongs.  

4.7.1 Adding, Changing, and Deleting a Proposal Section in the Proposal Section 
Window  

If you choose to add sections to a proposal manually, select the proposal in the 
Proposals list window and choose Section List from the right mouse button menu. 
Trns•port displays a Proposal Sections list window (see Figure 4-17).  

 

 
Figure 4-17. Proposal Sections List Window 

Press INSERT or choose Add from the right mouse button menu. Trns•port displays an 
Add Proposal Section window (see Figure 4-18).  
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Figure 4-18. Add Proposal Section Window 

Enter a proposal section number and a description and click OK to add a proposal section, 
ADD MORE to add another section, or CANCEL to return to the Proposal Sections list window 
without adding a new section.  

4.7.2 Changing a Proposal Section  

After Trns•port generates section and line numbers, you can modify the section number 
record. Trns•port uses the category description of the first category assigned to the 
section as the section description. To create a unique section, you can change a proposal 
section’s description by selecting the proposal section in the Proposal Sections list 
window.  

Choose Change from the right mouse button menu. Trns•port displays a Proposal Section 
window. Change the description and click OK to save the changes or click CANCEL to 
return to the Proposal Sections list window without saving.  

4.7.3 Deleting a Proposal Section  

To delete proposal sections, select the section or sections in the Proposal Sections list 
window and choose Delete from the right mouse button menu. Trns•port displays a Delete 
Warning window.  If you generated the section and line numbers using the automated 
process, and have since made changes or deletions to the sections or items, you will 
need to rerun the generate section and line number process to make sure those changes 
are reflected correctly in the database.  

Click YES in each of the windows to complete the delete process.  

4.7.4 Adding, Changing, and Deleting a Proposal Section in the Tabbed Folder 
Window  

To add sections through the tabbed folder window, select the proposal in the Proposals 
list window and choose Tabbed Folder Change from the right mouse button menu.  
Trns•port displays the Proposal tabbed folder window.  Click the SECTIONS tab (see 
Figure 4-19).  
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Figure 4-19. Sections Tab on the Proposals Tabbed Folder Window 

The top part of the SECTIONS tab contains a list of all the existing sections in the 
proposal.  The bottom part of the SECTIONS tab contains detail information for the 
section currently selected in the list.    

To add a section to the proposal, select Add from the right mouse button menu.  
Trns•port adds a blank row to the list of sections. Enter data into the blank fields 
displayed in the detail area of the Sections tab.  You can also enter data directly into the 
list fields by selecting Hide Detail from the right mouse button menu (see Figure 4-20).  

 
Figure 4-20. Sections Tab With Hide Detail Selected 

Enter a proposal section number and a description and click OK to add a proposal section, 
ADD MORE to add another section, or CANCEL to return to the Proposal Sections list without 
adding a new section.  
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Before leaving the tabbed folder window you must save all your changes to the database 
by clicking the SAVE button or selecting Save from the File menu.  

4.7.5 Changing a Proposal Section  

After Trns•port generates section and line numbers, you can modify the section number 
record. Trns•port uses the category description of the first category assigned to the 
section as the section description. To create a unique section, you can change a proposal 
section’s description.  

Select the proposal section in the list on the SECTIONS tab of the Proposal Tabbed Folder 
window. Trns•port displays all the existing information about the selected section in the 
detail area of the SECTIONS tab.  

Click in the Description text box and change the description.  Click OK to save the 
changes or CANCEL to return to the Sections list without saving.  

Before leaving the tabbed folder window you must save all your changes to the database 
by clicking the SAVE button or selecting Save from the File menu.  

4.7.6 Deleting a Proposal Section  

To delete proposal sections, select the section or sections in the SECTIONS tab and 
choose Delete from the right mouse button menu.  Trns•port displays a Delete Warning 
window.  

Click YES in the window to complete the delete process.  

4.7.7 Generating Section and Line Numbers  

Generating section and line numbers will roll up the project-level items and categories to 
the proposal level and assign proposal line numbers and section numbers to the items 
and categories.  Trns•port uses the section and line numbers assigned through this batch 
process to generate the proposal items in the Trns•port LAS initialization process.  All 
proposal-level reports will use these line number assignments.  

� Note:  There are times when generating section and line numbers is not a 
desired action (example – some M&O proposals where order of lines and items 
is important).  If and when PES prompts to Generate Section and Line Numbers, 
just click on NO or CANCEL. 

You can generate section and lines numbers two ways:  

 Select the proposal from the Proposals list window and choose Run Process from the 
right mouse button menu.  Trns•port displays the Processes window.  Select Generate 
Section and Line Numbers from the Processes window and click OK.  

Within the Proposal tabbed folder window, click the SECTIONS tab. Trns•port displays the 
SECTIONS tab window. Click the GENERATE SECTION AND LINES NUMBERS button.  

Trns•port displays the Proposal Generation Option window.  

If you check the List Section/Line Number Assignments check box, you can get a hard 
copy printout of the project item and how they are rolled up to the proposal level.  

If you have already set all the process parameters correctly and do not need to make 
changes to the default values, click SUBMIT to bypass the Process Submission Parameters 
window.  

After Trns•port completes the batch function, you can review the Proposal Line Number-
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Section Assignment report. The report shows the proposal sections and line numbers 
Trns•port created and how they relate to the project(s) and categories that make up the 
proposal.  

In this report, Trns•port combines all the project categories into one or more proposal 
sections and puts the proposal line numbers in order according to the item numbers they 
represent.  

If you set the Combine with Like Items flag to yes in the Add Item window, each item 
will only appear once in a proposal section, even if it is listed under more than one 
category. Items only appear once because Trns•port combines project items with the 
same item number into single proposal line items, even though the project items are in 
different categories or projects. Bidders can then bid on a single item. Trns•port rolls up 
all the quantities for the project items into one proposal line item. If you set the Combine 
flag to no, Trns•port will not roll up the items.  

� Note:  Currently NJ does not combine like items therefore like items should not 
be allowed to combine. 

Because bidders will not bid on non-bid account items (you can set a flag in the project 
item detail window), Trns•port will omit these items from the proposal report.  

4.8 Maintaining Special Provisions  

� Note:  NJ is not currently using Special Provisions in Trns•port .This section on 
Special Provisions is provided for reference only. 

Special provisions are special texts or requirements that you can apply to specific 
proposals. Trns•port maintains a list of special provisions in the Special Provisions List 
table; thus, the master list of special provisions are separate from the proposals to which 
they apply. When you add a special provision to a proposal, Trns•port adds an 
association record to establish a connection between the selected special provision and 
the selected proposal. If you delete a special provision, Trns•port deletes the association 
between the special provision and the proposal, not the special provision and text itself.  

4.8.1 Adding a Special Provision to a Proposal  

To associate special provisions with a proposal, select the proposal to which you want to 
assign special provisions in the Proposals list window.  Click the SPECPROV button or 
choose Special Provisions List from the right mouse button.  Trns•port displays the Special 
Provisions list window, which shows the special provisions currently associated with the 
proposal (see Figure 4-21).  
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Figure 4-21. Special Provisions List Window 

To associate special provisions with a proposal, press INSERT or choose Add from the right 
mouse button menu to display the Add Special Provisions list window, which is the full 
list of special provisions (see Figure 4-22).  

 
Figure 4-22. Add Special Provisions List Window 

Click on a special provision to select it and then press INSERT or select Add from the right 
mouse button menu to associate the special provision with the selected proposal.  

You can associate several special provisions at one time by holding down CTRL while you 
select more than one special provision. Then you can press INSERT to associate the 
provisions to the selected proposal.  

Click the CLOSE button on the button bar to close the Add Special Provisions list window. 
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Trns•port displays the special provisions you added in the Special Provisions list window.  

4.8.2 Adding a Special Provision to a Proposal Through the Tabbed Folder 
Window  

To associate special provisions with a proposal, select the proposal to which you want to 
assign special provisions in the Proposals list window and select Tabbed Folder Change from 
the right mouse button menu.  Trns•port displays the Proposal tabbed folder window.  

To add a special provision to the proposal, click the SPECIAL PROVISIONS tab. Trns•port 
displays the SPECIAL PROVISIONS tab window (see Figure 4-23).  

 
Figure 4-23. Special Provisions on the Proposal Tabbed Folder Window 

The top part of the SPECIAL PROVISIONS tab contains a list of all the special provisions 
currently associated with the proposal.  The bottom part of the SPECIAL PROVISIONS tab is 
a master list of special provisions from which you can choose to add to your proposal.  
This master list will contain all special provisions that are not already associated with this 
particular proposal.  

You can view the long description of any special provision listed on the SPECIAL 
PROVISIONS tab by clicking on the provision and selecting View Text from the right mouse 
button menu.  

To add a special provision to the proposal, select the special provision in the master list 
and press the ADD SELECTED button.  

� Note: You can use the Quick Find text box or the filter on the SPECIAL PROVISIONS 
tab to quickly locate the record(s) you want.  

You can select more than one special provision by holding down CTRL while you select 
records with the mouse, or you can add all the special provisions by clicking the ADD ALL 
button.  

Trns•port displays the special provisions you added in the Special Provisions list.  

When you have finished adding special provisions to the proposal, save your changes to 
the database by clicking the SAVE button or selecting Save from the File menu.  

Defining a Proposal                                                                              4-25 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

4.8.3 Deleting a Special Provision from a Proposal  

To delete the association of a special provision with a proposal, select the provision in 
the list on the SPECIAL PROVISIONS tab and click the REMOVE SELECTED button.  

You can select more than one special provision by holding down CTRL while you select 
records with the mouse, or you can delete all the special provisions by clicking the 
REMOVE ALL button.  

Trns•port displays a Delete Warning window.  Click YES in the window to complete the 
delete process.  

When you have finished removing special provisions from the proposal, save your 
changes to the database by clicking the SAVE button or selecting Save from the File menu.  

4.8.4 Listing Special Provisions  

To produce a hard copy listing of special provision information, select the proposal or 
proposals with special provisions you want to list in the Proposals list window.  Then 
choose Run Process from the right mouse button menu.  Trns•port displays the Processes 
list window.  

Select List Proposal Provisions from the list and click OK. Trns•port displays the Confirm 
Process Submission window.  

Click SUBMIT to run the process.  

4.9 Listing Contract Proposals  

To produce a hard copy listing of proposal information, select the proposal or proposals 
in the Proposals list window. Then choose Run Process from the right mouse button menu. 
Trns•port displays the Processes list window.  

Select List Contract Proposals and click OK to continue the process. Trns•port displays the 
Confirm Process Submission window.  

Click SUBMIT to run the process, PARAMETERS to change process submission parameters, or 
CANCEL to return to the Proposals list window without running the process.   

4.10 Changing the Estimated Price at the Proposal Level  

When a proposal has been set up, estimators might want to review the proposal-level 
prices and quantities. Because of the larger quantity of items at this level, estimated  

prices might be changed because of quantity savings or the price might have changed 
over time.  You can view and modify the estimated prices through an editable scroll 
feature in Trns•port.  All modified prices will be propagated back to the original project 
item price(s).  

Follow these steps to change an item’s estimated price at the proposal level (see Figure 
4-24):  

Select a proposal from the Proposals list window.  

Click the ITEMS button or select Proposal Items from the right mouse menu to display a 
Proposal Items list window, which shows quantities rolled up to the proposal level.  
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Figure 4-24. Proposal Items List Window 

This grid window shows quantities rolled up to the proposal level. If item price estimates 
were previously specified (with the Generate Bid-Based Prices process or by the 
estimator), a weighted estimated price for each proposal line item is displayed. This 
pricing information is computed from the estimated price and quantities of the individual 
occurrences of the items that were combined into that proposal line item.  

The following formula is used to display the weighted prices:  

For lump sum items (where Σ means "sum"):  

 

For all other items:  

  
 

Change the estimated price in the Price field. If you change a price inadvertently, press 
ESC before you leave that field to revert back to the original price.  Trns•port recalculates 
the extended amount according to the new price you enter.  

When you finish making changes, click in the window again. When you try to close the 
window, Trns•port displays the Proposal Items dialog box.  

Click YES to save the new prices, click NO to return to the Proposals list window without 
changing prices, or click CANCEL to return to the Proposal Items list window to make 
other changes (see Figure 4-25). When you save, Trns•port will propagate the new 
prices back to the project estimate item level and breakdown level.  
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Figure 4-25. Proposal Items Dialog Box 

Each proposal line price estimate will be redistributed to each of the project item records 
that combine into that proposal line item. This formula is used to distribute the prices 
back to the project item records:  

For lump sum items:  

 
For all other items: 

 
4.10.1 Changing the Estimated Price at the Proposal Level in the Tabbed Folder 
Window  

To change an item’s estimated price at the proposal level, select a proposal from the 
Proposals list window and choose Tabbed Folder Change from the right mouse button 
menu. Click the ITEMS tab. The ITEMS tab contains a list of proposal items with the item 
quantities rolled up to the proposal level (see Figure 4-26).  

 
Figure 4-26. Items Tab in the Proposal Tabbed Folder Window 

This grid window shows quantities rolled up to the proposal level.  If item price estimates 
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were previously specified (with the Generate Bid-Based Prices process or by the 
estimator), a weighted estimated price for each proposal line item is displayed.  This 
pricing information is computed from the estimated price and quantities of the individual 
occurrences of the items that were combined into that proposal line item.  

The following formula is used to display the weighted prices:  

For lump sum items (where Σ means "sum"):  

 

For all other items:  

 

Change the estimated price in the Price field.  If you change a price inadvertently, press 
ESC before you leave that field to revert back to the original price.  Trns•port recalculates 
the extended amount according to the new price you enter.  

Each item listed on the ITEMS tab must have a proposal line number assigned to it in 
order for Trns•port to update the database with any changes you make to item prices.  If 
line numbers have not been assigned to any of the items associated with your proposal, 
click the GENERATE SECTION AND LINE NUMBERS button before saving your changes. If you 
wish to print, click the PRINT button to print the results of this process to a local printer.  

When you finish making changes, save the new prices by clicking the SAVE button or 
selecting Save from the File menu. Trns•port will propagate the new prices back to the 
project level and breakdown level.  

Each proposal line price estimate will be redistributed to each of the project item records 
that combine into that proposal line item. This formula is used to distribute the prices 
back to the project item records:  

For lump sum items:  

 
 

For all other items:  

 
 

4.11 Loading the Proposal Item Price Estimates  

To load all the proposal item price estimates that have been entered into the Trns•port 
PES database, you must run a batch process called Load Contract Price Estimates.  

The Load Contract Price Estimates process performs edit checks on the entered proposal 
item price estimates. It verifies that the CONTID is a valid contract identifier, that the 
referenced proposal items have been defined, and that the item quantity and item 
number are consistent with those in the Trns•port PES database. The process reports 
any problems found with the data in an exception report and then updates the Project 
Item file with the new prices. An estimate item price will not be updated if the price is 
locked or if there is an addendum item associated with the proposal item.  
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Before running the Load Contract Price Estimates process, follow these steps to make 
sure the IO\QPROPRIC\PROPPRIC.DAT file is in the staging area:  

Select Download File from the Utilities menu and choose Process I/O File;  

Select the QPROPRIC directory;  

Verify that the PROPPRIC.DAT file is in the directory;  

Click CANCEL.  

Select Run Processes from the File menu and choose Load Contract Price Estimates. Submit 
the batch job by clicking SUBMIT in the Confirm Process Submission window. See 
“Submitting Batch Processes” in Chapter 3 for more information about submitting and 
printing batch processes.]  

4.12 Generating a Proposal-level Bid-Based Prices  

To obtain historically generated prices for proposal items, you must run the Generate 
Proposal Level Bid Based Prices process.  This process will generate average or 
regression prices (if the historical data is available) for proposal items by quantity level 
and other criteria. Then, it will propagate the proposal item prices to the corresponding 
project item record. Item prices in the Proposal Item and Estimate Item tables are 
updated and reports are also generated.  

The Bid-Based Prices report generates price estimates by using multiple regression 
prediction equations produced by Trns•port BAMS/DSS.  Trns•port bases predictions on 
bid data contained in the Trns•port BAMS/DSS historical database and includes quantity, 
location and time period. Trns•port writes the generated prices to each item’s record in 
the Proposal Item table then the Project Estimate Item table for every item that does not 
already have a price estimate associated with it.  Appendix C includes sample output and 
explanations of weighted averages and regression analysis.  

The system manager must have run the Trns•port BAMS/DSS PEMETH and COMBID 
models to generate the BIDHIST.CSV, or bid history, file.  This file contains all the data 
and parameters you need to generate bid-based prices.  This process will continue to use 
the bid histories from the last file loaded until a newer BIDHIST file is generated and 
loaded to the proper area.   

Select the proposals for which you want to generate from the Proposals list window.  You 
can select more than one proposal by holding down CTRL while you select proposals with 
the mouse. Choose Generate Bid-Based Prices from the Run Processes window. Trns•port 
displays the Generate Bid Based Prices window (see Figure 4-27).  

 
Figure 4-27. Generate Bid Based Prices Window 

You must enter the proposed letting date in yy/mm/dd format before you can run the 
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process. Because season is one of the pricing coefficients, the date you enter sets the 
time parameters for generating bid-based prices.  

Click SUBMIT to run the process, PARAMETERS to change parameters, or CANCEL to cancel 
the process submission.  

4.13 Adding Fiscal Completion Schedule Data to a Proposal  

You can add fiscal year information to a proposal record and create a report called the 
Proposal Fiscal Completion Schedule, which shows what percentage of work should be 
completed in each fiscal year of the proposal.  You can generate a Proposal Fiscal 
Completion Schedule for an individual proposal or an entire bid letting.  

To add fiscal year information to a proposal, select the proposal in the Proposals list 
window and select Tabbed Folder Change from the right mouse button menu.  Trns•port 
displays the Proposal tabbed folder window (see Figure 4-28).  

Click the FY SCHEDULE tab.  

 
Figure 4-28. FY Schedule Tab on the Proposal Tabbed Folder Window 

The FY SCHEDULE tab contains a grid listing all the fiscal years currently associated with 
the proposal. The last row in the grid displays totals for the Percent Time Elapsed and 
the Percent Funding Allocated columns.  You can add or change information in any field 
in the grid.   

To add a new fiscal year record to the proposal, select Add from the right mouse button 
menu. Trns•port adds a blank row to the grid.  Enter information for the fiscal year and 
the time and funding percentages directly into each field.   

To delete a fiscal year record, select the row containing the record and choose Delete from 
the right mouse button menu.  You can select more than one fiscal year by holding down 
CTRL while you select records with the mouse, or select all records by selecting Select All 
from the right mouse button menu.  

Trns•port displays a Delete Warning window.  Click YES in the window to complete the 
delete process.  
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When you have finished adding, changing or deleting fiscal year information from the 
proposal, save your changes to the database by selecting Save from the File menu. 
Trns•port displays a Warning message if either of the totals do not equal 100 when you 
attempt to save or close the tabbed folder window.  

4.13.1 Generating the Proposal Fiscal Completion Schedule Report  

To print the Proposal Fiscal Completion Schedule report, select the proposal from the 
Proposals list window and choose Run Process from the right mouse button menu.  
Trns•port displays the Processes window.  Select Generate Proposal Fiscal Completion Schedule 
Report from the Processes window and click OK.  

Trns•port displays the Confirm Process Submission window.  Click SUBMIT to run the 
process.  

4.14 Deleting a Proposal  

You can delete a proposal and its associated references. There are two levels of delete at 
the proposal level. You can delete the following information:  

Related addendum information  

List of projects associated with the proposal  

List of special provisions associated with the proposal  

Any association between the proposal and a bid letting  

Project estimate information for all projects belonging to the proposal (optional)  

! Caution: Do not delete proposals that still have data in Trns•port LAS (for example, 
bid tab or planholder data); otherwise, the Trns•port LAS data for those proposals 
will not be accessible.  

To delete a proposal record, select the proposal or proposals in the Proposals list 
window. Then choose Delete from the right mouse button menu. Trns•port displays a 
Delete window.  

If you choose Delete, you will delete the association of a single proposal with the projects 
associated with the proposal. You will also delete the proposal header records, sections, 
addendums, proposal sites and long description.  Click CANCEL to return to the Proposals 
list window without deleting.  Click OK to continue the delete process. Trns•port displays 
a Delete Warning window.  

Click YES in each of the windows to complete the delete process.  
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5.0 Setting up a Bid Letting and Assigning Proposals 

When you finish creating a proposal and it is ready for contractors to bid on, you are 
ready to set up a bid letting. You must create a letting and assign proposals to the 
letting so the proposals will be available for bid. You can also specify the order in which 
your agency will open and read the proposal bids and you can add descriptive 
information about the letting such as letting date, time and location.  

5.1 Adding a Bid Letting Record  

Before you can assign proposals to a bid letting, you must set up a bid letting header 
record.  

To select the bid letting function in Trns•port PES, click the BIDLETS button on the 
Trns•port PES button bar. Trns•port displays a Bid Letting list window (see Figure 5-1).  

 
Figure 5-1. Bid Letting List Window 

To create a new bid letting record, press INSERT or select Add from the right mouse menu 
to display the Add Bid Letting Package window (see Figure 5-2).  
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Figure 5-2. Add Bid Letting Package Window 

To create a complete record you must enter information in these fields: Date of Letting 
The date you will hold a letting.  Enter in YY/MM/DD format. Letting Number A unique 
identifying number or alphanumeric for a bid letting.  

You are not required to, but you can enter information in these fields to record additional 
information about a letting:  

Letting Address  A description of the letting location.  

Location of Bid 
Deposit 

The location at which bidders should deposit bids.  

Location of 
Letting  

The location at which you will perform a letting.  

Status of Letting  

A value, which must be selected from the attached 
LETSTAT code table, which indicates the status of the 
letting (for example, planned, scheduled, or 
postponed).  

Time of Letting  The time a letting will be held.  

When you finish entering information, click OK to add the bid letting, ADD MORE to add 
another bid letting, or CANCEL to return to the Bid Letting list window without adding a 
letting.  

Trns•port adds new lettings to the bid letting list by the number of the letting. You may 
have to scroll up or down to find the lettings you added.  
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5.2 Changing a Bid Letting Record  

To change information in a bid letting record, select the record in the Bid Lettings list 
window and choose Change from the right mouse button menu. Trns•port displays a Bid 
Letting Package window.  

You can change or add information in any field except Letting Number. When you finish 
making changes, click OK to save your changes or CANCEL to return to the Bid Lettings list 
window without saving.  

5.3 Assigning Proposals to a Bid Letting  

To assign proposals to a new bid letting, select the bid letting in the Bid Letting list 
window and click the LETPROP button on the button bar or choose Letting Proposal List from 
the right mouse menu. Trns•port displays the Letting/Proposals list window (see Figure 
5-3).  

 
Figure 5-3. Letting Proposals List Window 

To assign proposals to the letting, press INSERT or choose Add from the right mouse 
menu. Trns•port displays the Add Letting/Proposal window (see Figure 5-4).  
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Figure 5-4. Add Letting/Proposal Window 

Contract ID  A unique identifier for a proposal or contract.  

Letting Call 
Order  

The order in which you will open a bid for a specified 
proposal during a bid letting.  

Advertisement  
Date 

The date you will notify potential bidders of the letting of a 
proposal. Enter in YY/MM/DD format 

You are not required to, but you can enter information in these fields to record additional 
information about a letting:  

Awarded 
Amount  

The dollar amount awarded to the winning bidder for a 
proposal.  

Awarded Vendor  The vendor number of the winning bidder for a contract.  

CAS Contract ID  A unique identifier for the contract when it is passed to a 
construction system.  This allows the state to rename a 
proposal once it has been awarded.  

Letting Status  A value, which must be selected from the PRPSTAT code 
table, which indicates the status of a proposal.  

Passed to 
SiteManager 
(CAS)/DSS  

Indicates whether a contract has been passed to DSS (D), 
CAS (C), or both (B). This field is blank if the contract has 
not been passed. If you plan to pass a contract that has 
been passed previously, you must make sure this field is 
blank before you pass the contract again.  
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Reason for Non-
Processing  

A value, which must be selected from the attached 
CNAWDRS code table, which indicates the reason the 
proposal is not processed.  

Status Date  The date you entered the status.  

Click OK to add the proposal letting information to the Trns•port database, ADD MORE to 
add another proposal to the letting, or CANCEL to exit without saving.  

Trns•port displays the proposals you assigned to the letting in the Letting/Proposals list 
window in call order.  

To close the Letting/Proposals window, click the CLOSE button on the button bar. 

5.4 Initializing a Proposal 

When a proposal has been assigned to a bid letting, you must first initialize the proposal 
before you can begin to manage the Letting in LAS. 

Open the bid letting list window, right click and select Letting Proposal List.  Right click 
the proposal and select Run Process.  Select Initialize Letting Proposals, ok, submit, and 
ok.  Once the proposal has been initialized the text file can be generated. 

5.5 Changing Letting/Proposal Information  

To change information about a letting/proposal, select the letting/proposal in the 
Letting/Proposals list window and choose Change from the right mouse button menu. 
Trns•port displays a Letting/Proposal window.  

You can change or add information in any field except Letting Call Order. When you 
finish making changes, click OK to save your changes or CANCEL to return to the 
Letting/Proposals list window without saving.  

5.6 Listing Bid Letting Packages  

You can produce a hard copy listing of bid letting information to help you review current 
data values. To select the bid lettings to list in the report, hold down CTRL while you 
select bid lettings with the mouse. Then select Run Process from the right mouse button 
menu. Trns•port displays a Processes window.  

Select List Bid Letting Packages and click OK to run a process. Trns•port displays a Confirm 
Process Submission window.  

Click SUBMIT to run the process, PARAMETERS to change process submission parameters, or 
CANCEL to return to the Bid Lettings list window without running the process.   

5.7 Generating a Proposal Schedule Report  

After you assign a proposal to a letting, the proposal schedule will have letting data 
available. You can then run the Proposal Schedule report, which consists of these 
sections:  

• Proposal Cover Sheet – The cover sheet shows proposal information and projects 
associated with the proposal.  The second page of the cover sheet lists the 
proposal sites, estimated number of days to complete the contract, and the 
liquidated damages per day rate.  If the proposal has alternate items, they are 
also listed.  The Road User Cost per day section is printed for proposals that 
involve Cost Plus Time bidding. 

• Proposal Schedule of Prices – The schedule of items is printed for distribution to all 
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potential bidders.  The schedule shows each proposal line item, its description and 
estimated quantity.  Space is provided for the contractor to enter the bid price, 
the extended bid amount, section totals, cost plus time number of days bid and 
proposal total. 

• Proposal Estimate – The Proposal Estimate with the Engineers Estimate is similar 
to the schedule of items but is for IN HOUSE USE ONLY.  IT IS IMPORTANT THAT 
THIS IS NOT POSTED. 

• Special Provisions Listing – The special provisions listing lists all special provisions 
associated with the proposal. 

• Special Provisions Text – The special provision text for each special provision 
attached to the proposal can be printed. 

• DBE Interest Report – The DBE Interest Report lists proposal items that have been 
flagged in the item file as likely items for DBE/WBE (ESBE for NJDOT) 
subcontracts.  Information on this report can be used to help determine and 
evaluate ESBE goals for a proposal. 

• Generate Pass File to EBS – Once the proposal item details are finalized they can 
be transferred from PES to Expedite in an EBS file. 

• Quantity Sheet Summary – A summary sheet of all item quantities and the total 
estimate amount. 

To run a Proposal Schedule report, select a proposal from the Proposals list window and 
choose Run Process from the File menu to display a Processes window.  

Select Generate Proposal Schedule and click OK. Trns•port displays the Proposal Price 
Schedule Options window (see Figure 5-5).  

 
Figure 5-5. Proposal Price Schedule Options Window 

You must fill in the EBS Pass File Name, which is the DP#,  before you can run the 
process. You can generate any combination of the report sections by clicking each check 
box.   Make sure the proposal estimate is NOT checked because the Engineers Estimate 
is included and it SHALL NOT BE POSTED. 

Click OK in the Proposal Price Schedule Options window to run the process. Click OK in 
the Job Monitor window to return to the Proposals list window  
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5.8 Deleting a Bid Letting Package  

You can delete an existing bid letting package at three levels. Each level of delete 
eliminates more data from the Trns•port database. The first level deletes all bid letting, 
the second level includes proposal-level information, and the third level also deletes all 
project-related information.  

! Caution: Do not delete a bid letting package if the letting has data in Trns•port LAS 
(for example, bid tab data).  Trns•port performs a check to ensure this never 
happens.  

To delete a bid letting package, select the bid letting in the Bid Lettings list window. 
Then choose Run Process from the right mouse button menu. Trns•port displays a 
Processes window.  

Select Delete Bid Letting Package and click OK. Trns•port displays a Delete dialog box.  

The type of deletes Trns•port displays depend on which deletes you have the security to 
perform. If you choose Delete, you will delete the bid letting package and associated 
letting proposals for all calls in the selected letting. Click OK to continue the Delete 
process or click CANCEL to return to the Bid Lettings list window without deleting. If you 
click OK, Trns•port displays a Delete Warning window.  

If you click YES, Trns•port will complete the delete process. If you click NO, Trns•port will 
return to the Bid Lettings list window without deleting.  

If you choose Power Delete, you will also delete all proposal-level information for the 
proposals in the selected letting (that is, the sites, long description, proposal provisions 
and sections). Trns•port displays a series of two Delete Warning windows.  

If you choose Strong Delete, you will also delete all projects, category, funding, and item 
information for the projects assigned to the proposals for the selected letting. Trns•port 
displays a series of three Delete Warning windows.  
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6.0 Managing Addendums 

After you advertise a proposal, you will have to make changes to the proposal with 
addendums. You can add new items, change existing items, or delete items.  The items 
can be in the same or different categories.  

To add an addendum to a proposal, you must create an addendum header record and 
then specify the project and category for each proposal addendum item.  

 Note: If you make changes in Trns•port PES (where you manage the 
addendums) to proposals that you have already initialized in Trns•port LAS 
(where you do the advertising), you will need to reinitialize the proposals in 
Trns•port LAS to transfer addendum changes from Trns•port PES. This means 
you must run the batch process Initialize Letting Proposals.  

6.1 Creating an Addendum Header Record  

To begin creating an addendum, you must create an addendum header record.  

Select the proposal to which you want to add an addendum from the Proposal list 
window and click the ADDEND button or choose Addendum List from the right mouse menu 
to display the Addendums list window (see Figure 6-1).  

 
Figure 6-1. Addendum List Window 

Press INSERT or choose Add from the right mouse menu to display the Add Addendum 
detail window (see Figure 6-2).  
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Figure 6-2. Add Addendum Detail Window 

To create a complete record you must enter information in these fields:  

Date of Addendum The date you add the addendum or it becomes effective. Enter in 
YY/MM/DD format. 

Description A short description of the addendum.  

Proposal A sequential number identifying a proposal addendum.  Trns•port  

Addendum No. Enters a value automatically.  

When you finish adding information about this addendum, click OK to save the record, 
ADD MORE if you want to add another addendum, or CANCEL to return to the Addendums 
list window without adding an addendum.  

6.2 Changing or Deleting Addendums  

You can change addendum information by selecting the addendum from the Addendum 
list window and choosing Change from the right mouse button menu.  Trns•port displays 
an Addendum window.  

Trns•port enters any available information about the addendum. You can add or change 
information in any field except Proposal Addendum Number. When you finish making 
changes, click OK to save your changes or click CANCEL to return to the Addendums list 
window without saving changes.  

To delete an addendum record, choose the addendum in the Addendums list window and 
choose Delete from the right mouse button menu. Trns•port displays a Delete Warning 
window.  

Click YES in each window to complete the delete process.  

6.3 Maintaining Addendum Item Information  

Trns•port treats each addendum item record as a transaction to apply to the original 
project specifications. Because Trns•port includes addendum items in Trns•port LAS 
reports, you must specify the project, category, item number, and items alternate code 

Managing Addendums                                                                               6-2 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

(if any) for each proposal addendum item.  You must also specify the proposal section 
number and proposal line item number.  

The PES Addendum Item table will now contain an audit trail of item level changes, 
additions, and deletions, while the PES Estimate Item table will always contain the 
current state of project estimate level items with addendum item changes automatically 
applied.  

To maintain addendum item information, select the addendum for which you want to 
maintain item information and select Addendum Items from the right mouse button menu. 
Trns•port displays the Addendum Items List Window (see Figure 6-3).  

 Note: Only the addendum items on the most recent addendum may be changed 
or deleted, and addendum items may only be added to the most recent 
addendum.  Only the most recent addendum may be changed or deleted as a 
whole.  

 
Figure 6-3. Addendum Items List Window 

6.3.1 Adding an Addendum Item Record  

Depending on the purpose of your addendum item, you will add an addendum item 
record in one of these three ways:  

• To add an addendum item record to add a new item, select Add from the right 
mouse menu and then choose New Item to display the Add Addendum Item detail 
window.  

• To add an addendum item to modify an item, select Add from the right mouse 
menu and then choose Modify Item to display the Add Addendum Item detail 
window.  

• To add an addendum item to delete an item, select Add from the right mouse menu 
and then choose Delete Item.  

Transport displays an Add Addendum Item detail window (see Figure 6-4).  
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Figure 6-4. Add Addendum Item Detail Window 

To create a complete record you must enter information in these fields:  

Category No. A unique identifier for a project category.  Choose a value from 
the attached drop-down list. When you add an addendum item, 
Trns•port fills the Category Number drop-down list with all 
categories in the project. If you select a different category 
number, Trns•port reverts the other fields to the default values 
until you select a Project Item Line Number.  

Estimated Price The engineer’s estimated cost for one unit of an item. Trns•port 
uses this field to determine an item's cost for the Detailed 
Estimate. Defaults to 0.00000; enter only if you are adding an 
item because Trns•port will use the original price if you change an 
existing item quantity.  

Estimated Quantity Used with Estimated Price to determine the cost of an item. Used 
in Trns•port LAS to determine the value of bids, in Trns•port CAS 
to determine the authorized item quantity, and in Trns•port 
BAMS/DSS to analyze construction overruns. Defaults to 0.000.  

Item Number A unique identifying number or alphanumeric assigned to each 
item. Choose a value from the attached drop-down list.  

 Note: To save time when adding items to a project, you can create a default 
filter for the Item List lookup window that will automatically filter the list to 
show only those items that you typically work with.   

After you add an addendum item to a proposal you MUST sign on to Trns•port 
LAS and reinitialize the proposal before you can continue to work with the 
proposal in LAS. 

 

 

Managing Addendums                                                                               6-4 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

Project Item 
Line No.  

A unique sequential identifier for an item within a 
project.  Choose a value from the attached drop-down 
list. When you select a category number, Trns•port 
fills in the Project Item Line No. list with all project 
item line numbers for the selected project and 
category. When you select the Project Item Line No., 
Trns•port fills in the Item Number, Item Description, 
Units or Lump Sum Units, Estimated Quantity, 
Estimated Price, Combine with Like Items, and 
Proposal Line Number fields.  

Proposal Line 
Number  

A unique sequential number that identifies a line item 
within a proposal. Trns•port automatically enters a 
value.  

Type of Action  The type of action (add, change or delete) to be 
performed by an addendum item.  

! Caution: Project Number, Category Number, Project Item Sequence Number and 
Proposal Line Number must match the item’s fields exactly if you are changing or 
deleting an existing item. If you are not changing an existing item, be sure you 
enter a valid category number for the project and that you do not enter a project 
item sequence number or proposal line number that has already been used; 
otherwise, batch failures will result. Trns•port does not interactively check to 
determine if the item is valid.  

You are not required to, but you can enter information in these fields to record additional 
information about an addendum:  

Item Alternate  Different items can serve as alternates for each other, which means 
that  

Code a bidder can choose to bid on either item, but not both. The first two 
characters of the item alternate code specify the alternate set and the 
third character indicates the choice within the set.  

Non-Bid Item An item, such as a state-supplied item, that will be included in the 
project but will not appear on any bid documents.  

Non-Participating  Identifies a fund that will fund 100 percent of the work for a 
project Fund Code item. Trns•port excludes the work for 
this item from funding for the category that contains the 
item.  

Pre-Established Indicates that the item has a fixed price.  

Price  

Revised Price You can change the Estimated Price by filling in a new value in this 
field. Trns•port will use the Revised Price instead of the Estimated 
Price whenever this field is non-blank, which allows you to keep a 
record of the changes you have made to any of the estimated prices.  

Source of Price A value, which must be selected from the attached PRICSPR code 
table, which indicates the originating source of an estimated price for 
an item (for example, estimated or historical).  
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When you finish entering information, click OK to add the item to the selected addendum. 
Click ADD MORE if you want to add another item or click CANCEL to return to the Addendum 
Items list window without adding an item.  

6.3.2 Changing an Addendum Item Record  

To change an addendum item record, select the item record in the Addendums Items List 
window and choose Change from the right mouse menu.  Transport displays an 
Addendum Item detail window with all information associated with the addendum item 
record (see Figure 6-5).  

 
Figure 6-5. Add Addendum Item Detail Window 

You can enter or change information in any field except Project No., Category No., 
Project Item Line No., and Specification Year.  When you finish making changes, click OK 
to save your changes or click CANCEL to return to the Addendum Items List window 
without saving.  

To delete an addendum item record, select the item in the Addendums Items List 
window and choose Change from the right mouse menu.  Transport displays a Delete 
Warning window. Click YES in each window to complete the delete process.  

6.4 Listing Proposal Addendums  

To produce a hard copy listing of proposal addendum information, select the proposal or 
proposals for which you want to list addendums from the Proposals list window. (You can 
select more than one proposal by holding down CTRL while you select proposals.)  

To generate the report, select Run Process from the File menu to display the Processes 
window. Choose List Proposal Addendum from the report list and click OK to run the 
process. Trns•port displays a Confirm Process Submission window.  

Click SUBMIT to run the process, PARAMETERS to change process submission parameters, or 
CANCEL to return to the Proposals list window without running a process.   

! Caution:  After you review the report output, sign on to Trns•port LAS and 
reinitialize each proposal to which you added addendums.  

Managing Addendums                                                                               6-6 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

7.0 Introduction to Trns•port LAS  

This chapter provides an overview of the Trns•port system and describes the workflow of 
the Trns•port LAS (Letting and Award System) module.  

7.1 Trns•port LAS Overview and Work Flow  

Trns•port LAS automates activities associated with letting and awarding projects.  You 
can enter information about vendors who receive proposals into the system for proposal 
cost accounting, mailing list generation and addendum distribution.  After the bid 
opening, you can enter bids interactively or through a batch facility. Trns•port performs 
edit checks of each bid and a bid editing facility allows you to correct errors.  When you 
enter all bids and finish editing, you can generate the following reports to help you 
evaluate and award bids:  

• Bid Tabulations (including the Engineer’s Estimate, if desired) 

• Low Bid Summary 

After you award contracts, you can produce pre- and post-letting bid letting summary 
reports, final detail estimates (project agreements), and final contract price schedules.  

After you award a contract, you can archive bid information from Trns•port LAS (for 
example, engineer's estimate information, bids from all bidders and the winning bidder) 
to the historical Trns•port database Trns•port Decision Support System (Trns•port 
BAMS/DSS). You can initialize a contract by passing winning bidder information and 
estimated item quantities to Trns•port Construction Administration System (SiteManager 
Construction) 

The Trns•port LAS work flow includes these steps:  

Initialize the bid letting proposals.  

After you define a bid letting in Trns•port PES, you must initialize the proposals 
for the bid letting in Trns•port LAS. You must rerun the initialization process if 
you make changes to estimate information for the proposals or add addendums 
in Trns•port PES. You can run and rerun the process any time.  

Process: Initialize Letting Proposals (File|Run Process) 
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child)  

Notify the contractors about bid letting details.  

The Notice to Contractors report notifies contractors about bid letting details. This report 
specifies the proposals that are up for bid in the letting and the work items that comprise 
those proposals.  

Process: Generate Notice to Contractors (File|Run Process)  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child)  

Enter purchase information for proposals and plans.  
As contractors purchase proposal books and plans for the proposals in the bid letting, 
you record the purchases. You can use this information to distribute proposal addendum 
information, invoice plan purchases, and identify bidders who have purchased valid-for-
bidding proposals as well as courtesy or “nonbid” planholders.  
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Trns•port must have entries for each bidder in the planholder list indicating the bidder 
purchased a valid-for-bidding proposal book for each proposal for which they submitted 
a bid.  

Trns•port maintains a master reference list of vendor information. You must enter 
planholder ship-to and bill-to addresses in the Vendor file. You might have to periodically 
maintain the Vendor file as vendor information changes.  

Process: Add/Change/Delete Planholder  

Location: Vendors List Window (Parent) 
Bid Lettings List Window (Child) 
Planholders List Window (Child)  

Process: Add/Change/Delete Vendor  
Location: Vendors List Window  
Generate Planholder Reports.  

When you distribute addendums to the proposals in a letting, you can run mailing labels 
(single label or three-across label sets) for each planholder on the letting planholder list 
for addendum and plan distribution. You can select options for ship-to or bill-to address 
labels and to print a list of planholders. Later you can rerun this report to print a list of 
planholders and a vendor invoice report that is based on the cost of plans purchased 
(see below).  

Process: Generate Planholder Reports (File|Run Process)  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child)  

Hold the bid letting.  
Receive bids for the proposals in the letting.  

Import bid information.  
After you receive the bids for the letting, you can load the bid information into Trns•port 
LAS.  Bid information consists of an entry in the Bidders file for each proposal bidder and 
an entry in the Bid Tabs file for each proposal item bid, proposal section bid total, 
proposal bid total, and in the case of Cost Plus Time bids, the number of days bid.  You 
can import bid information through a batch process for external files or enter it 
interactively.  

Batch 
Process: Load Bid Tabs (File|Import)  

Interactive 
Process: Add Bidders  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child) 
Bidders List Window (Child)  

 
Process: Add/Change/Delete Bid Tabs  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child) 
Bidders List Window (Child) 
Bid Tabs List Window (Child)  
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Process:   Add/Change/Delete Bid Time  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child)  
 

Process: Add/Change/Delete Number of Days Bid  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child)  

Check bid information.  

You can use the Bid Tab Edit report to perform edit checks on the consistency and 
validity of bid information. Whenever you modify bid information through the 
interactive or batch facilities, you must run the Bid Tab Edit report. You must 
generate the report before you generate the Bid Tab Analysis report.  

Process: Generate Bid Tab Edit Report (File|Run Process)  
Location: Bid Lettings List Window (Parent) 

Letting/Proposal List Window (Child)  

Correct bid information errors and rerun the Bid Tab Edit report.  
Correct errors detected by the Bid Tab Edit report or that you detect. You can make 
corrections interactively or through the batch facility for an external file. After you make 
corrections, rerun the Bid Tab Edit report to verify the corrections.  

Batch 
Process: Load Bid Tabs (File|Import)  

Interactive 
Process:  Add/Change/Delete Bidders  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child) 
Bidders List Window (Child) 

Process: Add/Change/Delete Bid Tabs  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child) 
Bidders List Window (Child) 
Bid Tabs List Window (Child)  

Process:   Add/Change/Delete Bid Time  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child)  
 

Process: Add/Change/Delete Number of Days Bid  
Location: Bid Lettings List Window (Parent) 

Letting/Proposal List Window (Child)  

Process: Generate Bid Tab Edit Report (File|Run Process)  
Location: Bid Lettings List Window (Parent) 

Letting/Proposal List Window (Child)  
 

Generate Bid Tab Analysis reports.  

  

The Bid Tab Analysis process includes the Low Bid Summary, the Tabulation of Bids, and 
Low Bid Item Analysis reports. These reports provide hard copy comparisons between 
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the valid estimates and the bids.  After you modify and successfully process bid 
information through the Bid Tab Edit report, you must run the Generate Bid Tab Analysis 
process.  

Process: Generate Bid Tab Analysis (File|Run Process)  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child)  

Generate Bid Letting Summary reports.  
The Bid Letting Summary reports summarize bid letting addendums, bid letting history, 
and the Bid Letting Comparison form. You can run and rerun these reports any time 
before, during, or after the letting.  

Process:  Generate Bid Letting Summary (File|Run Process)  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child)  

Set proposal award status.  
When you determine the award decisions for the letting, you must set the 
award status (awarded or rejected) for each proposal in the letting.  

Process: Change Letting Proposals  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child)  

Enter the DBE/WBE  (ESBE)commitments for awarded contracts and generate a 
listing of DBE/WBE commitments.  

You can enter the DBE commitments for the awarded contracts.  
Process:  Add/Change DBE/WBE Commitments  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child) 
DBE Commitments List Window (Child)  

Then you can print a listing of DBE/WBE commitments.  

Process:  List DBE/WBE Commitments (File|Run Process)  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child)  

Generate Contract Schedules for the awarded contracts.  
You can generate a Contract Schedule of Prices and a DBE Interest report for each 
awarded contract. The Contract Schedule of Prices report is similar to the Proposal 
Schedule with the winning bidder’s unit prices.  

Process: Generate Contract Schedule (File|Run Process)  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child)  

Generate Final Detail Estimate reports for awarded projects.  
You can generate a Final Detail Estimate report for each of the projects, proposals or bid 
lettings. If these proposals have been awarded, the winning bidder’s unit prices will be 
used.  

Process:  Generate Final Detail Estimate (File|Run Process)  
Location: Bid Lettings List Window (Parent) 

Letting/Proposals List Window (Child)  
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Pass the bid letting information to Trns•port BAMS/DSS.  
Trns•port LAS passes the bid letting information to the Trns•port BAMS/DSS historical 
database.  
Process: Pass Contract Data to DSS (File|Run Process)  
Location: From anywhere in Trns•port LAS  
 

Pass the awarded contract information to Trns•port SiteManager.  
Trns•port LAS passes the contract and reference information in a form readable to the 
Trns•port SiteManager database.  
Process: Pass Contract Data to SiteManager  
Location: From anywhere in Trns•port LAS  
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8.0 Managing a Bid Letting  

After you set up a bid letting header record in Trns•port PES, you can manage the bid 
letting function in Trns•port LAS.  

8.1 Initializing Proposals  

When you initialize a proposal, Trns•port generates a table that contains proposal-level 
items.  Up to this point, all quantity data is at the project level. If you make changes to 
breakdown or project-level items after you initialize the proposal, you will have to 
reinitialize the proposal to incorporate the changes you made.  

Before initializing a proposal, you should have already performed these tasks in 
Trns•port PES:  

• Added projects to the proposal.  

• Added a 00 proposal site and at least one county to the proposal record. If this 
information has not been added, Trns•port will display either an error or a warning 
message depending on the associated installation option setting.  

• Added the proposal to a bid letting.  

• Run the Generate Section/Line Numbers process.  

� Note: If you go back to Trns•port PES and make changes to the associated 
proposal, projects, or estimates after you initialized them in Trns•port LAS, you 
must run the initialization function in Trns•port LAS again.  

To initialize a proposal, you must first sign on to Trns•port LAS and select a bid letting.  

8.1.1 Selecting a Bid Letting  

To select a bid letting, click the BIDLETS button on the Trns•port LAS button bar.  
Trns•port displays a Bid Lettings list window (see Figure 8-1).  

 
Figure 8-1.  Bid Lettings List Window 
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8.1.2 Selecting Proposals  

Click the LETPROP button to display a list of all proposals associated with the selected bid 
letting (see Figure 8-2).  

 
Figure 8-2. Letting/Proposals List window 

Select the proposal you want to initialize by clicking on it. If you want to select more 
than one proposal, press and hold CTRL while you select proposals with the mouse.   

8.1.3 Initializing Letting Proposals  

To initialize letting proposals, select Run Process from the File menu to display the 
Processes window. Scroll down until you find Initialize Letting Proposals and select it. 
Click OK to display the Confirm Process Submission window.  

Click SUBMIT to run the process. 

The Initialize Letting Proposals function allows you to initialize only the proposal(s) for 
the bid letting you selected.  

Trns•port updates LAS information in the Trns•port database from information you 
added in Trns•port PES.  You cannot go on to the next step until Trns•port 
completes its work. The Initialize Letting Proposals function reports information to the 
message log regarding the status of the Letting Proposals it attempted to initialize.  

When the process finishes, Trns•port sends a Job Completed message window to the 
computer from which you ran the process.  

�  Note: If you initialize a proposal in Trns•port LAS and then add addendum 
items (which you must do in Trns•port PES), you must reinitialize the proposal 
in Trns•port LAS to transfer the Trns•port PES changes.  

8.2 Adding and Changing Letting/Proposals  

You add proposals to lettings in Trns•port PES, and then initialize those proposals in 
Trns•port LAS.  You can also add additional proposals to a letting or change information 
about a letting/proposal in LAS.  
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8.2.1 Adding Letting/Proposals  

To add a proposal to a letting, click the BID LETTING button to display the Bid Lettings list 
window. Select the bid letting to which you want to add a proposal and choose Tabbed 
Folder Change from the right mouse button menu.  Trns•port displays the Bid Letting 
tabbed folder window.  

Click the LETTING PROPOSALS tab. The top part of the LETTING PROPOSALS tab contains a 
list of all the proposals associated with the letting. The bottom part of the LETTING 
PROPOSALS tab contains detail information for the proposal currently selected in the list 
(see Figure 8-3).    

 
Figure 8-3. Letting Proposal Tab 

To add a new proposal to the letting, click inside the proposals grid and choose Add from 
the right mouse button menu.  Trns•port displays a Proposals list window listing all 
proposals that have not already been assigned to a bid letting (see Figure 8-4).  
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Figure 8-4. Proposals List Window 

8.2.2 Letting Call Order 

The Letting Call Order must be inserted manually to ensure that Capital Projects and 
Maintenance and Operations projects are discernable.  The CPM projects shall always 
begin with the 100 range while the Maintenance and Operations projects shall always 
begin with the 400 range. 

8.2.3 Changing Letting/Proposals  

To change the information about a letting/proposal, click the BIDLETS button to display 
the Bid Lettings list window. Select a bid letting and click the LETPROP button to display 
the Letting/Proposals list window. Select the letting/proposal you want to change and 
then choose Change from the right mouse button menu. Trns•port displays a 
Letting/Proposal window.  

You can add information to or change information in any fields except Letting Call Order 
or Notice Publication Date. When you finish making changes, click OK to save your 
changes or CANCEL to return to the Letting/Proposals list window without saving.  

8.2.4 Changing Letting/Proposals in the Tabbed Folder Window  

You can also change information about a letting/proposal in the tabbed folder window.  
Click the BID LETTING button to display the Bid Lettings list window. Select a bid letting 
and choose Tabbed Folder Change from the right mouse button menu.  Trns•port 
displays the Bid Letting tabbed folder window. Click the LETTING PROPOSALS tab.  

Select the proposal you want to change in the top part of the tab. Trns•port displays all 
the existing information about the proposal in the detail area of the LETTING/PROPOSALS 
tab below the list. You can add information to or change information in any fields.  You 
can also enter information directly into the list by selecting Hide Detail from the right 
mouse button menu.  

8.2.5 Entering Date Information with the Date Fill Command  

When a group of proposals assigned to a letting have the same Notice Publication Date 
and/or Status Date, you can add this information to all the proposals at once through the 
Fill Dates window.  

To use this feature, click the BID LETTING button to display the Bid Lettings list window. 
Select a bid letting and choose Tabbed Folder Change from the right mouse button 
menu.  Trns•port displays the Bid Letting tabbed folder window.  Click the LETTING 
PROPOSALS tab.  
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Select the proposals you want to change in the top part of the tab. Select Date Fill from 
the Edit menu or the right mouse button menu (see Figure 8-5 & Figure 8-6).    

 
Figure 8-5. Date Fill Option on Right Mouse Button Menu 

Trns•port displays the Fill Dates window. 

 
Figure 8-6. Fill Dates Window 

Enter the new date(s) into the field(s) or use the Calendar lookup button to the right of 
each field to select a date.  Click OK. 

Trns•port add the new date information to the grid. 
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8.2.6 Using Range Fill to Change Letting/Proposal Information  

There are certain Letting/Proposal fields to which you can assign a value for several 
letting/proposals simultaneously.  These fields include Award Status, Status Date, Notice 
of Publication Date, Pass Date, and some generic fields.  

If you want to assign a common value to a field for all the proposals, on the Letting 
Proposals tab, click the header of the column you want to change to select the entire 
column.  You can also select only a range of cells in a column by following these steps:  

1. Press and hold down the ALT key  

2. Click the left mouse button over the first cell in the range and drag the mouse 
pointer over the range of cells you want to select. Trns•port displays the selected 
cells in white text with black background.  

� Note: In Hide Detail mode (the detail area of the LETTING/PROPOSAL tab is not 
displayed), you cannot select a range of cells beginning with an active cell (that 
is, when the mouse pointer in that cell resembles the letter I).  

After you have selected the range of cells you want to change, select Range Fill from 
the Edit menu and choose Up or Down. If you choose Up, Trns•port will assign the 
value found in the bottommost cell to all the cells above it in the selected range.  If you 
choose Down, Trns•port will assign the value found in the topmost cell to all the cells 
below it in the selected range.  

Before leaving the tabbed folder window you must save the new information to the 
database by clicking the SAVE button or selecting Save from the File menu.  

8.3 Listing Letting/Proposals  

To produce a hard copy listing of letting/proposals, select the proposal or proposals you 
want to list in the Letting/Proposals list window and choose Run Process from the right 
mouse button menu button. Trns•port displays the Processes list window.  

Scroll down to select List Letting Proposals. Then click OK to submit a batch process or 
click CANCEL to return to the Letting/Proposals list window without submitting a process. 
If you click OK, Trns•port displays a Confirm Process Submission window.  

Click SUBMIT to submit the batch process, PARAMETERS to change process submission 
parameters, or CANCEL to return to the Proposals list window without submitting the 
process.  

8.4 Deleting a Proposal From a Bid Letting  

If you withdraw a proposal or it is incorrect, you can delete it from a bid letting at any 
time. To delete a proposal from a bid letting, select the bid letting in the Bid Lettings list 
window.  

Click the LETPROP button to display the Letting/Proposals list window.  

Select the proposal or proposals you want to delete from the letting and choose Run 
Process from the right mouse button menu. Trns•port displays the Processes window.  

Select Delete Proposal from Bid Letting and click OK to continue the delete process or 
click CANCEL to return to the Letting/Proposals list window without deleting. If you click 
OK, Trns•port displays a Delete Warning window.  

Click YES to continue the delete process or No to return to the Letting/Proposals list 
window without deleting. If you click YES, Trns•port displays a Confirm Delete window.  
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Click SUBMIT to submit the deletion process, PARAMETERS to change process submission 
parameters, or CANCEL to return to the Proposals list window without submitting the 
process.  

8.4.1 Deleting a Proposal in the Tabbed Folder Window  

You can also delete proposals from a letting in the tabbed folder window.  Click the BID 
LETTING button to display the Bid Lettings list window. Select a bid letting and choose 
Tabbed Folder Change from the right mouse button menu.  Trns•port displays the Bid 
Letting tabbed folder window. Click the LETTING PROPOSALS tab.  

Select the proposal in the Proposals list in the top part of the tab and choose Delete from 
the right mouse button menu.  Trns•port displays a Delete Warning window.  

Click YES in the window to complete the delete.  See “Deleting Information” in Chapter 3 
for more information about deleting.  

� Note: When you delete a Proposal from a bid letting, Trns•port automatically 
deletes the associated planholder, bidder, bid tabulation, bid time and DBEWBE 
records.  

8.5 Generating a Notice to Contractors and a Bid Summary Report  

The Notice to Contractors is a letter to the public advertising a proposal is available for 
bid and an additional listing of proposals within a letting and the DBE percentage, 
location and classification. This process also allows you to generate a PDF version of the 
Notice to Contractors reports from XML output by choosing the Generate PDF Report 
option.  

The Bid Summary report lists items, quantities, and units by part and sums them for a 
project. Each site in a Cost Plus Time proposal is displayed along with the Road User 
Cost Per Day amount.  Generate this report after the proposal is set up and ready to be 
let. This report goes with the advertisement and is sent to magazines for publication.  
Design uses this report to review preliminary proposals.  

If the Reporting Method installation option is set to DATE, the Generate Notice to 
Contractors report will only be available from the Bid Lettings list window.  To generate 
these reports, follow these steps:  

1. Select the bid letting for which you are accepting bids from the Bid Lettings list 
window.  

2. Select Run Process from the right mouse button menu.  

3. Select Generate Notice to Contractors in the Processes window.  

4. Enter the Publication Date.  

5. Click the Generate PDF Report check box, if applicable.  

6. Click SUBMIT.  

If the Reporting Method installation option is set to SLCT or SCRL, the Generate Notice to 
Contractors report will be available from both the Bid Lettings and Letting/Proposals list 
windows. To generate these reports, follow these steps:  

1. Select the bid letting for which you are accepting bids from the Bid Lettings list 
window.  

2. Select the proposal from the Letting/Proposals list window.  
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3. Select Run Process from the right mouse button menu.  

4. Select Generate Notice to Contractors in the Processes window.  

5. Click the Generate PDF Report check box, if applicable.  

If you click OK, Trns•port will display the Confirm Process Submission window.  Click the 
SUBMIT button to run the process.  

8.6 Managing Planholders  

You must include all vendors who purchase plans for a letting in the Planholder list for 
that letting. You can produce a hard copy listing of all planholders for a selected letting 
proposal. You can also specify the address or addresses to which addendum information 
should be sent for each bid letting/call for which vendors purchase contract proposals 
and plans.  

8.6.1 Adding a Planholder  

Click the VENDORS button on the button bar or select Reference Tables from the File 
menu and choose Vendor List to display the Vendors list window. Select a vendor and 
click the PLANHOLD button on the button bar or select Planholders through BidLet List 
from the right mouse button menu.  

Trns•port displays a Bid Lettings list window that lists all bid lettings for which the 
selected vendor is a planholder (see Figure 8-7).  

 
Figure 8-7. Bid Lettings List Window 

Select the bid letting to which you want to add this vendor as a planholder and click the 
PLANHOLD button. Trns•port displays the Planholders List window (see Figure 8-8).  

Managing a Bid Letting  8-8 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

 
Figure 8-8. Planholders List Window 

Press INSERT or select Add from the right mouse button menu to display the Add 
Planholder window (see Figure 8-9).  

Managing a Bid Letting  8-9 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

 
Figure 8-9. Add Planholder Window 

To create a complete record you must enter information in these fields:  

Call Order The order in which you will open a 
bid for a specified proposal.  Choose 
a value from that attached list. 

Date and Time of Purchase The date and time a vendor 
purchases a set of plans for a 
particular proposal.  Trns•port 
automatically enters this field. 

Valid for Bidding The Valid for Bidding box indicates 
the planholder is a “legitimate” or 
valid bidder on the project. If the 
vendor is valid for bidding, click the 
Valid for Bidding box. If the 
planholder is not yet valid for bidding 
but plans to meet requirements to 
become valid, make sure this box is 
not checked. 
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You are not required to, but you can enter information in these fields to record additional 
information about a planholder:  

Advance Account No. If your state allows contractors to set 
up accounts for contractors, this field  
holds that number. It is not used for 
any Trns•port processing.    

Bill-To Address The sequence number of the 
planholder's billing address. 
Trns•port references the address 
information in the VENDADDR file. If 
the selected vendor has no 
addresses, you will need to add 
addresses. 

Cash/Charge Code A coded value (which must appear in 
the CHRG code table) indicating the  
method by which the plans were 
purchased. 

Clerk Writing Order A coded value indicating the person 
who took an order for the purchase 
of plans. 

Complete Plans Qty. The number of complete plans 
purchased by a vendor. 

Contract ID A unique identifier for a proposal or 
contract. 

Document Number If NJDOT has an internal referencing 
number or library system for 
documents, this field would hold that 
number. Trns•port does not use it in  
any Trns•port processing.  
 

Invoice Number A unique identifier for a planholder 
invoice. 

Number of Label Sets The number of sets of labels to be 
generated when you generate labels 
for this order. You must fill in this 
field for Trns•port to generate labels. 
Valid values are zero through nine. 

Ordered by The name of the person ordering the 
proposal plans. 

Plans w/o Cross-sect. Qty. The number of complete plans 
without cross-sections purchased by 
a vendor. 
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Proposal Number Held If your state has a serial sequence 
number or a numbering system for 
proposals, this field would hold that 
number. Trns•port does not use it in 
any Trns•port processing. 

Proposal Quantity The number of proposals purchased 
by a given vendor. 

Ship-To Address The vendor address sequence 
number of a planholder's shipping 
address. 

Many bidders are “courtesy” or non-bidders, which means they can buy copies of the 
plans, but they cannot submit bids for the proposal. You can enter information for 
courtesy bidders so that if the bidder meets the necessary requirements to be a valid 
bidder, you will only have to set the Valid for Bidding flag to No.  

When you finish adding information for this planholder, click OK to add the selected 
vendor to the planholder list. If the planholder requests additional proposals, you can 
click ADD MORE to add the vendor as a planholder on another call.  

You can return to the Bid Lettings list window to select another bid letting for this 
vendor. When you finish adding this vendor as a planholder, you can return to the 
Vendor list window to select another vendor.  

8.6.2 Adding a Planholder in the Tabbed Folder Window  

You can also add planholders in the tabbed folder window. Click the BID LETTING button to 
display the Bid Lettings list window. Select the bid letting to which you want to add a 
planholder and choose Tabbed Folder Change from the right mouse button menu.  
Trns•port displays the Bid Letting tabbed folder window.  

Click on the PLANHOLDERS tab. The top part of the PLANHOLDERS tab contains a list of all 
the planholders for the letting. The bottom part of the tab contains detail information in 
four pages for the planholder currently selected in the list (see Figure 8-10).  
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Figure 8-10. Planholders Tab 

To add a new planholder to the letting, click inside the planholders list and choose Add 
Invoice from the right mouse button menu.  Trns•port adds a new row to the list.  The 
Date Purchased field will contain the current date and all other fields in the new row will 
be empty.  Enter data into the blank fields displayed in the detail area at the bottom of 
the PLANHOLDERS tab. You can also enter data directly into the list fields by selecting 
Hide Detail from the right mouse button menu.  

Before leaving the tabbed folder window you must save the new Planholder record to the 
database by clicking the SAVE button or selecting Save from the File menu.  

8.6.3 Copying Planholders  

You can copy planholder information from one letting and call to another, and eliminate 
the need to reenter all the information for each planholder under the new letting and 
call.  After copying the planholders, you can then enter any modifications required for 
the new planholder entries.  

To copy planholder information from one letting and call to another, select the letting 
and call containing the planholders you want to copy from the Letting/Proposals List 
window. Select Copy Special from the Edit menu.  Trns•port displays the Copy 
Planholders window (see Figure 8-11).  
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Figure 8-11. Copy Planholders Window 

Click the down arrows beside the Destination Letting and Destination Call fields and 
select the letting and call to which you want to copy information.  Click OK to copy the 
planholder information or CANCEL to return to the Letting/Proposals list window without 
copying the planholder information.   

8.6.4 Changing Planholder Information  

To change information about a planholder, follow these steps:  

1. Select the vendor record in the Vendors list window.  

2. Click the PLANHOLD button or select Planholders through BidLet List from the 
right mouse button menu button.  

3. Select the planholder record in the Planholders list window.  

4. Choose Change from the right mouse button menu button.  

Trns•port displays a Planholder window.  

You can add or change information in blank or red fields. When you finish making 
changes, click OK to save your changes or CANCEL to return to the Planholders list window 
without saving.  

8.6.5 Changing Planholder Information in the Tabbed Folder Window  

You can also change planholder information in the tabbed folder window.  Click the BID 
LETTING button to display the Bid Lettings list window. Select a bid letting and choose 
Tabbed Folder Change from the right mouse button menu.  Trns•port displays the Bid 
Letting tabbed folder window. Click the PLANHOLDERS tab.  

Select the planholder record you want to change in the top part of the tab. Trns•port 
displays all the existing information about the planholder in the detail area of the 
PLANHOLDERS tab below the list.  

You can add information to or change information in any fields in the detail area except 
the blue fields. You can also enter information directly into the list by selecting Hide 
Detail from the right mouse button menu.    

You can start a new invoice for any vendor by clicking the ADD INVOICE button, or add to 
the currently selected invoice by clicking the ADD TO CURRENT INVOICE button.  

Before leaving the tabbed folder window you must save the new information to the 
database by clicking the SAVE button or selecting Save from the File menu.  
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8.6.6 Deleting a Planholder  

To delete a planholder from the selected letting/proposal, select the planholder in the 
Planholders list window and choose Delete from the right mouse button menu button. 
Trns•port displays a Delete Warning window.  

Click YES in each of the windows to complete the delete process.  

8.6.7 Deleting a Planholder in the Tabbed Folder Window  

You can also delete planholders from a letting in the tabbed folder window.  Click the BID 
LETTING button to display the Bid Lettings list window. Select a bid letting and choose 
Tabbed Folder Change from the right mouse button menu.  Trns•port displays the Bid 
Letting tabbed folder window. Click the PLANHOLDERS tab.  

Select the planholder record you want to delete from the list and choose Delete from 
the right mouse button menu.  Trns•port displays a Delete Warning window.  

Click YES in the window to complete the delete  

8.6.8 Listing Planholders  

To produce a hard copy listing of selected planholders, click the BIDLETS button and 
follow these steps:  

1. Select a bid letting (Bid Lettings list window).  

2. Select a proposal (Letting/Proposals list window).  

3. Select List Planholders from the Processes window (select Run Process from 
the File menu).  

4. Click OK to submit the process. Trns•port displays a Confirm Process Submission 
window.  

5. Click SUBMIT to submit the batch process, PARAMETERS to change process 
submission parameters, or CANCEL to return to the Letting/Proposals list window 
without submitting the process. See “Submitting Batch Processes” in Chapter 3 for 
more information.  

8.7 Validating Planholders for Bidding  

You can quickly and easily validate planholders for bidding using the Planholder Valid 
Flag grid window.  

To open the Planholder Valid Flag grid window, select a bid letting from the Bid Lettings 
list window and click the VALID button or choose Planholder Valid for Bidding List 
from the right mouse button menu.  Trns•port displays the Planholder Valid Flag grid 
window (see Figure 8-12).  
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Figure 8-12. Planholder Valid Flag Grid Window 

Under the Valid column, click in the check boxes next to the planholders you want to 
validate for bidding. If a planholder has been checked as valid, but is not, click in the 
check box again to clear it.  

Select Update Database from the File menu to update the database with new valid 
planholders. Alternatively, when you attempt to close the Planholder Valid Flag window, 
Trns•port displays a dialog box that requests confirmation of the changes you made.  
Click YES to update the database, NO to return to the Planholder Valid Flag window, or 
CANCEL to close the window without updating the database.  

8.7.1 Validating Planholders in the Tabbed Folder Window  

You can also validate planholders for bidding in the tabbed folder window. To open the 
tabbed folder window, select a bid letting from the Bid Lettings list window and choose 
Tabbed Folder Change from the right mouse button menu.  Trns•port displays the Bid 
Letting tabbed folder window.  

Click the PLANHOLDERS tab. The top part of the tab contains a list of all the planholders 
for the letting. Select the planholder you want to validate in the list and click the Validate 
for Bidding check box on Page 1 of the detail area of the tab. You can also click the Valid 
for Bidding checkbox directly in the list by selecting Hide Detail from the right mouse 
button menu.  

Before leaving the tabbed folder window you must save the new planholder record by 
clicking the SAVE button or selecting Save from the file menu.  

8.8 Generating Planholder Reports  

To generate planholder reports, which include mailing labels for planholders, a listing of 
the planholders, and vendor invoices, follow these steps (see Figure 8-13 and Figure 8-
14):  

1. Select a bid letting from the Bid Lettings list window.  

2. Select a proposal from the Letting/Proposals list window.  

3. Choose Run Process from the File menu and select Generate Planholder 
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Reports from the Processes window.  

4. Select Planholder Report Options and click OK.  

To select a bid letting, click the BIDLETS button to display the Bid Lettings list window.  

 
Figure 8-13. Bid Lettings List Window 

Select a letting and click the LETPROP button to display the Letting/Proposals list 
window. 

 
Figure 8-14. Letting/Proposals List Window 
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Select the proposal for which you want to run planholder reports and choose Run 
Process from the right mouse button menu.  Choose Generate Planholder Reports 
from the Processes window and click OK. Trns•port displays a Planholders Report Options 
window (see Figure 8-15).  

 
Figure 8-15. Planholders Report Options Window 

Various types of mailing labels and reports are available. Click in the boxes for the 
options you want to generate and click SUBMIT to submit the batch process, PARAMETERS to 
change process submission parameters, or CANCEL to cancel the process submission.  

The output can be saved and uploaded to Bid Express. 

8.9 Browsing Letting/Proposal Addenda Information  

After a proposal has been advertised in Trns•port PES, any subsequent changes to the 
proposal, such as adding or deleting items, are made by creating addenda.  Although 
existing addenda may only be added or modified through Trns•port PES, you can browse 
a list of all the addenda created for proposals in a letting in the Bid Letting tabbed folder 
window of Trns•port LAS.  

To open the tabbed folder window, select a bid letting from the Bid Lettings list window 
and choose Tabbed Folder View from the right mouse button menu.  Trns•port 
displays the Bid Letting tabbed folder window. Click the ADDENDA tab (see Figure 8-16).  
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Figure 8-16. Addenda Tab 

Use the scroll bars to browse the addenda information.  You can also filter and sort the 
list as in any Trns•port list window.  

8.10 Managing Bidders  

All contractors who bid on letting proposals, must be entered in Trns•port as valid 
planholders and must be in the master vendor list.  You can also produce a hard copy 
listing of bidders.  

8.10.1 Adding Bidders to a Proposal  

To add bidders to the proposal, follow these steps:  

1. Select a bid letting from the Bid Lettings list window.  

2. Select a proposal from the Letting/Proposals list window.  

3. Open the Bidders list window.  

4. Add bidder information.  

Select a bid letting from the Bid Lettings list window and click the LETPROP button to view 
the associated proposals as you did to initialize letting proposals. Then click the BIDINFO 
button to display the Bidders list window (see Figure 8-17).  
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Figure 8-17. Bidders List Window 

Press INSERT or select Add from the right mouse button menu to display the Add Bidder 
window shown below (see Figure 8-18).  

 
Figure 8-18. Add Bidder Window 

To create a complete record you must enter information in these fields:  

Vendor Number A unique identifier for a vendor. 
When you fill in the Vendor Number 
field, Trns•port automatically enters 
the Vendor Name field. You can 
select a vendor number from the 
attached reference table. 
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You are not required to, but you can enter information in these fields to record additional 
information about a bidder:  

Bid Exception Status Indicates if the automated bid editing 
process detected any errors in the 
bid (such as incorrect arithmetic). 
Trns•port automatically enters the 
Bid Exception Status field when you 
run the Bid Tab Edit. You must run 
the Bid Tab Edit report before you 
can award a contract. 

Bid Type A coded value indicating the type of 
bid, which must be in the BIDTYPE 
code table. 

Calculated Total Trns•port calculates the vendor bid 
total by checking various figures on 
the vendor's bid tabulations. 
Trns•port calculates and sums item 
extended amounts or sums vendor 
section totals according to an 
installation option. This figure should 
be the same as the Proposal Bid 
Total. Trns•port automatically enters 
the Calculated Total field when you 
run the Bid Tab Edit. You must run 
the Bid Tab Edit report before you 
can award a contract. 

Cost Plus Time Total Computed as the sum of the 
Calculated Total and the Plus Time 
Total for the bidder. 

Current Work The current dollar amount of work 
the bidding vendor has outstanding. 

Plus Time Total Computed as the product of the 
Proposal Site Road User Cost Per Day 
multiplied by the corresponding Bid 
Time Number of Days Bid for all  
sites in the Proposal for that bidder 

Proposal Total 

 

 

 

 

 

 

 

The total cost of the proposal as 
determined by the bidder. Trns•port  
automatically enters the Proposal 
Total field when you run the Bid Tab  
Edit. You must  
run the Bid Tab Edit report before 
you can award a contract.  
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Status of Bid A coded value indicating the status of 
the vendor's bid, which must be in 
the BIDSTAT code table. A state may 
indicate that a bidder is irregular by 
adding a code value that is in the 
IRREG code table (subset of 
BIDSTAT).  A vendor marked as 
irregular will not be considered for 
award. 

Supplier Only Flag Indicates that a vendor might be a 
supplier of materials only. 
 

Surety Agent ID Trns•port treats surety agents as 
vendors for information storage. This 
field holds the vendor code of the 
surety agent for this bid. The value 
entered here must appear in the 
VENDOR file. 

Surety Company ID Trns•port treats surety companies as 
vendors for storing information in 
Trns•port. This field holds the vendor 
code of the surety company for this 
bid. The value entered here must 
appear in the VENDOR file. 

When you finish entering information, click OK to add the new bidder, ADD MORE to add 
another bidder or CANCEL to return to the Bidders list window without adding a bidder.  

8.10.2 Adding Bidders in the Tabbed Folder Window  

You can also add bidders to a letting/proposal in the tabbed folder window.  Select a bid 
letting in the Bid Lettings list window and choose Letting Proposal List from the right 
mouse button menu.  Trns•port displays the Letting/Proposals list window.  

In the list window select the proposal to which you want to add bidders and choose 
Tabbed Folder Change from the right mouse button menu.  Trns•port displays the 
Letting/Proposal tabbed folder window.  

To add bidder information, click the BID MANAGEMENT tab (see Figure 8-19).  
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Figure 8-19. Bid Management Tab 

The top part of the BID MANAGEMENT tab lists all the bidders for the selected proposal. 
The bottom part of the tab contains detail information for the bidder currently selected in 
the list.  

To add a new bidder to the proposal, right click inside the bidders list and choose Add 
from the right mouse button menu.  Trns•port displays a Planholders list window listing 
all planholders for the proposal (see Figure 8-20)  

 
Figure 8-20. Planholders List Window 

Select the planholder you want to add as a bidder from the list, using the scroll bar if 
necessary. You can also filter and sort the list to make it easier to find the planholder(s) 
you want. Click OK.  

Trns•port adds the bidder to the list on the BID MANAGEMENT tab.  

Before leaving the tabbed folder window you must save the new bidder record to the 
database by clicking the SAVE button or selecting Save from the File menu.  
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8.10.3 Changing Bidder Information  

To change information about a bidder, select the bidder in the Bidders list window and 
choose Change from the right mouse button menu.  Trns•port displays a Bidder detail 
window.  

You can add or change information in the empty or red fields. When you finish changing 
information, click OK to save the changes or CANCEL to return to the Bidders list window 
without saving.  

8.10.4 Changing Bidder Information in the Tabbed Folder Window  

You can also change information about a bidder in the tabbed folder window.  To open 
the tabbed folder window, select a bid letting in the Bid Lettings list window and choose 
Letting Proposal List from the right mouse button menu.  Trns•port displays the 
Letting/Proposals list window.  

In the list window select the proposal for which you want to change bidder information 
and choose Tabbed Folder Change from the right mouse button menu.  Trns•port 
displays the Letting/Proposal tabbed folder window.  

To change bidder information, click the BID MANAGEMENT tab. Select the bidder you want 
to change in the top part of the tab. Trns•port displays all the existing information about 
the bidder in the detail area below the list. You can add information to or change 
information in any field containing a text box.  You can also enter information directly 
into the list by selecting Hide Detail from the right mouse button menu.  

Before leaving the tabbed folder window you must save the new bidder information to 
the database by clicking the SAVE button or selecting Save from the File menu.  

8.10.5 Adding Bid Classification Codes  

You can add bid class irregularity information to a bidder’s record through the 
Letting/proposal tabbed folder window. Follow these steps to add this information:  

1. Select a bid letting in the Bid Lettings list window and choose Letting Proposal 
List from the right mouse button menu.  Trns•port displays the Letting/Proposals 
list window.  

2. In the list window select the proposal for which you want to add bid classification 
information and choose Tabbed Folder Change from the right mouse button 
menu.  Trns•port displays the Letting/Proposal tabbed folder window.  

3. Click the BID MANAGEMENT tab and select the bidder you want to change in the top 
part of the tab (see Figure 8-21).  

4. Click the BID CLASS CODES option button. Trns•port displays a list of any 
classification codes and code descriptions currently associated with the bidder. You 
can add, change, or delete any information in the list.  

5. To add a new classification code, select Add from the right mouse button menu. 
Trns•port adds a blank row to the list.  Click the down arrows and select the 
appropriate codes for the Bid Class Code and Code Description fields. To change a 
classification code or description, simply click the down arrow and choose the new 
information.  
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Figure 8-21. Bid Management Tab with Bid Class Codes Detail Page Displayed 

6. To delete a class code record, select the row containing the record you want to 
delete and choose Delete from the right mouse button menu.  Trns•port displays 
a Delete Warning window.  Click YES in the window to complete the delete process.  

When you have finished adding, changing or deleting bid class code information, save 
your changes to the database by selecting Save from the File menu.  

8.10.6 Deleting a Bidder  

To delete bidders from a letting/proposal, follow these steps:  

1. Select a bid letting from the Bid Lettings list window.  

2. Select a letting proposal from the Letting/Proposals list window.  

3. Select Bidder Information List from the right mouse button menu.  

4. Select the bidder in the Bidders list window.  

5. Choose Delete from the right mouse button menu.  

After you select the bidder in the Bidders list window and choose Delete from the right 
mouse button menu, Trns•port displays a Delete Warning window.  

Click YES in each window to complete the delete process.   

8.10.7 Deleting a Bidder in the Tabbed Folder Window  

You can also delete bidders from a letting/proposal in the tabbed folder window.  To 
open the tabbed folder window, select a bid letting in the Bid Lettings list window and 
choose Letting Proposal List from the right mouse button menu.  Trns•port displays 
the Letting/Proposals list window.  

In the list window select the proposal for which you want to delete bidder information 
and choose Tabbed Folder Change from the right mouse button menu.  Trns•port 
displays the Letting/Proposal tabbed folder window.  

To delete a bidder, click the BID MANAGEMENT tab. Select the bidder you want to delete in 
the top part of the tab and choose Delete from the right mouse button menu.  Trns•port 
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displays a Delete Warning window.  

Click YES in the window to complete the delete.  

8.10.8 Listing Bidders  

To produce a hard copy listing of bidder information, select the letting/proposals for 
which you want to list information in the Letting/Proposals list window. Then choose Run 
Process from the right mouse button menu. Trns•port displays a Processes window.  

Select List Bidders and click OK to submit a batch process. Click CANCEL to return to the 
Letting/Proposals list window without submitting a process. If you click OK, Trns•port 
displays a Confirm Process Submission window.  

Click SUBMIT to submit the batch process, PARAMETERS to change process submission 
parameters, or CANCEL to return to the Letting/Proposals list window without making 
submitting the process.  

8.11 Managing Bid Time Information  

You can add, change and delete bid time information for a Cost Plus Time bid in the 
Letting/Proposal tabbed folder window.  

Follow these steps to add a bid time record:  

1. Select a bid letting in the Bid Lettings list window and choose Letting Proposal 
List from the right mouse button menu.  Trns•port displays the Letting/Proposals 
list window.  

2. In the list window select the proposal for which you want to add bid time 
information and choose Tabbed Folder Change from the right mouse button 
menu.  Trns•port displays the Letting/Proposal tabbed folder window.  

3. Click the BID MANAGEMENT tab and then click the BID TIME option button. Trns•port 
displays a list of all the contract sites with site descriptions and any Number of 
Days Bid currently associated with the bidder (see Figure 8-22).  

4. In the Bid Time detail window, select Add from the right mouse button menu.  
Trns•port adds a blank row to the list.  

5. To create a complete record, enter information in these fields:  

Site Proposal sites represent work 
locations for which time charges are 
accrued. The default situation is for a 
single site of time charges to accrue 
on the contract as a whole. If 
contractors will construct several 
project entities (for example, 
bridges) as part of a single contract, 
you can treat each project entity as a 
separate site to assign completion 
time and assess liquidated damages. 

Number of Days Bid In a Cost Plus Time bid, the bid time 
number of days bid for the associated 
letting proposal’s awarded vendor for 
an associated proposal site. 
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Figure 8-22. Bid Management Tab with Bid Time Detail Window Displayed 

When you have finished adding bid time information, save your changes to the database 
by selecting Save from the File menu.  

You can change information in the Site and Number of Days Bid fields by clicking in the 
field and typing the new information.  To delete a bid time record, select the record in 
the list and choose Delete from the right mouse button menu.  

! Caution: Adding incorrect records or deleting records for bidders may cause the 
bid to be marked as Irregular. Bid time records should only be maintained in this 
window to correct errors.  

8.12 Maintaining Bidders Notes  

To add notes about a bidder, select the bidder in the Bidders list window. Then choose 
Bidder’s Notes from the right mouse button menu. Trns•port displays a Bidder’s Notes 
text window (see Figure 8-23).  

 
Figure 8-23. Bidder’s Notes Window 
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You can enter notes of about 32,000 characters. Do not press ENTER at the end of each 
line; Trns•port automatically wraps text to a new line. If you want to start a new line, 
press ENTER. You can use the Windows Copy (CTRL+C) and Paste (CTRL+V) commands from 
the Edit menu to copy and paste text from other windows. Click OK when you finish 
entering information and Trns•port displays the Bidders list window. Click CANCEL to 
return to the Bidders list window without adding notes for a bidder.  

8.12.1 Adding Bid Notes in the Tabbed Folder Window  

To add notes about a bidder in the tabbed folder window, select a bid letting in the Bid 
Lettings list window and choose Letting Proposal List from the right mouse button 
menu.  Trns•port displays the Letting/Proposals list window.  

In the list window select the proposal and choose Tabbed Folder Change from the right 
mouse button menu.  Trns•port displays the Letting/Proposal tabbed folder window.  

To add bid notes, click the BID MANAGEMENT tab (see Figure 8-24).  

 
Figure 8-24. Bid Management Tab 

The top part of the BID MANAGEMENT tab lists all the bidders for the selected proposal. 
The bottom part of the tab contains detail information for the bidder currently selected in 
the list. By default the tab opens with the detail area displaying bidder information.  

To add new bid notes to the proposal, select a bidder from the list in the top part of the 
BID MANAGEMENT tab and click the BID NOTES option button. Trns•port displays the Bid 
Notes text page (see Figure 8-25).  
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Figure 8-25. Bid Management Tab with Bid Notes Displayed 

You can enter notes of about 32,000 characters. Do not press ENTER at the end of each 
line; Trns•port automatically wraps text to a new line.  If you want to start a new line,  

press ENTER. You can use the Windows Copy (CTRL+C) and Paste (CTRL+V) commands from 
the Edit menu to copy and paste text from other windows.    

Before leaving the tabbed folder window you must save the new bid notes record to the 
database by clicking the SAVE button or selecting Save from the File menu.  
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9.0 Analyzing Bid Tabulations  

The amount a vendor bids for an item or group of items is called a bid tabulation or bid 
tab. You must enter bid information for each proposal item, proposal section total, and 
proposal total. For proposals using Cost Plus Time bidding, you must also enter bid time 
information.  

You can enter bid tab information directly into Trns•port or you can batch load them 
from an external file. The data files you load might contain errors; therefore, this chapter 
also discusses how to correct errors.  

9.1 Loading Bid Tabulations and DBE Commitments  

You can add bidder, bid tab, and bid time information as well as DBE commitment 
information through the batch load process.  

To load bid tab, DBE commitments, or bid time data from a file, follow these steps:  

1. Make sure the data files are in the correct format and location for loading.  

2. Run the Load Bid Tabs process.  

First, you must create the data files in the proper file format. Check with your system 
manager to be sure the files are in place before you continue (XTABDAT.dat) then load 
bid tabs.  

To load the data into Trns•port LAS, select Import from the File menu.  Trns•port 
displays a confirm process submission window.  

Click SUBMIT to run the process, PARAMETERS to change process parameters, or CANCEL to 
cancel the process.  

Batch loading takes a properly formatted data file and merges it with the Trns•port 
database. If a bidder or DBE commitment record already exists, Trns•port will update it; 
otherwise, Trns•port will create a new record. You cannot continue until Trns•port 
completes its work.  Trns•port will notify you when the process finishes.  

9.2 Reviewing the Bid Tabulations and DBE Commitments Load Edit and Load 
Edit Summary Reports  

When the process is complete, Trns•port prints hard copy reports.   

The Bid Tab and DBE Commitment Load Edit reports identify information about each 
record Trns•port attempted to load. The reports will tell you which records Trns•port 
successfully loaded or where an error occurred. The Bid Tab Load Edit report can help 
you detect errors such as incorrect line numbers and nonexistent bidders or vendors. If 
the report lists an error, the associated record did not load and you must enter 
it manually as described in Section 9.4 of this chapter. The DBE Commitment 
report can help you detect errors such as incorrect DBE numbers and nonexistent 
vendors.  If the report lists an error, the associated record did not load and you 
must enter it manually.  

The Bid Tab Load Edit Summary indicates the number of input records Trns•port 
processed. If Trns•port found an error in a record, the number of bid tab 
additions will be less than the number of records processed. This report also 
indicates the total additions and changes to the Bid Tabs and Bidders files.  

The DBE Commitments Load Edit Summary indicates the number of input records 
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Trns•port processed.  If Trns•port found an error in a record, the number of DBE 
commitment additions will be less than the number of records processed.  This 
report also indicates the total additions and changes to the DBE Commitments file.  

9.3 Adding Bid Time Information Manually (NJDOT is not currently using this 
function) 

You can manually add any Cost Plus Time bid information that was not loaded with the 
Load Bid Tabs function. Follow these steps to add the Number of Days Bid information 
for any site in the contract:  

1. Select the bid letting in the Bid Lettings list window and choose Letting Proposal 
List from the right mouse button menu.  Trns•port displays the Letting/Proposals 
list window.  

2. In the list window select the proposal for which you want to add or change bid 
time information and choose Tabbed Folder Change from the right mouse 
button menu.  Trns•port displays the Letting/Proposal tabbed folder window.  

3. Click the BID MANAGEMENT tab and then click the BID TIME option button. Trns•port 
displays a list of all the contract sites with site descriptions and any Number of 
Days Bid currently associated with the bidder (see Figure 9-1).    

 
Figure 9-1. Bid Time Page of the Bid Management Tab 

You can add information in the Number of Days Bid column for any site in the contract. 
When you have finished adding bid time information, save your changes to the database 
by selecting Save from the File menu.  

9.4 Adding Bid Tabulations (NJDOT is currently not using this function). 

You can manually enter bid tab information for proposals. You can also manually add 
proposal bids or correct bid data that you loaded through the Load Bid Tabs process.  

You will need to manually add any records that Trns•port did not load with the Load Bid 
Tabs function. To add a new bid tabulation, follow these steps:  

1. Determine which records need to be added and why they did not load.  
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2. Select a bid letting.  

3. Select a proposal.  

4. Select a bidder.  

5. Select the Bid Tabs function.  

6. Enter bid tab information.  

The Bid Tabs Load Edit report shows you which records Trns•port did not load. You will 
need to find all the errors and find correct values for each record before you add the 
records directly into Trns•port LAS.  

Click the BIDLETS button to display the Bid Lettings list window (see Figure 9-2).  

 
Figure 9-2. Bid Lettings List Window 

Select a bid letting and click the LETPROP button to display the Letting/Proposals list 
window (see Figure 9-3).  
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Figure 9-3. Letting/Proposals List Window 

Select a proposal and click the BIDINFO button to display a Bidders list window of all 
bidders for the letting and proposal you selected (see Figure 9-4).  

 
Figure 9-4. Bidders List Window 

Select a bidder and click the BIDTABS button to display a list of bid tabulations for the 
selected vendor (see Figure 9-5).  
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Figure 9-5. BidTabs List Window 

To add a new bid tabulation, press INSERT or select Add from the right mouse button 
menu to view the Add Bid Tab window (see Figure 9-6).  

 
Figure 9-6. Add Bid Tab Window 

To create a complete record you must enter information in this field:  

Line Type  If the bid tab you are entering is for a bid item, the line type is 
"L", you must enter a value in the Line Number field.  If it is a 
section bid total, the Line Type is "S", and you must enter a value 
in the Section Number field.  If the bid tab is a bid proposal total, 
the Line Type is "P", you must leave the Section Number field 
blank.  
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Click OK to save the new record and return to the BidTabs list window, ADD MORE to add 
another bid tab record, or CANCEL to return to the BidTabs list window without adding a 
record.  

Trns•port displays the bid tab you added at the bottom of the bid tab list.  

9.5 Generating Estimate Bid Tabs (NJDOT is not currently using this function). 

You can generate planholder, bid tabs, bid time, and bidder records for a selected vendor 
that use the engineer’s estimate figures for the bidder’s unit prices. This process is useful 
for non-bid projects that need to be passed to Trns•port SiteManager Construction  for 
contract maintenance.  

To generate estimate bid tabs, select a bid letting from the Bid Lettings list window. 
Then select a letting/proposal in the Letting/Proposals list window. Click the BIDTABSEST 
button or select Bid Tab Estimation from the right mouse button menu.  Trns•port 
displays a Vendors list window (see Figure 9-7).  

 
Figure 9-7. Vendors List Window 

Select the vendor that will be the bidder from the Vendors list window. Then choose Run 
Process from the right mouse button menu. Trns•port displays a Processes window.  

Select Generate Estimate Bid Tabs and click OK to submit a batch process. Trns•port 
displays a Confirm Process Submission window.  

Click SUBMIT to continue batch process submission or click CANCEL to return to the 
Vendors list window without submitting the process. 

9.5.1 Generating Estimate Bid Tabs in the Tabbed Folder Window (NJDOT is not 
currently using this function). 

You can also generate estimate bid tabs in the tabbed folder window.  Select a bid letting 
in the Bid Lettings list window and choose Letting Proposal List from the right mouse 
button menu.  Trns•port displays the Letting/Proposals list window.  

In the list window select the proposal for which you want to generate estimate bid tabs 
and choose Tabbed Folder Change from the right mouse button menu.  Trns•port 
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displays the Letting/Proposal tabbed folder window (see Figure 9-8).  

 
Figure 9-8. General Tab of the Letting/Proposal Tabbed Folder Window 

To generate estimate bid tabs, click the GENERATE ESTIMATE BID TABS button. Trns•port 
displays a Vendors list window (see Figure 9-9).  

 
Figure 9-9. Vendors List Window 

Select the vendor that will be the bidder from the Vendors list window and click OK.  

9.6 Listing Bid Tabs  

You can produce a hard copy listing of bid tab information to review current data values. 
To produce the listing, choose the letting/proposal or proposals in the Letting/Proposals 
list window. Then choose Run Process from the right mouse button menu. Trns•port 
displays the Processes window.  

Select List Bid Tabs and click OK to submit the batch process. Click CANCEL to return to 
the Letting/Proposals list window without submitting the process. If you click OK, 
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Trns•port displays a Confirm Process Submission window.  

Click SUBMIT to continue process submission, PARAMETERS to change process submission 
parameters, or CANCEL to return to the Letting/Proposals list window without submitting 
the process.  

9.7 Generating the Bid Tab Edit Report  

The Bid Tab Edit report analyzes individual line item bids for numerical accuracy. It 
marks irregular bids in the exception report. See Appendix D for sample output. After 
you generate the report and correct errors (see the next section), you can regenerate 
the report.  You MUST generate the Bid Tab Edit Report before you can award a 
conctract in LAS AND before you can analyze a bid. 

The report checks to make sure bidders enter extended amounts that are in line with the 
unit prices they offer and it tells you why bidders are irregular. For example, if a bidder 
lists a unit price of $85 and the known quantity is 4, the extended amount should be 
$340. If the vendor lists $190 instead, the vendor might appear to be the low bidder.   

Follow these steps to run this report:  

1. Select a bid letting from the Bid Lettings list window.  

2. Select the proposals from the Letting/Proposals list window.  

3. Select Run Process from the File menu and choose Bid Tab Edit Report.  

You can select a bid letting and a proposal as you did in Section 9.4. To select all the 
proposals for a letting, press and hold down CTRL while you click on each proposal to 
select it.  

Follow these steps to run the Bid Tab Edit report:  

1. Select a bid letting from the Bid Lettings list window.  

2. Select the proposals from the Letting/Proposals list window.  

3. Select Run Process from the File menu and choose Bid Tab Edit Report.  

You can select a bid letting and a proposal as you did in Section 9.4. To select all the 
proposals for a letting, press and hold down CTRL while you click on each proposal to 
select it.  

To run the Bid Tab Edit report, select Run Process from the File menu to display the 
Processes window and select Generate Bid Tab Edit Report and click OK. This process 
produces a Bid Tab Edit report that details all proposals for a particular letting.  

The first section of this report is the Category and Item Alternate Bid Edit. This report 
indicates bidding errors for category and item alternates such as incomplete bids on a 
set of alternates.  For Cost Plus Time sites, this section will also list any missing bid time 
information.  

The second section is the Item Bid Edit. In this section, Trns•port lists errors with 
proposal bid tabs, such as invalid extended amounts.  

The third section is the Proposal Section Edit. If a bidder's extended amounts do not add 
up to the section total, Trns•port lists that information in this section.  

The fourth section is the Vendor Bid Total Inconsistent with Calculated Bid Total. If a 
bidder's extended amounts do not add up to the proposal total, Trns•port lists that 
information in this section of the report.  
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The fifth section is the Bidders Summary, which ranks each bidder according to the 
calculated bid total. These rankings are "apparent" and Trns•port only considers them to 
be true rankings if Sections 1 through 4 of the report list no errors.  

The Plus Time Bid Total column lists the Plus Time Proposal Bid for Cost Plus Time 
proposals. The Apparent Ranking of the bidders is based on the Bidder’s Cost Plus Time 
amounts.  For non Cost Plus Time proposals, the Apparent Ranking is based on the 
Calculated Proposal Total.  

The bid exception status column indicates which vendors have errors. Vendors with a Bid 
Exception Status of Irregular will not be considered for award.  Irregular bids must be 
corrected, and the Bid Tab Edit process run again to eliminate the irregular bid status.  

9.8 Changing Bid Tabulations (This function to be performed by Procurement). 

To change a unit price or extended amount for an existing bid tabs record, follow these 
steps:  

1. Review the Bid Tab Edit report to determine the correct unit prices and extended 
amounts for those bid tabs with errors.  

2. Select the bid letting from the Bid Lettings list window.  

3. Select the proposal from the Letting/Proposals list window.  

4. Choose Bidder Information List from the right mouse button menu.  

5. Select the bidder in the Bidders list window.  

6. Choose Contract Bid Tabs List from the right mouse button menu.  

7. Select the Bid Tab record.  

8. Choose Change from the right mouse button menu.  

The Bid Tabs Edit report shows any errors it finds in bid tab records. Before you can 
change an existing bid tab record, you will need to find the errors and the correct values. 
Then you can select a bid letting, proposal, and bidder  as described at the beginning of 
Section 9.4.  

After you select a bidder, click the BIDTABS button to display the BIDTABS list window.  

Select the bid tab you want to change and choose Change from the right mouse button 
menu to display the Bid Tab Window.  

You can change the Unit Bid Price and Extended Amount field values.  For each bid tab 
line item you change, click the Changed Bid Amount Flag check box.  

To save your changes and return to the BidTabs list window, click OK. If you click CANCEL, 
Trns•port returns to the list window without making changes.  

9.8.1 Changing Bid Tabulations in the Tabbed Folder Window  

You can also change bid tab information in the tabbed folder window.  To open the 
tabbed folder window, select a bid letting in the Bid Lettings list window and choose 
Letting Proposal List from the right mouse button menu.  Trns•port displays the 
Letting/Proposals list window.  

In the list window select the proposal to which you want to add bid tabs and choose 
Tabbed Folder Change from the right mouse button menu.  Trns•port displays the 
Letting/Proposal tabbed folder window.  
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Click the BID MANAGEMENT tab (see Figure 9-10).  

 
Figure 9-10. Bid Management Tab 

Select a bidder from the list in the top part of the BID MANAGEMENT tab and click the BID 
TABS option button. Trns•port displays a grid containing all existing Proposal Item 
records for the letting/proposal (see Figure 9-11).  

 
Figure 9-11. Bid Management Tab with Bid Tabs Grid Displayed 

Select the bid tab record you want to change and enter the new bid price and extended 
amount.  Click the Changed Bid Amount Flag check box.  

The value in the Calculated Extended Amount, Estimated Extended Amount, and Amount 
Difference with Estimated Extended Amount columns will adjust automatically according 
to the new bid price.  
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9.8.2 Consistency Checking  

After you have made changes to bid tabs, you can verify that the new information 
contained in the Bid Tab grid is accurate and valid by selecting Consistency Checking 
from the Edit menu or the right mouse button menu.    

If Trns•port finds an error, a warning will be displayed and the Error Flag checkbox for 
the lines in error will be checked.  

Before leaving the tabbed folder window you must save the new bid price information to 
the database by clicking the SAVE button or selecting Save from the File menu.  

9.9 Generating the Bid Tab Analysis Report  

To compare bidder's estimates with each other and with the engineer's estimate, you can 
run the Bid Tab Analysis report.  

 Note: Do not run the Bid Tab Analysis report until you correct errors with the 
Bid Tab Edit process. If a vendor has an irregular bid and you do not correct it, 
Trns•port will not use that vendor’s bid in the bid tab analysis.  

Report results can help you evaluate bids and award contracts. The report includes an 
item by item report, a low bid summary, and Trns•port’s recommendation. To produce 
the report, follow these steps:  

To produce the report, follow these steps:  

1. Select a bid letting from the Bid Lettings list window.  

2. Select a proposal from the Letting/Proposals list window.  

3. Choose Run Process from the File menu and run the Generate Bid Tab Analysis 
process.  

4. Select the report sections you want Trns•port to run.  

5. Review the report output.  

Select a bid letting and proposal following the steps at the beginning Section 9.4. Then 
select Run Process from the File menu and choose Generate Bid Tab Analysis from 
the Processes window. Trns•port displays the Bid Tab Analysis Options window (see 
Figure 9-12).  

 
Figure 9-12. Bid Tab Analysis Options Window 

Click in the Include Engineer's Estimate field so that Trns•port includes the engineer's 
estimate values in the report and click OK to run the process.  

The first section of the report is the Low Bid Summary, which indicates the low bidder 
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and low bid value (corrected bid) and the engineer's estimate of the cost (estimated 
cost). Additionally, Trns•port records the low bid as a percentage of the engineer's 
estimate and as a dollar value over or under the engineer's estimate.  For Cost Plus Time 
proposals, this section of the report displays the Total Cost and the Total Bid, both of 
which include the Time Bid portion.  

The second section of the report is the Vendor Ranking. Trns•port ranks all bidders for 
the selected proposal belonging to the selected letting according to bid total. If a vendor 
submitted a bid that was lower than the engineer's estimate, that bidder would receive 
the zero ranking. For Cost Plus Time proposals, the vendor ranking will be based on the 
Cost Plus Time amount rather than the calculated item total.  

The third section of the report is the Tabulation of Bids. This section lists proposal header 
information, vendor ranking with bid totals, and item bid information for each proposal. 
The report displays the item bid information with three vendors per page of output. The 
engineer's estimate appears as the first vendor if the report was generated to include the 
engineer's estimate.  For Cost Plus Time proposals, the vendor ranking section of the 
report is based on the Bidder’s Cost Plus Time Total amount.  

The fourth section of the report is the Low Bid Item Analysis. This report lists proposal 
header information, vendor rank and bid total information, and a detailed item price 
comparison between the low bidder and the engineer's estimate for each proposal in the 
selected letting. For Cost Plus Time proposals, the vendor ranking section of this report 
displays values based on the cost of the proposal plus the time bid.  The last row of this 
report displays totals including the time bid, for each vendor.  

9.10 Deleting Bid Tabulations  

To delete bid tab information, select the record or records you want to delete in the 
BidTabs list window and choose Delete from the right mouse button menu. Trns•port 
displays a Delete Warning window.  

Click YES in each window to complete the delete process. 
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10.0 Awarding a Contract 

After you initialize the proposal, assign bidders, and add bid tab information, you are 
ready to create a contract and produce final reports.  A Trns•port contract is essentially 
a Trns•port proposal you have let and awarded.  

10.1  Generating and Reviewing the Bid Letting Summary Report (Post-Letting)  

The Bid Letting Summary shows the status of each contract proposal for the selected 
lettings.  It also shows the winning vendor and contract amount if you award the 
proposal. You can also generate a Bid Letting Addendums Summary, a Bid Letting 
History report, and a Pre-Qualified Contractors report.  

You can also generate this report before a letting.  You do not have to generate this 
report to award a contract, but you do have to generate the Bid Tab Edit and 
Bid Tab Analysis reports (see Chapter 9).  

To generate the Bid Letting Summary report, follow these steps:  

1. Select a bid letting from the Bid Lettings list window.  

2. Select a proposal from the Letting/Proposals list window.  

3. Select Run Process from the File menu and choose Bid Letting Summary.  

4. Select the report sections you want Trns•port to produce.  

5. Run the process. Click the BIDLETS button to display the Bid Lettings list window 
(see Figure 10-1).  

 
Figure 10-1. Bid Lettings List Window 

Select a bid letting and click the LETPROP button to display the Letting/Proposals list 
window (see Figure 10-2).  
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Figure 10-2. Letting/Proposals List Window 

Select a proposal and choose Run Process from the File Menu. 

Choose Generate Bid Letting Summary and click OK.  Trns*port displays the Bid 
Letting Summary Options window (see Figure 10-3) 

 
Figure 10-3. Bid Letting Summary Options Window 

Select the report sections you want to produce by clicking in the check boxes and click 
SUBMIT to run the process. Click OK in the Job Monitor window.  

The first section of the report lists any addendums for any of the proposals in the bid 
letting package.  

The second section of the report is the Bid Letting Comparison form.  This section lists 
the proposals in call-order sequence and includes selected proposal information and 
blank fields for manual entry at the bid letting.  For Cost Plus Time proposals, this report 
includes the Cost Plus Time Total in the Corrected Low Bid column for proposals that 
have been identified as Cost Plus Time proposals. The Apparent Low Bid column contains 
a notation that the proposal is a Cost Plus Time proposal.  
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The third section, Bid Letting History, lists summary information about the contract if 
you previously let it but the contract was rejected.  This section also shows current 
letting information.  

The fourth section, Letting Award Summary, lists information about the winning vendor.  

The fifth section lists prequalified contractors. This report lists all vendors who have a 
vendor work classification (VENCLASS table) that matches one of the three proposal 
work classification fields.  

10.2 Assigning a Contract Identifier to a Proposal and Awarding It  

After the bids are in and analyzed, follow these steps to award the contract:  

1. Select a bid letting from the Bid Lettings list window.  

2. Select a proposal from the Letting/Proposals list window.  

3. Select Change from the right mouse button menu.  

4. Enter the letting status.  

Click the BIDLETS button to display the Bid Lettings list window.  Select a bid letting and 
click the LETPROP button to display the Letting/Proposals list window.  Select a proposal 
and click the LETPROP button (or select Letting Proposal from the right mouse button 
menu) to display the Letting/Proposal tab window (see Figure 10-4).  

 
Figure 10-4. Letting/Proposal Tab Window 

You can change the Letting Status by clicking on the down arrow next to the field and 
selecting from the attached list box.  To award the contract, select the code value for 
award from the drop down list.  

You can award a contract to a vendor other than the low bidder by changing the 
information in the Awarded Vendor field. When you change the awarded vendor, 
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Trns•port automatically updates the Awarded Amount field to the new awarded vendor’s 
bid total.  

 Note: If you regenerate the Bid Tab Analysis, Trns•port will overwrite these 
fields by the calculated low bidder and amount.  

10.2.1 Awarding a Contract in the Tabbed Folder Window  

You can also award a contract to a bidder in either the Letting/Proposal tabbed folder 
window or the Bid Letting tabbed folder window.  

To award a contract in the Letting/Proposal tabbed folder window, select a bid letting in 
the Bid Lettings list window and choose Letting Proposal List from the right mouse button 
menu. Trns•port displays the Letting/Proposals list window.  

In the list window select the proposal and choose Tabbed Folder Change from the right 
mouse button menu. Trns•port displays the Letting/Proposal tabbed folder window with 
the GENERAL tab open by default (see Figure 10-5).  

 
Figure 10-5. Awarding a Contract in the Letting/Proposal Tabbed Folder Window 

To award a contract in the Bid Letting tabbed folder window, select a bid letting in the 
Bid Lettings list window and choose Tabbed Folder Change from the right mouse button 
menu. Trns•port displays the Bid Letting tabbed folder window with the GENERAL tab 
open (see Figure 10-6).  
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Figure 10-6. Awarding a Contract in the Bid Letting Tabbed Folder Window 

Change the letting status in either tabbed folder by clicking on the down arrow next to 
the Letting Status field and selecting from the attached list box.  Select A to award the 
contract.  

The Bid Tab Analysis process determines the low bidder, and puts the awarded vendor 
number and awarded amount into the database. You can award a contract to a vendor 
other than the low bidder by changing the information in the Awarded Vendor field. 
When you change the awarded vendor, Trns•port automatically updates the Awarded 
Amount field to the new awarded vendor’s bid total.  

 Note: If you regenerate the Bid Tab Analysis, Trns•port will overwrite these 
fields by the calculated low bidder and amount.  

Before leaving the tabbed folder window you must save the award information to the 
database by clicking the SAVE button or selecting Save from the File menu.  

10.2.2 Generating the Awarded Vendor Mailing Labels  

To generate mailing labels for a vendor who was awarded a contract, select the bid 
letting from the Bid Letting list window.  Open the Letting/Proposal list window and 
select the Letting/Proposal of the winning vendor for whom you want to generate mailing 
labels.  

Then choose Run Process from the right mouse button menu to display the Processes 
window. Choose Generate Vendor Mailing Labels from the Processes window. Trns•port 
displays the Generate Vendor Mailing Labels parameter window (see Figure 10-7).  
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Figure 10-7. Generate Vendor mailing Labels Parameter Window 

Enter the number of labels you want generated for each vendor (1, 2, 3, or a whole 
page) and the address number to be used in the labels (the default is “01”). Then click 
SUBMIT to submit the process, PARAMETERS to change process submission information, or 
CANCEL to return to the Vendors list window without submitting the process. 

10.3  Generating and Reviewing the Contract Schedule Report  
Now that you have awarded the proposal, you can generate the Contract Schedule report 
which contains the bidder's unit prices and extended amounts for each item.  To 
generate the Contract Schedule report, follow these steps:  

1. Select a bid letting from the Bid Lettings list window.  

2. Select a proposal from the Letting/Proposals list window.  

3. Choose Generate Contract Schedules Report (select Run Process from the File 
menu).  

4. Select the report sections you want Trns•port to produce.  

5. Run the process.  

6. Review the output.  

Click the BIDLETS button to display the Bid Lettings list window.  Select a bid letting and 
click the LETPROP button to display the Letting/Proposals list window.  Then select Run 
Process from the right mouse button menu.  Trns•port displays a Processes window. 
Choose Generate Contract Schedule and click OK . Trns•port displays the Contract Schedule 
Options window (see Figure 10-8).  

 
Figure 10-8. Contract Schedule Options Window 
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Check the boxes next to the report sections you want to produce.  Click SUBMIT to run the 
process. Click OK in the Job Monitor window.  

The first section of the report is the contract cover sheet. The second page of the cover 
sheet contains additional information such as DBE/MBE/WBE goals and site time 
limitations.  Cost Plus Time sites are identified with an asterisk.  

The second section is the contract schedule of prices. Trns•port will wrap long item 
descriptions over several lines as needed.  

The DBE Interest report lists contract line items you flagged as likely candidates for DBE 
participation in the Item list.  The report shows the estimated quantity and awarded 
price for each item. This report is a beginning guide for setting DBE participation goals.  

10.4  Generating the Final Detail Estimate Report  

The Final Detail Estimate is the same as the Preliminary Estimate discussed elsewhere in 
this guide, except that now the awarded vendor's prices replace the engineer's estimated 
prices.  The report includes item specifications, estimated item quantities and prices, and 
low bid prices for alternates.  

You can generate the Final Detail Estimate from the Projects, Prime Projects, Proposals 
and Letting/Proposals list windows.  

10.4.1 Generating the Final Detail Estimate Report From the Projects List 
Window  

To generate the report from the Projects list window, click the PROJECTS button to display 
the Projects list window and follow these steps:  

1. Select the projects for which you want to get estimates (hold down CTRL while 
you select projects with the mouse).  

2. Select Run Process from the right mouse button menu.  

3. Select Generate Final Detail Estimate and click OK. Trns•port displays the 
Detail Cost Estimate Parameters window.  

4. Click the PAGE 2 tab and select the level of summarization you want – that is, 
prime project or proposal – and click OK (see Figure 10-9).  

 
Figure 10-9. Detail Cost estimate Parameters Window 

5. Select the report sections you want to produce and the database you want 
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Trns•port to use by clicking the check boxes.  By default, Trns•port produces all 
the reports and uses the PES database.  

6. Click SUBMIT to run the process.  

10.4.2 Generating the Final Detail Estimate Report From the Prime Projects List 
Window  

To generate the report from the Prime Projects list window, click the PRIMPROJS button to 
display the Prime Projects list window and follow these steps:  

1. Select the prime projects for which you want to get estimates (hold down CTRL 
while you select prime projects with the mouse).  

2. Select Run Process from the right mouse button menu.  

3. Select Generate Final Detail Estimate and click OK. Trns•port displays the Detail Cost 
Estimate Parameters window.  

4. Select the report sections you want to produce and the database you want 
Trns•port to use by clicking the check boxes.  By default, Trns•port produces all 
the reports and uses the PES database.  

5. Click SUBMIT to run the process (see Figure 10-10).  

 
Figure 10-10. Detail Cost Estimate Parameters Window 

10.4.3 Generating the Final Detail Estimate Report From the Proposals List 
Window  

To generate the report from the Proposals list window, click the PROPOSALS button to 
display the Proposals list window and follow these steps:  

1. Select the proposals for which you want to get estimates (hold down CTRL while 
you select proposals with the mouse).  

2. Select Run Process from the right mouse button menu.  

3. Select Generate Final Detail Estimate and click OK. Trns•port displays the Detail Cost 
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Estimate Parameters window.  

4. Select the report sections you want to produce and the database you want 
Trns•port to use by clicking the check boxes.  By default, Trns•port produces all 
the reports and uses the PES database.  

5. Click SUBMIT to run the process (see Figure 10-11).  

 
Figure 10-11. Detail Cost Estimate Parameters Window 

10.4.4 Generating the Final Detail Estimate Report From the Letting/Proposals 
List Window  

To generate the report from the Letting/Proposals list window, click the BIDLETS button 
to display the Bid Lettings list window.  Select a bid letting and then click the LETPROP 
button to display the Letting/Proposals list window and follow these steps:  

1. Select the letting proposals for which you want to get estimates (hold down CTRL 
while you select letting proposals with the mouse).  

2. Select Run Process from the right mouse button menu.  

3. Select Generate Final Detail Estimate and click OK. Trns•port displays the Detail Cost 
Estimate Parameters window (see Figure 10-12).  

 
Figure 10-12. Detail Cost Estimate Parameters Window 

Awarding a Contract  10-9 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

1. Select the status of the contracts by clicking in the Awarded, Rejected, or Both 
check boxes.  

2. Select the report sections you want to produce by clicking in the check boxes. By 
default, Trns•port produces all the reports.  

3. Click SUBMIT to run the process.  

10.4.5 Final Detail Estimate Report  

The Final Detail Estimate report lists the funding sources for the project and its actual 
cost according to values submitted by the low bidder.  

Project Summary Log The log contains basic information 
about the selected projects, 
depending on which summary level 
you selected. 
 

Estimate Cover Page The cover page shows header 
information for the project in the 
estimate. 
 

Cost Summary This report shows how much of each 
project each fund will 
pay for. 
 

Cost Estimate The header portion of this report 
displays information about the 
project.  The next section shows 
information about the first category, 
including funding sources.  The report 
lists item details next.  The report 
uses the long description.  The report 
shows the total cost of each category 
after the last item.  After the last 
category, Trns•port displays the 
project total. 
 

Funding Summary This report indicates the source of 
funds for each category. 

Funding Summary by Unit This report combines projects and 
categories into common units by the 
Unit Number field in the category 
record.  For example, if categories of 
work are being performed in a single 
county, you could give these 
categories the same unit number.  
This report would then let you know 
how much of the project funding is 
going into each county. 
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Category Funding Summary by 
Fund 

This report lists each fund in the 
estimate with the amount allocated 
from each category in the project. 

10.5 Reviewing the Exception Report  

Trns•port prints Exception reports after you generate the Final Detail Estimate.  

The first page indicates if there were errors.  The second page indicates if there were 
errors with the specified funding.  If there were data problems, such as fund 
participation not adding up to 100 percent, the report would list those problems in this 
report.  

When the Final Detail Estimate is complete and the estimated figures are satisfactory, 
you can move the Trns•port LAS data to Trns•port SiteManager Construction.  

10.6 Deleting Bid Letting Packages  

You can delete a bid letting package, or calls or proposals associated with a bid letting 
package, from Trns•port PES or Trns•port LAS at any time.  After you pass a proposal 
to Trns•port LAS and initialize it, you will no longer be able to delete the bid 
letting in Trns•port PES.  You will have to delete the bid letting package in 
Trns•port LAS if any proposal associated with the bid letting package has been 
passed to Trns•port LAS.  

To delete a bid letting package, select the bid letting you want to delete in the Bid 
Lettings list window.  Then choose Run Process from the File menu. Trns•port displays a 
Processes window.  

Select Delete Bid Letting Package and click OK to continue the delete process. Click CANCEL to 
return to the Bid Lettings list window without deleting.  If you click OK, Trns•port displays 
a Delete window.  

You can delete information on three levels: delete, power delete, and strong delete.  

 Note: If you have security to run only two of these deletes, only those two deletes will 
appear in the delete window.  If you have security for one of these deletes, this window will 
not appear.  

If you choose Delete, you will delete the association of all the letting proposals in the bid 
letting package and all related bid information (bidders, bid tabs, bid time, planholders 
and other letting-level data).  

If you choose Power Delete, you will also delete all proposal-level information for the 
proposals in the selected letting (that is, the letting call, proposal description, proposal 
sites and other proposal-level data).  

If you choose Strong Delete, you will also delete all project, category, funding, and item 
information for the projects assigned to the proposals for the selected letting.  

 Note: You should not use Strong Delete until after you award the proposal and pass the 
data to Trns•port SiteManager Construction and Trns•port BAMS/DSS.  

After you select the level of delete, click OK to continue the delete process. Trns•port 
display a series of Delete Warning windows.  Click YES to continue the delete process or 
NO to return to the Bid Lettings list window without deleting.  
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11.0 Managing Vendors (Procurement) 

You can add and update information about contractors, subcontractors, surety 
companies, insurance agents, escrow agents, major suppliers, and DBE suppliers in 
Trns•port LAS.  You might also want to treat counties or municipalities as vendors to 
manage work they perform themselves and to treat utility companies as subcontractors.  

11.1 Adding Vendors  

You must add each vendor who wants to purchase plans, submit bids, subcontract, be a 
supplier, or be a service provider to the Trns•port master vendor file.  You can add 
vendors through the Vendor Tabbed Folder Add window or the Add Vendor window.  

11.1.1 Adding a Vendor Through the Tabbed Folder Window  

To add a vendor, click on the VENDORS button on the Trns•port LAS button bar to display 
the Vendors list window (see Figure 11-1).  

 
Figure 11-1. Vendors List Window 

Select any vendor in the list and choose Tabbed Folder Add from the right mouse 
button menu.  Trns•port displays the GENERAL tab of the Add Vendor tabbed folder 
window (see Figure 11-2).  
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Figure 11-2. General Tab of the Vendor Tabbed Folder Window 

The GENERAL tab contains general information fields used for identifying the vendor.  To 
create a complete record you must enter information in these fields:  

Long 
Name  

The vendor name (long description).  

Name  The vendor name (short description).  

Vendor 
No.  

A unique identifier for a vendor.  

Vendor 
Type 

A value, which must be selected from the attached VENDTYP 
code table, which indicates the type of vendor. 

You are not required to, but you can enter information in these fields to record additional 
information about a vendor:  

Ability Factor The state's numerical rating of the vendor's capability to 
perform work. It is a factor in calculating the vendor's 
capacity; it is not a performance evaluation.  

Adjusted Net 
Worth 

The total value of the vendor’s assets minus the total 
value of its debts. This number can represent the 
agency’s estimate, the vendor’s claim, or an audit 
amount.  

Alternate 
Vendor ID 

A code that identifies a vendor in some electronic or 
manual system Vendor ID outside of Trns•port.  This 
value can be used by Trns•port to communicate with that 
external system.  
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Alternate 
Vendor No. 

An alternate identification number or code for a vendor. 

Certification 
Type 

A value, which must be selected from the attached 
CERTYPE code table that indicates the type of work a 
vendor is authorized to perform. 

Corporation 
Type 

A value, which must be selected from the attached 
CORPTYP code table, which indicates the type of business 
structure used by a vendor. 

DBE 
Certification 
Date 

The date on which the vendor was certified for its 
business enterprise type. 

Ethnic Group 
Type 

The ethnic group code to which the Vendor belongs. 

IRS Number The Federal Employer Identification (FEI) number 
assigned to the vendor by the IRS.  

Maximum 
Capacity 

The maximum amount of work, in dollars, that a vendor 
can perform. 

Obsolete Indicates that a vendor is obsolete and therefore should 
no longer be used. 

Prequal 
Certified Date 

The date the vendor became qualified to perform the type 
of work certified for the state. 

Prequal 
Expired Date 

The date the vendor’s qualification for certification for 
work expires. 

Prequal 
Update 

The date you schedule to review the list of vendors who 
have pre-List Date qualified. 

Primary 
DBE/WBE 
Code  

A coded value indicating the vendor’s business enterprise 
certification type.  

State of 
Incorporation  

 

A coded value indicating the state in which the vendor 
company is incorporated.  

Uncompleted 
Work  

The amount of work, in dollars, a vendor has outstanding.  

When you have finished adding information, save the new vendor to the Trns•port database 
by clicking the SAVE button or selecting Save from the File menu.  Trns•port displays the new 
vendor in the Vendor list window.  
11.1.2 Adding a Vendor Through Tab Windows  

To add a new vendor, click the VENDORS button on the button bar. Trns•port displays the 
Vendors list window. Press INSERT or select Add from the right mouse button menu to 
display the Add Vendor window (see Figure 11-3).  
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Figure 11-3. Add Vendor Window 

To create a complete record you must enter information in the fields listed in Section 
11.1.1.  

When you finish adding information, click OK to add the vendor or ADD MORE to add 
another vendor. When you finish adding vendors, Trns•port adds the new vendors to the 
Vendors list and returns you to the Vendors list window.  

11.2 Viewing the Vendor Inquiry Screen  

Trns•port has a Vendor Inquiry window that displays vendor classifications, vendor 
insurance, and vendor officer data on four tabs.  This data is for viewing only and cannot 
be modified.  To view the Vendor Inquiry Screen, select a single vendor from the 
Vendors list window and choose Vendor Inquiry Screen from the right mouse button 
menu or click the INQUIRY button on the button bar. Trns•port displays the first tab of 
the Vendor Inquiry window (See Figure 11-4).  

 
Figure 11-4.Vendor Tab of the Vendor Inquiry Window 
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You can view the primary address for a vendor and various information pulled from the 
VENDOR table, but you cannot modify any of the information on these tabs.  Click on the 
tabs at the top of the window to move between tabs in the window.  

The CLASSIFICATIONS tab of the Vendor Inquiry window displays information about a 
vendor’s class, class description, and qualification type (see Figure 11-5).  

 
Figure 11-5. Classifications Tab of the Vendor Inquiry Window 

The INSURANCE tab of the Vendor Inquiry window displays information about vendor 
insurance (see Figure 11-6).  

 
Figure 11-6. Insurance Tab of the Vendor Inquiry Window 

The OFFICERS tab of the Vendor Inquiry window displays information about vendor 
officers (see Figure 11-7).  
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Figure 11-7. Officers Tab of the Vendor Inquiry Window 

When you have completed your review of the vendor information, click CLOSE to exit the 
Vendor Inquiry window and return to the Vendor list window.  

11.3 Changing Vendor Information  

You can change information about a vendor through the Vendor Tabbed Folder Change 
window or the Change Vendor window.  

11.3.1 Changing Vendor Information Through the Tabbed Folder Window  

To change information about a vendor, select the vendor record from the Vendors list 
window and choose Tabbed Folder Change from the right mouse button menu.  
Trns•port displays the Vendor Tabbed Folder window with all known information about 
the Vendor (see Figure 11-8).  

 
Figure 11-8. General Tab of the Vendor Tabbed Folder Window 
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You cannot change the Vendor Number, but you can add or change information in the 
rest of the fields. When you finish adding or changing information, save your changes to 
the database by clicking the SAVE button or selecting Save from the File menu.  

 Note: If a vendor is no longer active, do not delete the vendor record because 
you will lose all the reference information about the vendor. Instead, click the 
Obsolete check box to set the flag.  

11.3.2 Changing Vendor Information Through the Vendor Window  

To change information about a vendor, select the vendor record from the Vendors list 
window and choose Change from the right mouse button menu to display the Vendor 
window (see Figure 11-9).  

 
Figure 11-9. Vendor Window 

To create a complete record you must enter information in the fields listed in Section 
11.1.1.  

You cannot change the Vendor Number, but you can add or change information in the 
rest of the fields. Click OK to save your changes or CANCEL to return to the Vendors list 
window.  

 Note: If a vendor is no longer active, do not delete the vendor record because 
you will lose all the reference information about the vendor. Instead, click the 
Obsolete check box to set the flag.  

11.4 Removing Vendors  

To delete vendor records, select the vendor or vendors in the Vendors list window. Then 
choose Delete from the right mouse button menu.  Trns•port displays the first of two 
Delete Warning windows.  

Click YES in each window to complete the delete process. 
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11.5 Managing Vendor Addresses  

You can easily keep track of multiple addresses for all vendors bidding on a project.    

11.5.1 Adding Vendor Addresses  

You can add addresses for a selected vendor through the Vendor Tabbed Folder window 
or the Vendor Address window.  

11.5.2 Adding a Vendor Address Through the Tabbed Folder Window  

To add an address to a new vendor record, select the vendor record from the Vendors 
list window and choose Tabbed Folder Change from the right mouse button menu.  
Trns•port displays the Vendor tabbed folder window.  Click on the ADDRESSES tab (see 
Figure 11-10).  

 
Figure 11-10. Addresses Tab of the Vendor Tabbed Folder Window 

The top part of the ADDRESSES tab contains a grid of all the existing addresses for the 
vendor. The bottom part of the ADDRESSES tab contains address detail information for 
the address selected in the grid.  

To add a new address, click in the address grid and select Add from the right mouse 
button menu.  Trns•port adds a blank row to the list of addresses.  Enter data into the 
blank fields displayed in the detail area of the Addresses tab. Click the PAGE 2 option 
button to enter additional information.  

You can also enter address information directly into the grid area of the tab by selecting 
Hide Detail from the right mouse button menu.  The detail area of the tab disappears 
and you can add or edit the information in each cell of the grid.   
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 Note: The Addresses tab contains a standard Trns•port filter and a quick find 
box you can use to search selected single columns of data  

To create a complete record you must enter information in these fields:  

Address The vendor’s address.  

Address Seq. No.  A sequential number used to identify one 
of multiple addresses for a single vendor. 

 

Address Type 

 

A value, which must be selected from the 
ADDRTYP code table, that indicate the type 
of address for the vendor (for example, 
billing or shipping) when a vendor has 
multiple addresses.  

City The vendor’s city.  

State The vendor’s state address. 

ZIP Code The vendor’s zip code.  

You are not required to, but you can enter information in these fields to record additional 
information about a vendor’s address: 

Additional Vendor Name  A field for an additional name of the 
vendor.  

Fax Number The vendor’s fax number.  

E-mail The vendor’s e-mail address.  

Latitude The latitude on a map of the vendor's 
address.    

Longitude The longitude on a map of the vendor's 
address.    

Phone The vendor's phone number.    

Sales Tax Code A coded value indicating the sales tax that 
applies to the vendor. 

If you need to add a second address for the same vendor, click ADD MORE and enter 
another record for the vendor with a different address sequence number.  You can keep 
track of a different vendor number by putting it in the Alternate Vendor Number field.    

Click OK when you have finished adding address information or click CANCEL to return to 
the Addresses grid window without saving the new address record.  Before leaving the 
tabbed folder window you must save the new address record to the database by clicking 
the SAVE button or selecting Save from the File menu.  

11.5.3 Adding Vendor Addresses Through the Vendor Address Window  

To add addresses to new vendor records, select the vendor record from the Vendors list 
window and click the ADDRESS button to display the Addresses list window (see Figure 
11-11).  
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Figure 11-11. Addresses List Window 

Press INSERT or choose Add from the right mouse button menu to add an address for the 
selected vendor. Trns•port displays the Add Vendor Address window (see Figure 11-12).  

 
Figure 11-12. Add Vendor Address Window 

To create a complete record you must enter information in the fields listed in the 
previous section.  

If you need to add a second address for the same vendor, click ADD MORE and enter 
another record for the vendor with a different address sequence number.  You can keep 
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track of a different vendor number by putting it in the Alternate Vendor Number field.    

To save your changes and return to the Addresses list window, click OK. If you click 
CANCEL, Trns•port will not add the address.  Click the CLOSE button on the button bar to 
close the Add Vendor Address window and return to the Vendors list window.  

11.5.4 Changing a Vendor Address  

You can change a vendor’s address through the tabbed folder window or through the 
Vendor Address window.  

11.5.5 Changing a Vendor Address Through the Tabbed Folder Window  

To change a vendor’s address, select the address you want to change on the ADDRESS 
tab of the Vendor tabbed folder window. Trns•port displays all the existing information 
about the selected address in the detail area of the Addresses tab.  

You can change or update any fields on the tab. To change information, click in a text 
box and add or delete information.  Click OK when you finish making changes or CANCEL 
to return to the Addresses grid without saving your changes.  

11.5.6 Changing a Vendor Address Through the Vendor Address Window  

To change vendor addresses, select the vendor record from the Vendors list window and 
click the ADDRESS button to display the Addresses list window.  

Choose Change from the right mouse button menu to change an address for the 
selected vendor. Trns•port displays the Vendor Address window.  

You can change or update any fields except the Address Sequence Number field.  Click 
OK when you finish making changes or CANCEL to return to the Addresses list window 
without saving your changes.  

11.5.7 Deleting a Vendor Address  

You can delete a vendor’s address through the tabbed folder window or through the 
Vendor Address window.  

11.5.8 Deleting a Vendor Address Through the Tabbed Folder Window  

To delete a vendor address, select the address you want to delete from the list on the 
ADDRESS tab of the Vendor tabbed folder window and choose Delete from the right 
mouse button menu.  Trns•port displays a Delete Warning window.  Click YES in the 
window to complete the delete process.  

11.5.9 Deleting a Vendor Address Through the Vendor Address Window  

To delete a vendor address, select the vendor in the Vendors list window and click the 
ADDRESS button to display the Addresses list window. Select the address you want to 
delete and choose Delete from the right mouse button menu.  Trns•port displays a 
Delete Warning window.  Click YES in the window to complete the delete process.  

11.6 Managing Officer Information for a Vendor  

Officers are persons who are authorized to sign for a contractor or hold some office in 
the vendor’s company.  You can add, change, or delete vendor officer information.  

11.6.1 Adding Officer Information  

You can add officer information for a vendor through the Vendor tabbed folder window or 
the Vendor Officers list window.  
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11.6.2 Adding Officer Information Through the Tabbed Folder Window  

To add officer information for a vendor, select the vendor record from the Vendors list  

window and choose Tabbed Folder Change from the right mouse button menu.  
Trns•port displays the Vendor tabbed folder window.  Click the OFFICERS tab (see Figure 
11-13).  

 
Figure 11-13. Officers Tab of the Vendor Tabbed Folder Window 

The top part of the OFFICERS tab contains a grid of all the existing officers for the vendor. 
The bottom part of the OFFICERS tab contains officer detail information for the officer 
selected in the grid.  

To add a new officer, click in the officers grid and select Add from the right mouse 
button menu.  Trns•port adds a blank row to the list of officers.  Enter data into the 
blank fields displayed in the detail area of the Officers tab.  

You can also enter officer information directly into the grid area of the tab by selecting 
Hide Detail from the right mouse button menu.  The detail area of the tab disappears 
and you can add or edit the information in each cell of the grid.  

 Note: The OFFICERS tab contains a standard Trns•port filter and a quick find box 
you can use to search selected single columns of data. 

To create a complete record you must enter information in this field:  

Vendor Officer The name of an officer for a vendor. 

You are not required to, but you can enter information in these fields to record additional 
information about a vendor’s officers:  

Address Seq. No. A sequential number used to identify 
one of multiple addresses for a single 
vendor that corresponds to the 
vendor officer’s address. 
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Address Type A value, which must be selected from 
the ADDRTYP code table, that 
indicate the type of address for the 
vendor (for example, billing or 
shipping) when a vendor has multiple  
addresses.  

Officer's Address Number  The vendor address sequence 
number identifying the vendor  
officer's address. 

Social Security Number The social security number of the 
vendor officer. 

Title of Officer The title of a vendor officer. 

Click OK when you have finished adding officer information or click CANCEL to return to 
the Officers grid without saving the new officer record.  Before leaving the tabbed folder 
window you must save the new officer record to the database by clicking the SAVE button 
or selecting Save from the File menu.  

11.6.3 Adding Officer Information Through the Officers List Window  

To add officer data for a vendor, select a vendor from the Vendors list window and click 
the OFFICERS button to display the Officers list window (see Figure 11-14).  

 
Figure 11-14. Officers List Window 

You can add values by pressing INSERT or choosing Add from the right mouse button 
menu.  Trns•port displays the Add Officer window (see Figure 11-15).  
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Figure 11-15. Add Officer Window 

To create a complete record you must enter information in the fields listed in the 
previous section.  

Click OK to add the officer information and return to the Officers list window or click ADD 
MORE to add another officer. Click the CLOSE button on the button bar to close the Officers 
list window and return to the Vendors list window.  

11.6.4 Changing Officer Information  

You can change information about a vendor’s officers through the tabbed folder window 
or through the Vendor Address window.  

11.6.5 Changing Officer Information Through the Tabbed Folder Window  

To change information about a vendor’s officer, select the record you want to change on 
the OFFICERS tab of the Vendor tabbed folder window. Trns•port displays all the existing 
information about the selected officer in the detail area of the Officers tab.  

You can change or update any fields on the tab. To change information, click in a text 
box and add or delete information.  Click OK when you finish making changes or CANCEL 
to return to the Officers grid without saving your changes.  

11.6.6 Changing Officer Information Through the Vendor Address Window  

To change information about a vendor officer, select the record you want to change in 
the Officers list window. Then choose Change from the right mouse button menu.  
Trns•port displays a Vendor Officer window.  

You can add or change information in any fields except Vendor Officer.  When you finish 
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making changes, click OK to save your changes or CANCEL to return to the Vendor list 
window without saving.  

11.6.7 Deleting Officer Information  

You can delete officer information through the tabbed folder window or through the 
Officer list window.  

11.6.8 Deleting Officer Information Through the Tabbed Folder Window  

To delete an officer, select the officer you want to delete from the list on the OFFICERS 
tab of the Vendor tabbed folder window and choose Delete from the right mouse button 
menu.  Trns•port displays a Delete Warning window.  Click YES in the window to 
complete the delete process.  

11.6.9 Deleting Officer Information Through the Officer Window  

To delete vendor officer records, select the record or records in the Officers list window 
and choose Delete from the right mouse button menu.  Trns•port displays a delete 
warning window.  

Click YES in each window to complete the delete process.    

11.7 Managing Vendor Work Classifications  

Work classifications include all the types of work a vendor is allowed to perform. This 
could include pre-qualifications, certifications, and all types of work for services and 
supplies.  

11.7.1 Adding a Vendor Work Classification  

You can add work classification information for a selected vendor through the Vendor 
Tabbed Folder window or the Vendor Work Classifications list window.  

11.7.2 Adding a Vendor Work Classification Through the Tabbed Folder Window  

To add a work classification to a vendor record, select the vendor record from the 
Vendors list window and choose Tabbed Folder Change from the right mouse button 
menu.  Trns•port displays the Vendor tabbed folder window.  Click .the CLASSIFICATIONS 
tab (see Figure 11-16).  

 
Figure 11-16. Classifications Tab of the Vendor Folder Window 
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The top part of the CLASSIFICATIONS tab contains a grid of all the existing classifications 
for the vendor. The bottom part of the CLASSIFICATIONS tab contains address detail 
information for the classification selected in the grid.  

 

To add a new classification, click in the classification grid and select Add from the right 
mouse button menu.  Trns•port adds a blank row to the list of classifications.  Enter data 
into the blank fields displayed in the detail area of the Classifications tab.  

You can also enter work classification information directly into the grid area of the tab by 
selecting Hide Detail from the right mouse button menu.  The detail area of the tab 
disappears and you can add or edit the information in each cell of the grid.  

 Note: The CLASSIFICATIONS tab contains a standard Trns•port filter and a quick 
find box you can use to search selected single columns of data. 

To create a complete record you must enter information in these fields:  

Work Classification A value, which must be selected from the 
attached VWRKCLS code table, which 
identifies the classification of 
work the vendor is qualified to perform. 

Qualification Amount (For This 
Class)  

 

The total dollar value of contracts for 
which the vendor is qualified to work. 
Defaults to zero.  

Click OK when you have finished adding classification information or click CANCEL to 
return to the Classifications grid without saving the new classification record.  Before 
leaving the tabbed folder window you must save the new classification record to the 
database by clicking the SAVE button or selecting Save from the File menu.  

11.7.3 Adding a Vendor Work Classification Through the Work Classifications 
Window  

To add a vendor work classification, select the vendor in the Vendors list window and 
click the WORKCLASS button. Trns•port displays a Work Classifications list window (see 
Figure 11-17).  
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Figure 11-17. Work Classifications List Window 

Press INSERT or choose Add from the right mouse button menu to display the Add Work 
Classification window (see Figure 11-18).  

 
Figure 11-18. Add Work Classification Window 

To create a complete record you must enter information in the fields listed in the 
previous section.  

If you want to add more than one work classification for this vendor, click ADD MORE. 
When you finish adding a work classification for this vendor, click OK to return to the 
Work Classifications list window.  Click the CLOSE button on the button bar to close the 
Add Work Classification window and return to the Vendors list window.  

11.7.4 Changing a Vendor Work Classification  

You can change a vendor’s work classifications through the tabbed folder window or 
through the Vendor Work Classifications window.  
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11.7.5 Changing a Work Classification Through the Tabbed Folder Window  

To change a work classification, select the classification you want to change on the 
CLASSIFICATIONS tab of the Vendor tabbed folder window. Trns•port displays all the 
existing information about the selected classification in the detail area of the 
Classifications tab.  

You can change or update any fields on the tab. To change information, click in a text 
box and add or delete information.  Click OK when you finish making changes or CANCEL 
to return to the Classifications grid without saving your changes.  

11.7.6 Changing a Work Classification Through the Work Classifications 
Window  

To change a vendor work classification, select the work classification from the Work 
Classifications list window. Choose Change from the right mouse button menu to display 
the Work Classification window.    

You can add and change information in any fields except the Work Classification field.  
When you finish updating a work classification for the selected vendor, click OK to return 
to the Work Classifications list window.  Click CANCEL to return to the Work Classifications 
list window without saving.  

11.7.7 Deleting a Vendor Work Classification  

You can delete a vendor’s work classification through the tabbed folder window or 
through the Work Classifications window.  

11.7.8 Deleting a Work Classification Through the Tabbed Folder Window  

To delete a work classification, select the classification you want to delete from the list 
on the CLASSIFICATIONS tab of the Vendor tabbed folder window and choose Delete from 
the right mouse button menu.  Trns•port displays a Delete Warning window.  Click YES in 
the window to complete the delete process.  

11.7.9 Deleting a Work Classification Through the Vendor Address Window  

To delete vendor work classifications, select the records you want to delete in the Work 
Classifications list window. Then select Delete from the right mouse button menu.  
Trns•port displays a Delete Warning window.  Click YES in each window to complete the 
delete process.  

11.8 Managing Vendor Insurance  

LAS allows you to store insurance policy data required for all contractors bidding on a 
proposal, as well as specific policies required for contract award. You can add, change or 
delete insurance information for a vendor.  

11.8.1 Adding Vendor Insurance Information  

You can add a vendor’s insurance information through the Vendor Tabbed Folder window 
or the Vendor Insurance Data list window  

11.8.2 Adding Insurance Information Through the Tabbed Folder Window  

To add vendor insurance information, select the vendor record from the Vendors list 
window and choose Tabbed Folder Change from the right mouse button menu.  
Trns•port displays the Vendor tabbed folder window.  Click the INSURANCE tab (see 
Figure 11-19).  
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Figure 11-19. Insurance Tab of the Vendor Tabbed Folder Window 

The top part of the INSURANCE tab contains a grid of all the existing insurance records for 
the vendor. The bottom part of the INSURANCE tab contains insurance detail information 
for the insurance record selected in the grid.  

To add a new insurance record, click in the insurance grid and select Add from the right 
mouse button menu.  Trns•port adds a blank row to the list of insurance records.  Enter 
data into the blank fields displayed in the detail area of the Insurance tab. Click the PAGE 
2 option button to enter additional information.  

You can also enter insurance information directly into the grid area of the tab by 
selecting Hide Detail from the right mouse button menu.  The detail area of the tab 
disappears and you can add or edit the information in each cell of the grid.   

 Note: The INSURANCE tab contains a standard Trns•port filter and a quick find 
box you can use to search selected single columns of data  

To create a complete record you must enter information in these fields:  

Ins. Sequence No. A sequential number used to identify one 
of multiple insurance policies for a single 
vendor. 

Insurance Type A value, which must be selected from the 
attached INSTYPE code table, that 
identifies the type of insurance policy; for 
example, general liability, umbrella, 
worker’s compensation. 

You are not required to, but you can enter information in these fields to record additional 
information about a vendor’s insurance: 

Agent Agent who sold the contractor the 
insurance policy. 

Begin Date Date insurance policy takes effect 
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Comment Space for additional information about the 
insurance policy. 

Company Code The vendor number of the insurance 
company underwriting the insurance 
policy. 

Contract ID A unique identifier for a proposal or 
contract. 

Expiration Date The date on which the vendor’s work 
certification or insurance policy expires. 

Insurance Status A value, which must be selected from the 
attached INSSTAT code table, that 
indicates whether insurance is active, a 
binder, canceled or expired. 

Phone Number Phone number for agent or insurance 
company.  

Policy No. Policy number for the contractor’s 
insurance policies.  

Click OK when you have finished adding insurance information or click 
CANCEL to return to the Insurance grid without saving the new insurance 
record. Before leaving the tabbed folder window you must save the new 
insurance record to the database by clicking the SAVE button or selecting 
Save from the File menu.  

11.8.3 Adding Vendor Insurance Information Through the Vendor Insurance 
Window  

To add vendor insurance, select the vendor from the Vendors list window.  Then click the 
INSURE button to display the Insurance Data list window (see Figure 11-20).  

 
Figure 11-20. Insurance Data List Window 
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Choose Add from the right mouse button menu.  Trns•port displays the Add Vendor 
Insurance window (see Figure 11-21).  

 
Figure 11-21. Add Vendor Insurance Window 

To create a complete record you must enter information in the fields listed in the 
previous section.  

Click OK to save the new insurance information, ADD MORE to add another insurance 
record for the same vendor, or CANCEL to return to the Insurance list window without 
adding a record.  

11.8.4 Changing Vendor Insurance  

You can change a vendor’s insurance record through the tabbed folder window or 
through the Vendor Insurance window.  

11.8.5 Changing Insurance Information Through the Tabbed Folder Window  

To change a vendor’s insurance, select the insurance record you want to change on the 
INSURANCE tab of the Vendor tabbed folder window. Trns•port displays all the existing 
information about the selected insurance in the detail area of the Insurance tab.  

You can change or update any fields on the tab. To change information, click in a text 
box and add or delete information.  To change the Ins. Company Code field, click the 
down arrow to the right of the text box. Trns•port displays the Vendor list window.  
Select the new vendor from the Vendor list window and click OK. Trns•port enters the 
new company code in the field.  
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Click OK when you finish making changes or CANCEL to return to the Insurance grid 
without saving your changes.  

11.8.6 Changing Insurance Information Through the Vendor Insurance Window  

To change vendor insurance, select the insurance record in the Insurance Data list 
window and choose Change from the right mouse button menu.  Trns•port displays a 
Vendor Insurance window.  

You can add information to or change any fields except the Insurance Sequence Number 
field. When you finish making changes, click OK to save your changes or click CANCEL to 
return to the Insurance Data list window without saving.  

11.8.7 Deleting Vendor Insurance  

You can delete a vendor insurance record through the tabbed folder window or through 
the Vendor Insurance window.  

11.8.8 Deleting a Vendor Insurance Record Through the Tabbed Folder Window  

To delete a vendor insurance record, select the record you want to delete from the list 
on the INSURANCE tab of the Vendor tabbed folder window and choose Delete from the 
right mouse button menu.  Trns•port displays a Delete Warning window.  Click YES in the 
window to complete the delete process.  

11.8.9 Deleting a Vendor Insurance Record Through the Vendor Address 
Window  

To delete vendor insurance, select the insurance record in the Insurance Data list 
window and choose Delete from the right mouse button menu.  Trns•port displays two 
delete windows. Click YES in each window to complete the delete process.    

11.8.10 Listing Vendor Insurance  

You can generate a listing of a vendor’s insurance data that includes an Insurance 
Expiration Letter and an Insurance Updates report. To produce this listing, select Run 
Process from the File menu and choose List Vendor Insurance Data from the 
Processes window. Trns•port displays a Confirm Process Submission window.  

Click SUBMIT to submit the process, PARAMETERS to change process submission 
information, or CANCEL to return to the Vendors list window without submitting the 
process.    

11.9 Managing Vendor Affiliate Information  

Affiliates are two vendors who have an on-going legal relationship. Affiliates can be 
parent and subsidiary or substantial owners of each other’s stock. Trns•port does not 
consider two vendors who engage in a single joint venture affiliates.  

11.9.1 Adding a Vendor Affiliate  

You can add affiliate information for a selected vendor through the Vendor Tabbed Folder 
window or the Vendor Affiliations List window.  

11.9.2 Adding an Affiliate Through the Tabbed Folder Window  

To add an affiliate to a vendor, select the vendor record from the Vendors list window 
and choose Tabbed Folder Change from the right mouse button menu.  Trns•port 
displays the Vendor tabbed folder window. Click the AFFILIATES tab (see Figure 11-22).  
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Figure 11-22. Affiliates Tab of the Vendor Tabbed Folder Window 

The top part of the AFFILIATES tab contains a grid of all the existing affiliates for the 
vendor. The bottom part of the AFFILIATES tab contains detail information for the affiliate 
selected in the grid.  

To add a new affiliate, click in the Affiliates grid and select Add from the right mouse 
button menu.  Trns•port adds a blank row to the list of affiliates.  Enter data into the 
blank fields displayed in the detail area of the Affiliates tab.  Click the PAGE 2 option 
button to enter additional information.  

You can also enter affiliate information directly into the grid area of the tab by selecting Hide 
Detail from the right mouse button menu.  The detail area of the tab disappears and you can 
add or edit the information in each cell of the grid.  

 Note: The AFFILIATES tab contains a standard Trns•port filter and a quick find 
box you can use to search selected single columns of data.   

To create a complete record you must enter information in these fields:  

Affiliate Number The name of the vendor associated with 
another vendor.  All references to 
vendors are validated with the Vendor 
file.  

Relation to Vendor A value, which must be selected from the 
attached RELAT code table, which 
indicates the relationship between a 
vendor and its affiliate. 

You are not required to, but you can enter information in these fields to record additional 
information about a vendor’s affiliates:  

Percent Ownership The vendor's percentage of ownership of 
the affiliated  
company.  
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Click OK when you have finished adding affiliate information or click CANCEL to return to 
the Affiliates grid without saving the new affiliate record. Before leaving the tabbed 
folder window you must save the new affiliate record to the database by clicking the 
SAVE button or selecting Save from the File menu.  

11.9.3 Adding an Affiliate Through the Vendor Affiliations List Window  

You can add affiliate information for a vendor by selecting the vendor from the Vendors 
list window. Click the AFFILS button to display the Affiliations list window (see Figure 11-
23).  

 
Figure 11-23. Affiliations List Window 

Press INSERT or select Add from the right mouse button menu to display the Add Affiliate 
window (see Figure 11-24).  

 
Figure 11-24. Add Affiliate Window 
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To create a complete record you must enter information in the fields listed in the 
previous section.  

Click OK to add the affiliate information and return to the Affiliations list window or click 
ADD MORE to add another affiliate.  Click the CLOSE button on the button bar to close the 
Affiliations list window and return to the Vendors list window.  

11.9.4 Changing Affiliate Information  

You can change affiliate information through the tabbed folder window or through the 
Vendor Affiliations window.  

11.9.5 Changing Affiliate Information Through the Tabbed Folder Window  

To change affiliate information, select the affiliate record you want to change on the 
AFFILIATES tab of the Vendor tabbed folder window. Trns•port displays all the existing 
information about the selected affiliate in the detail area of the Affiliates tab.  

You can change or update any fields on the tab. To change information, click in a text 
box and add or delete information.  Click OK when you finish making changes or CANCEL 
to return to the Affiliates grid without saving your changes.  

11.9.6 Changing Affiliate Information Through the Vendor Affiliations Window  

To change affiliate information, select the record you want to change in the Affiliations 
list window and choose Change from the right mouse button menu.  Trns•port displays 
an Affiliate window.  

You cannot change information in the Affiliate Number or Relation to Vendor fields.  
When you finish making changes, click OK to save your changes or CANCEL to return to 
the Affiliations list window without saving.  

11.9.7 Deleting an Affiliate  

You can delete an affiliate record through the tabbed folder window or through the 
Vendor Affiliations window.  

11.9.8 Deleting a Vendor Affiliate Through the Tabbed Folder Window  

To delete an affiliate, select the affiliate you want to delete from the list on the 
AFFILIATES tab of the Vendor tabbed folder window and choose Delete from the right 
mouse button menu.  Trns•port displays a Delete Warning window.  Click YES in the 
window to complete the delete process.  

11.9.9 Deleting a Vendor Affiliate Through the Vendor Affiliations Window  

To delete affiliate records, select the record or records in the Affiliations list window.  You 
can select more than one record by holding down CTRL while you select with the mouse.  
Then choose Delete from the right mouse button menu.  Trns•port displays a Delete 
Warning window.  

Click YES to continue the delete process or No to return to the Affiliations list window 
without deleting. If you click YES, Trns•port displays a Confirm Delete window.  Click YES 
in the window to complete the delete process.    

11.10 Using Vendor Attachments  

The ATTACHMENTS tab allows you to integrate OLE-compatible documents (for example, 
Microsoft® Word documents or Excel spreadsheets), web pages, and plug-in applications 
into Trns•port.  By adding an attachment to a vendor, you can access any information 
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related to the vendor in the attachment.    

The ATTACHMENTS tab contains a grid that lists all the attachments associated with the 
vendor that is open in the tabbed folder window. Information displayed about each 
attachment includes the name, attachment type, and a short description (see Figure 11-
25).  

 
Figure 11-25. Attachments Tab 

To open an attachment, select the attachment record in the list and choose Open from 
the Edit menu or the right mouse button menu.  Double clicking on a row in the grid will 
also open an attachment.  To open more than one attachment at a time, hold down CTRL 
and click on each attachment you want to open, then choose Open from the Edit menu.  

11.11 Listing Vendors and Vendor Insurance Data  

To produce a list of vendors and a list of vendor insurance data, select one or more 
vendors from the Vendors list window.  (You can select more than one vendor by holding 
down CTRL while you select vendors with the mouse.)  Choose Run Process from the 
File menu to display the Processes window.  

To produce a list of vendors, choose List Vendors and click OK to display the Select 
Vendor Listings window (see Figure 11-26).  
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Figure 11-26. Select Vendors Listings Window 

Select the parts of the report you want to print by clicking in the boxes. Then click 
SUBMIT to submit the process, PARAMETERS to change process submission information, or 
CANCEL to return to the Vendors list window without submitting the process.  See 
“Submitting Batch Processes” in Chapter 3 for more information.    

To produce a list of vendor insurance data, select List Vendor Insurance from the 
Processes window as described above.  

11.12 Listing Alphabetized Vendors  

To produce a list of alphabetized vendors, select one or more vendors from the Vendors 
list window. You can also select more than one vendor by holding down CTRL while you 
select vendors with the mouse.  Choose Run Process from the File menu to display the 
Processes window.  

To produce a list of vendors, choose List of Alphabetized Vendors and click OK to 
display the Select Vendor Listings window (see Figure 11-27).  

 
Figure 11-27. Select Vendors Listings Window 

Select the parts of the report you want to print by clicking in the boxes. Then click 
SUBMIT to submit the process, PARAMETERS to change process submission information, or 
CANCEL to return to the Vendors list window without submitting the process.   
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11.13 Generating Mailing Labels  

To generate mailing labels for vendors, select the vendor or vendors for whom you want 
to generate the labels from the Vendors list window (click the VENDORS button). Then 
choose Run Process from the right mouse button menu.  Trns•port displays the 
Processes window (see Figure 11-28).  

 
Figure 11-28. Processes Window 

Choose Generate Vendor Mailing Labels and click OK. Trns•port displays a Mailing 
Label Parameters window (see Figure 11-29).  

 
Figure 11-29. Mailing Label Parameters Window 

Enter the number of labels you want to generate and the address number of the address 
you want printed. Click SUBMIT to submit the batch process to print mailing labels.  

11.14 Generating Mailing Labels for Awarded Vendors  

To generate mailing labels for awarded vendors, select the call or calls from the Letting 
Proposals list window for which you want to generate the labels.  

Click the BIDLETS button to select the bid letting, and click LETPROP button to select the 
call. Then choose Run Process from the right mouse button menu.  Trns•port displays 
the Processes window. Choose Generate Awarded Vendor Mailing Labels and click 
OK. Trns•port displays a Mailing Label Parameters window (see Figure 11-30).  
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Figure 11-30. Mailing Label Parameters Window 

Select the number of labels you want to generate and the address number of the 
address you want printed. Click SUBMIT to submit the batch process to print mailing 
labels.  
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12.0 Managing DBE/WBE/MBE Commitments (Civil Rights Division)

You can enter information about DBE, WBE, and MBE subcontractors when bidders 
submit their bids.  If a project requires a DBE/WBE/MBE subcontractor to complete a 
certain percentage of the work, bidders must include this information in their bids:  

• Each DBE/WBE/MBE subcontractor  

• Type of work to be performed by the subcontractor  

• Dollar commitment to the subcontractor  

Each DBE/WBE/MBE contractor must have a record in the master vendor file.  If the 
vendor is a new subcontractor, you will have to add a new vendor record (see 
Chapter 11) before you can create a DBE/WBE/MBE Commitment record.  

12.1  Adding a DBE/WBE/MBE Commitment  

To create a DBE/WBE/MBE Commitment header record, select a bid letting from the 
Trns•port LAS Bid Lettings list window (see Figure 12-1)  

 
Figure 12-1. Bid Lettings List Window 

Click the LETPROP button (or select Letting Proposal List from the right mouse button menu) 
to display the Letting/Proposals list window, which lists all proposals associated with the 
selected letting (see Figure 12-2).  
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Figure 12-2. Letting/Proposals List Window 

Select a letting proposal and click the DBE COMMIT button (or select DBE Contract 
Commitments List from the right mouse button menu) to display the DBE Commitments list 
window for the selected proposal (see Figure 12-3).  

 
Figure 12-3. DBE Commitments List Window 

You can add a new commitment by pressing INSERT or choosing Add from the right mouse 
button menu. Trns•port displays an Add DBE/WBE/MBE Commitment window (see Figure 
12-4).  
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Figure 12-4. Add DBE/WBE/MBE Commitment Window 

DBE/WBE 
Vendor Number  

A value, which must be selected from the attached 
VENDOR code table, which is the vendor code for the 
particular DBE/WBE vendor.  

Vendor Number  A unique identifier for a vendor.  When you select the 
vendor number, Trns•port automatically enters the 
Vendor Name field.  The vendor number comes from the 
Vendors file, so there should already be a record for each 
DBE/WBE/MBE contractor.  

You are not required to, but you can enter information in these fields to record additional 
information about a DBE/WBE/MBE commitment:  

Approval Date The date the vendor was approved for 
work. 

Commitment mount  The total dollars committed to the 
DBE/WBE vendor. 

DBE Approval Indicates the acceptability of the 
vendor to work on a contract. 

Desc./Comment A short description or written 
comment about the particular 
DBE/WBE vendor. 

Work Types A coded value, which must be 
selected from the attached VWRDCLS 
code table, which indicates the type of 
work a vendor is qualified to perform. 

Managing DBE/WBE/MBE Commitments  12-3 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

12.1.1 Adding a DBE/WBE/MBE Commitment in the Tabbed Folder Window  

You can also enter DBE/WBE/MBE information about a bidder in the tabbed folder 
window. Select a bid letting in the Bid Lettings list window and choose Letting Proposal List 
from the right mouse button menu.  Trns•port displays the Letting/Proposals list window.  

In the list window select the proposal to which you want to add information and choose 
Tabbed Folder Change from the right mouse button menu.  Trns•port displays the 
Letting/Proposal tabbed folder window.  

To add DBE/WBE/MBE information, click the BID MANAGEMENT tab. Select a bidder from 
the list in the top part of the tab and click the DBE/WBE/MBE COMMITMENTS option 
button. Trns•port displays a list of all DBE/WBE/MBE commitment records for the bidder 
(see Figure 12-5).  

 
Figure 12-5. Bid Management Tab with DBE/WBE/MBE Commitments 

To add a new record to the list, click inside the DBE/WBE/MBE Commitments list and 
choose Add from the right mouse button menu.  Trns•port adds a new row to the list 
(see Figure 12-6).  
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Figure 12-6. Adding DBE/WBE Commitment Information 

To select the DBE/WBE Number, click the down arrow and select a vendor from the 
Vendor list window, using the scroll bar if necessary.  You can also filter and sort the list 
to make it easier to find the vendor you want.  Click OK.  

Trns•port enters the vendor number and name in the row. Enter additional information 
about the DBE/WBE commitment by clicking in each field in the new row and typing the 
information, or by selecting values from automatic drop down lists.  

Before leaving the tabbed folder window you must save the new DBE/WBE commitment 
record to the database by clicking the SAVE button or selecting Save from the File menu.  

12.2  Changing a DBE/WBE/MBE Commitment  

To change an existing DBE/WBE/MBE commitment, follow these steps:  

1. Click the BIDLETS button and select a bid letting from the Bid Lettings list window.  

2. Click the LETPROP button (or select Letting Proposal List from the right mouse button 
menu) and select a letting proposal for the selected bid letting.  

3. Select a letting proposal from the list window and click the DBE button (or select 
DBE Contract Commitments List from the right mouse button menu).  

4. Select the DBE Commitment you want to change and choose Change from the right 
mouse button menu.  

5. Make the changes to the window and click OK to save the changes.  

12.2.1 Changing a DBE/WBE/MBE Commitment in the Tabbed Folder Window  

To make changes to a DBE/WBE/MBE commitment record in the Letting/Proposal tabbed 
folder window, click the BID MANAGEMENT tab. Select the bidder in the top part of the tab 
and click the DBE/WBE COMMITMENT option button. Trns•port displays all the existing 
DBE/WBE commitment records for the bidder in the grid at the bottom of the tab.  

Make changes by clicking in the fields and typing the new information, or by selecting 
new values from automatic drop down lists.  
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Before leaving the tabbed folder window you must save the new bidder information to 
the database by clicking the SAVE button or selecting Save from the File menu.  

12.3  Deleting a DBE/WBE/MBE Commitment  

You can delete an existing DBE/WBE/MBE commitment by selecting a bid letting and a 
letting/proposal as described at the beginning of this chapter.  Then click the DBE button 
or select DBE Contract Commitments List from the right mouse button menu. Trns•port 
displays a DBE Commitments list window.  

Select the DBE Commitment you want to delete and choose Delete from the right mouse 
button menu. Trns•port displays a Delete Warning window.  

Click YES in each window to complete the delete process.  

12.3.1 Deleting a DBE/WBE/MBE Commitment in the Tabbed Folder Window  

You can also delete DBE/WBE/MBE commitment records in the tabbed folder window. 
Open the Letting/Proposal tabbed folder window and select the BID MANAGEMENT tab. 
Select the bidder in the top part of the tab and click the DBE/WBE COMMITMENT option 
button. Trns•port displays all the existing DBE/WBE commitment records for the bidder 
in the grid at the bottom of the tab.  

Click the row containing the DBE/WBE/MBE record you want to delete and select Delete 
from the right mouse button menu.  Trns•port displays a Delete Warning window.  

Click YES in the window to complete the delete.  

Before leaving the tabbed folder window you must save the change in DBE/WBE/MBE 
commitment information to the database by clicking the SAVE button or selecting Save 
from the File menu.  

12.4 Listing a DBE/WBE Commitment  

You can produce a hard copy listing of the DBE/WBE commitment information.  Select a 
bid letting in the Bid Lettings list window.  Then select a letting/proposal or proposals in 
the Letting/Proposals list window.  Choose Run Process from the right mouse button menu. 
Trns•port displays a Processes window.  

Select List DBE/WBE Commitments from the list and click OK to submit a batch process. 
Trns•port displays a Confirm Process Submission window.  

Click SUBMIT to submit the batch process, PARAMETERS to change process submission 
parameters, or CANCEL to return to the Letting/Proposals list window without submitting 
the process.  

 

Managing DBE/WBE/MBE Commitments  12-6 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

13.0 Exporting LAS Information to Other Trns•port Modules  

After a contract is awarded you can export the related information to other Trns•port 
modules for construction management and data archive.  

13.1 Passing Data to Trns•port SiteManager  

You can export contract and project information (such as descriptive information, item 
quantities and estimated prices, bid data, and award information) to Trns•port 
SiteManager once the contract has been awarded. When you pass data to 
SiteManager, Trns•port does not delete data from the Trns•port LAS database.  

This process does not write data directly to the SiteManager database. Trns•port 
produces multiple intermediate files or "pass files" in a format that SiteManager can 
import (see Figure 13-1).   

Each awarded contract you want to pass to SiteManager MUST contain this information:  

1. The winning vendor's record must contain at least one address and the Planholder 
Bill-to Address must be a valid vendor address record.  

2. The Letting Proposal Letting Status field must contain a value found in the 
AWARDED code table.  

3. The Passed to Construction/DSS field (in the Letting/Proposal window) must be 
blank (which means the proposal or contract has not been passed) or contain the 
letter D (which means the proposal or contract has previously been passed to 
Trns•port BAMS/DSS, but has not been passed to Trns•port SiteManager.).  After 
Trns•port completes the Pass Contract Data to SiteManager process, it changes a 
blank to a C (passed to construction), or a D to a B (passed to both construction 
and BAMS/DSS).  

4. Additional data edits are performed in the process that may reject the contract. 

 
Figure 13-1. Letting/Proposal Window 
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If you must correct or add to a contract, do it in Trns•port LAS and pass the contract to 
SiteManager again. To reset the values in the Letting Status and Passed to 
Construction/DSS fields for a contract (so that you can pass the contract again), follow 
the steps in the “Managing a Bid Letting” chapter of this guide.  

To access the export process, select Export from the File menu and then slide the 
mouse to the right to select Pass Contract Data to SiteManager (see Figure 13-2). 

 
Figure 13-2. Export Menu Options 

Trns•port displays an LAS Pass to SiteManager Options window (see Figure 13-3). 
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Figure 13-3. LAS Pass to SiteManager Options Window 

You can choose to pass all the reference data (Items, Funds, Vendors, Districts) or only 
the reference data specifically identified in the contracts being exported. You can also 
choose to generate pass files containing the Trns•port PES and LAS data that is not 
exported into SiteManager (called unmapped data).  When you have finished making 
your selections, click OK.  

Trns•port displays a Client Job Monitor window confirming that your process was 
submitted.  Click OK.  

When you invoke the batch process, Trns•port will generate a pass file containing all 
contract and reference data to pass to SiteManager. The names of these files are stored 
in the Trns•port system parameter QLASPTSM.  To view or modify this parameter, select 
System Management from the Utilities menu and choose System Parameters List. 

 Note: Each time you run this process, Trns•port generates new pass files.  
Trns•port will destroy or overwrite any existing pass files.  

After you generate the pass file, load it into SiteManager with the appropriate import 
process.  

This process also generates a Pass Contract to SiteManager Edit report, which lists all 
contracts Trns•port LAS passed to Trns•port SiteManager, any error messages, and 
reasons for not passing the data.  

13.2 Passing Data to Trns•port BAMS/DSS  

You can copy proposal and project information (such as descriptive information, item 
quantities and estimated prices, bid data, and award information) to Trns•port 
BAMS/DSS for historical analysis. When you pass data to Trns•port BAMS/DSS, 
Trns•port does not delete data from the Trns•port LAS database.  

This process does not write data directly to the Trns•port BAMS/DSS database.  
Trns•port produces an intermediate file or "pass file" in a format that Trns•port 
BAMS/DSS can import.   
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Each proposal or contract record you want to pass to BAMS/DSS must contain this 
information:  

1. The Letting Status field must contain a value found in the AWARDED, REJECTED, 
or CANCEL code tables.  

2. The Passed to CAS/DSS field (in the Letting/Proposal window) must be blank 
(which means the proposal or contract has not been passed) or contain the letter 
C (which means the proposal or contract has previously been passed to Trns•port 
SiteManager via the SiteManager Contract Initialization process but has not been 
passed to Trns•port BAMS/DSS).  After Trns•port completes the Pass Contract 
Data to DSS process, it changes a blank to a D (passed to BAMS/DSS) or a C to a 
B (passed to both CAS and BAMS/DSS) (see Figure 13-4).  

 
Figure 13-4. Letting/Proposal Window 

If you must correct or add to a contract, do it in Trns•port LAS and pass the contract to 
Trns•port BAMS/DSS again.  To reset the values in the Letting Status and Passed to 
CAS/DSS fields for a contract (so that you can pass the contract again), follow the steps 
in “Changing Letting/Proposals”, Chapter 8, in this Guide. 

To access the pass facility, select Export from the File menu.  Trns•port displays the 
Export menu options (see Figure 13-5).  
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Figure 13-5. Export Menu Options 

Slide the mouse to the right to select Pass Contract Data to DSS. Trns•port displays a 
Confirm Process Submission window (see Figure 13-6).  

 
Figure 13-6. Confirm Process Submission Window 

Click SUBMIT to submit the batch process, click PARAMETERS to change process submission 
parameters, or click CANCEL to cancel batch process submission.   

When you invoke the batch process, Trns•port will generate a pass file containing all 
contract data to pass to BAMS/DSS. The name of this file (IMPORTL.DAT) is stored in the 
Trns•port system parameter QLDSSTRX.  To view or modify this parameter, select 
System Management from the Utilities menu and choose System Parameters List. 

 Note: Each time you run this process, Trns•port generates a new pass file.  
Trns•port will destroy or overwrite any existing pass file.  

After you generate the pass file, load it into Trns•port BAMS/DSS with the Trns•port 
BAMS/DSS Import process.  

! Caution: If Trns•port BAMS/DSS rejects any contracts during the import process, 
you should review any generated exception messages.  Trns•port will pass the 
rejected records to the Error database.   

This process also generates a processing log file, which lists all contracts Trns•port LAS 
passed to Trns•port BAMS/DSS and the contracts that were not passed.  
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14.0 Maintaining Reference Tables - PES 

In this chapter you will learn how to maintain the Trns•port reference tables, which 
Trns•port uses in all modules:  

To view a list of Trns•port reference tables, while in the PES application module, select 
Reference Tables from the File menu (see Figure 14-1).    

 
Figure 14-1. Reference Tables List 

14.1 District Office List  

If you choose District Office List from the Reference Tables menu, Trns•port displays 
the District Offices list window (see Figure 14-2).  

 
Figure 14-2. District Offices List Window 
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14.1.1 Adding a District Office  

To add a district office to the reference table, press INSERT or choose Add from the right 
mouse button menu.  Trns•port displays the Add District window (See Figure 14-3).  

 
Figure 14-3. Add District Window 

To create a complete record you must enter information in these fields: 

District The district where a project or contract 
is located.  The first 2 digits identify the 
district and the last characters specify a 
sub-division of the district. 

You are not required to, but you can enter information in these fields to record additional 
information about a district office: 

Address The address of the district, area office, 
field office or residency. 

City The city in the district address. 

Engineer A code value (that must be in the 
STAFF code table) indicating the 
engineer in charge of the district, area 
office, residency or field office. 

Phone The phone number (including area code 
or extension) of the district, area office, 
field office, or residency. 

State, Zip The two-letter state code and zip code 
for the district’s address.  

Click OK to save the new record, ADD MORE to add another record, or CANCEL to return to 
the District Offices list window without adding a record.  

14.1.2 Changing an Existing District Office Record  

To change an existing record in the reference table, select a district from the District 
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Offices list window and click the OFFICE button or choose District Office from the right 
mouse button menu.  Trns•port displays the District window.  

You can add information to or change any field except the District field.  When you finish 
making changes, click OK to save the changes or CANCEL to return to the District Offices 
list window without saving.  

Click the CLOSE button on the button bar to close the District window and return to the 
District Offices list window.  

14.1.3 Deleting a District Office  

To delete a district office record, select the record in the District Offices list window and 
select Delete from the right mouse button menu.  Trns•port displays a series of delete 
warning windows. Click YES in each window if you are sure you want to delete the record.  

14.1.4 Producing a District List  

To produce a District List report listing, select the district or districts for which you want 
a listing in the District Offices list window and choose Run Process from the right 
mouse button menu.  Trns•port displays a Processes window.  

Select List Districts and click OK to run a process to print the listing.  

Click the CLOSE button on the button bar to close the District Offices list window.  

14.2 Fund List  

If you choose Fund List from the Reference Tables list, Trns•port displays the Funds list 
window (see Figure 14-4).  

 
Figure 14-4. Funds List Window 
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14.2.1 Adding a Funding Source  

To add a funding source to the reference table, press INSERT or choose Add from the 
right mouse button menu.  Trns•port displays the Add Funding Source window (see 
Figure 14-5).  

 
Figure 14-5. Add Funding Source Window 

To create a complete record you must enter information in these fields:   

Fund Code A unique identifier for a funding source.  

Fund Description A short description of the fund. 

Fund Priority Order  

 

A sequence number you use to indicate 
the order in which you should encumber 
funds when certain funds have limited 
participation.  Make sure your lowest 
priority funds do not have participation 
limits. 

Participation Percent  

 

The portion of work a particular fund will 
pay. 

You are not required to, but you can enter information in these fields to record additional 
information about a fund:  

Accounting Funding Code You can enter your agency’s accounting 
department codes for funds or groups of 
funds in this field.  

Federal Funding Mark the check box if the fund contains 
federal dollars.  

Funding Prefix An alternate name for a fund.  

When you finish adding information, click OK to save the new record, ADD MORE to add 
another record, or CANCEL to return to the Funds list window without adding a record.  

14.2.2 Changing a Funding Source  

To change a funding source record in the reference table, select a fund record from the 
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Funds list window and click the FUND button or choose Change from the right mouse 
button menu.  Trns•port displays the Fund window.  

You can change information in any field except the Fund Code field.  When you finish 
making changes, click OK to save the changes or CANCEL to return to the Funds list 
window without making changes.  

14.2.3 Deleting a Funds Record  

To delete a funds record, select the record in the Funds list window and select Delete 
from the right mouse button menu.  Trns•port displays a series of delete warning 
windows. Click YES in each of the windows if you are sure you want to delete the record.  

14.2.4 Producing a Funds List  

To produce a Funds List report listing, select the fund or funds for which you want a 
listing in the Funds list window and choose Run Process from the right mouse button 
menu.  Trns•port displays a Processes window.  

Select List Funds and click OK to run a process to print the listing. See “Running a 
Process” in Chapter 3 for more information.  

Click the CLOSE button on the button bar to close the Funds list window.  

14.3 Item List  

If you choose Item List from the Reference Tables list, Trns•port displays the Items list 
window (see Figure 14-6).  

 
Figure 14-6. Items List Window 
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14.3.1 Adding an Item  

To add an item to the reference table, press INSERT or choose Add from the right mouse 
button menu.  Trns•port displays the Add Item window (see Figure 14-7).  

 
Figure 14-7. Add Item Window 

To create a complete record you must enter information in these fields:   

Item Class Function  

 

A coded value indicating the classification 
or category into which the item fits.  
Used by Trns•port BAMS/DSS to group 
items into the same market share.   

Item Number A unique identifying number or 
alphanumeric assigned to each item. 

Long Description A long description of the item (maximum 
60 characters). 

Short Description A short description of the item 
(maximum 40 characters).  When 
Trns•port lists items on a scroll window, 
Trns•port displays the first 30 characters 
of the item short description beside the 
item number.  The first 30 characters 
should therefore contain enough 
information to uniquely distinguish an 
item from all other items.    
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Spec Year Because Trns•port contains projects 
designed at different times, you cannot 
change the reference information about 
each item (such as description and unit). 
Doing so would change the meaning of 
projects already in progress.  Instead, 
you can create entirely new reference 
item lists when necessary.  You can 
distinguish these lists by a spec year.  
This field identifies the specification year 
item list used on the project. 

Type of Item (Matls)  

 

A value, which you must select from the 
attached ITEMTYP code  
table that identifies the material type of 
the item. 

Unit of Measure A value, which you must select from the 
attached UNITS code table, that indicates 
the type of measurement used to 
determine one unit for lump sum items. 

You are not required to, but you can enter information in these fields to record additional 
information about an item:  

Alternate Item ID A separate item code used in public 
documents or communication with other 
systems if the regular item number is 
inappropriate. For example, the regular 
item code might be too specific for public 
documents. 

Combine with Like Items  

 

Trns•port will combine category items 
into a single proposal line item if they 
match in four fields:   the item number, 
the supplemental description, the item 
alternate code, and supplemental 
proposal description. If you want to stop 
Trns•port from doing that, make sure the 
check box is marked.  This will force 
Trns•port to create a separate proposal 
line item for this category item.  
Trns•port will combine different category 
items into a single proposal line item. 

Common Unit of Measure 

 

A value, which must be selected from the 
attached UNITS code table,  that 
indicates the common unit of measure to 
which Trns•port can convert the item for 
comparison to other items.    
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Conv. to Common Units  

 

Trns•port multiplies this conversion 
factor by the item quantity to  
convert the item units to the common 
unit of measure.  

DBE Apply Interest A percentage indicating the average 
number of times this item is selected for 
DBEs and the value of the item portion 
set-aside for DBEs.  

DBE Interest Flag Indicates whether an item is often of 
interest to or is selected for  
DBW/WBE set-aside.  

Exempt from Retainage  Indicates whether Trns•port should 
withhold retainage for work performed on 
a specific item.  

Fuel Adjustment Type  A value, which must be selected from the 
attached FUELTYP code table, that 
indicates an item might require a fuel 
price adjustment.  

Historical Price The price that you have historically used 
for an item. 

Lump Sum Item Units  A value, which must be selected from the 
attached UNITS code table, that identifies 
the type of measurement used to 
determine the unit of one lump sum 
item.  

Major Item Indicates that an item is important 
enough to appear on the Notice to  
Contractors, regardless of the dollar 
amounts allocated to it.  

Obsolete Item Indicates that an item is obsolete and 
should no longer be used on new 
projects. 

Regression Inclusion  This field is not currently used.  

Require Supplemental 
Description  

 

When checked, you must enter a 
supplemental description when  
adding an item to a project.  

Specialty Item Flag Indicates whether an item is a specialty 
item. 

When you finish adding information, click OK to save the new record, ADD MORE to add 
another record, or CANCEL to return to the Items list window without adding a record.  

14.3.2 Copying Items  

To copy information about an existing item to a new item, select the item you want to 
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copy information from in the Item List window.  Select Copy Special from the Edit 
menu.  Trns•port displays the Copy Item window with the selected items’ item number 
and spec year displayed.  

Enter a number for the new item in the New Item Number field and a Spec Year in the 
New Spec Year field. Click OK to save the new item or CANCEL to return to the Items list 
window without saving.  

14.3.3 Changing Item Information  

To change a record in the Item List reference table, click the ITEMS button or choose 
Change from the right mouse button menu.  Trns•port displays an Item window.  

You can add or change information in any field except Item Number and Spec Year.  
When you finish making changes, click OK to save the changes or CANCEL to return to the 
Items list window without saving.  

14.3.4 Adding an AutoPay Item  

An item can be set up to be paid automatically to the contractor based on the percent 
complete of the contract.  To do this, you must set up the payment schedule 
information.  To add an automatically paid item, click the AUTOPAY button or select 
Automatically Paid Items from the right mouse button menu.  Trns•port displays the 
Automatic Payment Records list window (see Figure 14-8).  

 
Figure 14-8. Automatic Payment Records List Window 

Press INSERT or choose Add from the right mouse button menu to display the Add Auto 
Payment window (see Figure 14-9).  
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Figure 14-9. Add Auto Payment Window 

To create a complete record you must enter information in this field:   

Percent Complete Basis  

 

A value, which must be selected from the 
attached PAYPCT code table, that 
indicates the method used to determine 
the current percent of work complete.    

You are not required to, but you can enter information in these fields to record additional 
information about an automatic payment item:  

Maximum Capacity The maximum amount of work, in 
dollars, that a vendor can perform.  

Percent Complete Threshold  

 

A percent of item completion that 
determines if an item should be paid 
automatically.  

Percent of Quantity Paid  

 

The percentage of the current item 
quantity to be paid to date at an 
automatic payment threshold.  

When you finish adding information, click OK to save the record, ADD MORE to add another 
record, or CANCEL to return to the Automatic Payment Records list window without 
making changes.  

14.3.5 Adding Item Materials  

To add item materials, click the MATERIAL button or select Item Materials from the right 
mouse button menu.  Trns•port displays the Item Materials list window (see Figure 14-
10).  
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Figure 14-10. Item Materials List Window 

Press INSERT or choose Add from the right mouse button menu to display the Add 
Material window (see Figure 14-11).  

 
Figure 14-11. Add Material Window 

To create a complete record you must enter information in these fields:   

Material Number A unique number or alphanumeric that 
identifies the material.  

Numerical Factor A numerical factor describing the 
quantity relationship between the item 
and the material. 

You are not required to, but you can enter information in these fields to record additional 
information about an item material:  
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Description A short description of the item material. 

Material Desc. A short description of the material.  

When you finish adding information, click OK to save the record, ADD MORE to add another 
record, or CANCEL to return to the Item Materials list window without making changes.  

14.3.6 Producing an Item List  

To produce an Item List report listing, select the item or items for which you want to 
produce a listing and choose Run Process from the right mouse button menu.  
Trns•port displays a Processes window.  

Select List Items and click OK to run a process to print the listing.  

14.3.7 Deleting an Item Record  

To delete an item record, select the record in the Items list window and select Delete 
from the right mouse button menu.  Trns•port displays a series of delete warning 
windows. Click YES in each of the windows if you are sure you want to delete the record.  

14.4 Material List  

If you choose Material List from the Reference Tables menu, Trns•port displays the 
Materials list window (see Figure 14-12).  

 
Figure 14-12. Materials List Window 

14.4.1 Adding Materials  

To add information about materials to the Material List reference table, press INSERT or 
choose Add from the right mouse button menu.  Trns•port displays the Add Material 
window (see Figure 14-13).  
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Figure 14-13. Add Material Window 

To create a complete record you must enter information in these fields:   

Description A short description of the material. 

Material Number A unique number or alphanumeric that 
identifies the material. 

Spec Year Because Trns•port contains projects 
designed at different times, you cannot 
change the reference information about 
each item (such as description and unit). 
Doing so would change the meaning of 
projects already in progress.  Instead, 
you can create entirely new reference 
item lists when necessary.  You can 
distinguish these lists by a spec year.  
This field identifies the specification year 
item list used on the project. 

You are not required to, but you can enter information in these fields to record additional 
information about a material:  

Material Kind Value indicating the kind of material. 

Unit Material A value, which must be selected from the 
attached UNITS code table, that indicates 
the type of measurement used to 
determine the units of the material. 

When you finish adding information, click OK to save the new record, ADD MORE to add 
another record, or CANCEL to return to the Materials list window without adding a 
record.  

14.4.2 Changing Material Information  

To change an existing record in the reference table, select a materials record from the 
Materials list window and click the MATERIALS button or choose Change from the right 
mouse button menu.  Trns•port displays the Material window.  

Maintaining Reference Tables - PES  14-13 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

You can add information to or change any field except Material Number and Spec Year.  
When you finish making changes, click OK to save the changes or CANCEL to return to the 
Materials list window without saving changes.  

14.4.3 Deleting Material Information  

To delete a materials record, select the record in the Materials list window and select 
Delete from the right mouse button menu.  Trns•port displays a series of delete warning 
windows. Click YES in each of the windows if you are sure you want to delete the record.  

14.4.4 Listing Materials  

To produce a listing of materials, select the material or materials for which you want to 
produce a listing and choose Run Process from the right mouse button menu.  
Trns•port displays a Processes window.  

Select List Materials and click OK to submit a batch process to print the listing.   

Click the CLOSE button on the button bar to close the Materials list window.  

14.5 Vendor List  

If you choose Vendor List from the Reference Tables menu, Trns•port displays a 
Vendors list window (see Figure 14-14).  

 
Figure 14-14. Vendors List Window 

14.5.1 Adding Vendors  

To add information about materials to the Vendor List reference table, press INSERT or 
select Add from the right mouse button menu to display the Add Vendor window (see 
Figure 14-15).  
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Figure 14-15. Add Vendor Window 

To Create a complete record you must enter information in these fields: 

Long Name  The vendor name (long description).  

Name  The vendor name (short description).  

Vendor No.  A unique identifier for a vendor.  

Vendor 
Type  

A value, which must be selected from the attached VENDTYP code 
table, which indicates the type of vendor.  

You are not required to, but you can enter information in these fields to record additional 
information about a vendor:  

Ability Factor The state's numerical rating of the 
vendor's capability to perform work.  It is 
a factor in calculating the vendor's 
capacity; it is not a performance 
evaluation. 

Adjusted Net Worth  

 

The total value of the vendor’s assets 
minus the total value of its debts.  This 
number can represent the agency’s 
estimate, the vendor’s claim, or an audit 
amount.  

Alternate Vendor ID  

 

A code that identifies a vendor in some 
electronic or manual system outside of 
Trns•port.  This value can be used by 
Trns•port to communicate with that 
external system. 

Alternate Vendor No An alternate identification number or 
code for a vendor. 
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Certification Type A value, which must be selected from the 
attached CERTYPE code table, which 
indicates the type of work a vendor is 
authorized to perform. 

Corporation Type A value, which must be selected from the 
attached CORPTYP code table, which 
identifies the vendor’s business structure. 

DBE Certification Date  

 

The date on which the vendor was 
certified for its business enterprise type.  

Ethnic Group Type  

 

The ethnic group code to which the 
Vendor belongs. 

IRS Number The Federal Employer Identification (FEI) 
number assigned to the vendor by the 
IRS. 

Max Capacity The maximum amount of work, in 
dollars, that the vendor can perform. 

Obsolete Indicates that a vendor is obsolete and 
therefore should no longer be used. 

Prequal Certified Date  

 

The date the vendor became qualified to 
perform the type of work certified for the 
state. 

Prequal Expired Date  

 

The date the vendor's qualification for 
certification for work expires.  

Prequal Update List Date  

 

The date you schedule to review the list 
of vendors who have pre-qualified.  

Primary DBE/WBE Code  

 

A coded value indicating the vendor’s 
business enterprise certification type.  

State The two-letter state code and zip code 
for the vendor’s address.  

State of Incorporation  

 

A coded value indicating the state in 
which the vendor company is 
incorporated.  

Uncompleted Work  

 

The amount of work, in dollars, a vendor 
has outstanding.  

When you finish adding information, click OK to add the vendor or ADD MORE to add another 
vendor. When you finish adding vendors, Trns•port adds the new vendors to the Vendors list 
and returns you to the Vendors list window.  
14.5.2 Changing Vendor Information  

To change information about a vendor, select the vendor record from the Vendors list 
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window and choose Change from the right mouse button menu to display the Vendor  
window.  

You can change any field except the Vendor Number.  Click OK to save your changes or 
CANCEL to return to the Vendors list window.  

14.5.3 Deleting Vendor Information  

If a vendor is no longer active, you should not delete the vendor record because you will 
lose all the reference information about the vendor.  Instead, make sure the Obsolete 
box is check in the Vendor record.  

14.5.4 Adding Vendor Addresses  

To add addresses to new vendor records, select the vendor record from the Vendors list 
window and click the ADDRESS button to display the Addresses list window (see Figure 
14-16).  

 
Figure 14-16. Addresses List Window 

Press INSERT or choose Add from the right mouse button menu to add an address for the 
selected vendor. Trns•port displays the Add Vendor Address window (see Figure 14-17).  

 
Figure 14-17. Add Vendor Address Window 
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To create a complete record you must enter information in these fields:  

Address The vendor's address. 

Address Seq. No.  

 

A sequential number used to identify one 
of multiple addresses for a single vendor. 

Address Type  

 

A value indicates the type of address for 
the vendor (for example, billing or 
shipping) when a vendor has multiple 
addresses. 

City The vendor’s city. 

State The vendor’s state address. 

ZIP Code The vendor’s zip code.  

You are not required to, but you can enter information in these fields to record additional 
information about a vendor’s address:  

Additional Vendor Name  A field for an additional name of the 
vendor.    

Fax Number The fax number for the vendor.  

E-mail  The e-mail address for the vendor.  

Address Latitude  The latitude on a map of the vendor's 
address.   

Longitude The longitude on a map of the vendor's 
address.    

Phone The vendor's phone number.    

Phone Number Phone number for the vendor.  

Sales Tax Code A coded value indicating the sales tax 
that applies to the vendor.  

If you need to add a second address for the same vendor, click ADD MORE and enter 
another record for the vendor with a different address sequence number.  You can keep 
track of a different vendor numbers by putting it in the Alternate Vendor Number field.    

To save your changes and return to the Addresses list window, click OK. If you click 
CANCEL, Trns•port will not add the address.  Click the CLOSE button on the button bar to 
close the Add Vendor Address window and return to the Vendors list window.  

14.5.5 Assigning Work Classifications to Vendors  

To assign a work classification to a vendor, select the vendor in the Vendors list window 
and click the WORKCLASS button. Trns•port displays a Work Classifications list window 
(see Figure 14-18).  
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Figure 14-18. Work Classifications List Window 

Press INSERT or choose Add from the right mouse button menu to display the Add Work 
Classification window (see Figure 14-19).  

 
Figure 14-19. Add Work Classification Window 

To create a complete record you must enter information in these fields:  

Work Classification  

 

A value, which must be selected from the 
attached VWRKCLS code table, which 
identifies the classification of work the 
vendor is qualified to perform.  

Qualification Amount (For This 
Class)  

 

The total dollar value of contracts for 
which the vendor is qualified to work. 
Defaults to zero.  

If you want to add more than one work classification for this vendor, click ADD MORE. 
When you finish adding a work classification for this vendor, click OK to return to the 
Work Classifications list window.  Click the CLOSE button on the button bar to close the 
Add Work Classification window and return to the Vendors list window.  
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14.5.6 Adding Vendor Insurance  

To add vendor insurance information, select the vendor from the Vendors list window 
and click the INSURE button to display the Insurance Data list window (see Figure 14-20).  

 
Figure 14-20. Insurance Data List Window 

Choose Add from the right mouse button menu.  Trns•port displays the Add Vendor 
Insurance window (see Figure 14-21).  

 
Figure 14-21. Add Vendor Insurance Window 

To create a complete record you must enter information in these fields:  

Ins. Sequence No.  

 

A sequential number used to identify one 
of multiple insurance policies for a single 
vendor.  
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Insurance Type  

 

A value, which must be selected from the 
attached INSTYPE code table, that 
identifies the type of insurance policy; for 
example, general liability, umbrella, 
worker’s compensation.  

You are not required to, but you can enter information in these fields to record additional 
information about a vendor’s insurance:  

Agent Agent who sold the contractor the 
insurance policy.  

Begin Date Date insurance policy takes effect.  

Comment Space for additional information about 
the insurance policy.  

Company Code  

 

The vendor number of the insurance 
company underwriting the insurance 
policy.  

Contract ID A unique identifier for a proposal or 
contract.  

Expiration Date  

 

The date on which the vendor’s work 
certification or insurance policy expires.  

Insurance Status  

 

A value, which must be selected from the 
attached INSSTAT code table, that 
indicates whether insurance is active, a 
binder, canceled or expired. 

Phone Number Phone number for agent or insurance 
company.  

Policy No. Policy number for the contractor’s 
insurance policies 

Click OK to save the new insurance information, ADD MORE to add another insurance 
record for the same vendor, or CANCEL to return to the Insurance list window without 
adding a record.  

14.5.7 List Vendor Insurance Data  

You can produce a listing of vendor insurance data, including an Insurance Expiration 
Letter and an Insurance Updates report.  

To generate this information, select Run Process from the File menu and choose List 
Vendor Insurance Data from the Processes window.  Trns•port displays a Confirm 
Process Submission window.  

Click SUBMIT to submit the process, PARAMETERS to change process submission 
information, or CANCEL to return to the Vendors list window without submitting the 
process.  

14.5.8 Adding Vendor Affiliate Information  

To add affiliate information for a vendor, select the vendor from the Vendors list window. 
Click the AFFILS button to display the Affiliations list window (see Figure 14-22).  
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Figure 14-22. Affiliations List Window 

Press INSERT or select Add from the right mouse button menu to display the Add Affiliate 
window (see Figure 14-23).  

 
Figure 14-23. Add Affiliate Window 

To create a complete record you must enter information in these fields:  

Affiliate Number  

 

The name of the vendor associated 
with another vendor.  All references 
to vendors are validated with the 
Vendor file.  

Relation to Vendor  

 

A value, selected from the attached 
RELAT code table, which indicates the 
relationship between a vendor and its 
affiliate.  

You are not required to, but you can enter information in these fields to record additional 
information about a vendor’s affiliates:  
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Percent Ownership The vendor's percentage of 
ownership of the affiliated company.  

 

Click OK to add the affiliate information and return to the Affiliations list window or click 
ADD MORE to add another affiliate.  Click the CLOSE button on the button bar to close the 
Affiliations list window and return to the Vendors list window.  

14.5.9 Adding Officer Information for a Vendor  

Officers are persons who are authorized to sign for a contractor.  To add officer data for 
a vendor, select a vendor from the Vendors list window and click the OFFICERS button to 
display the Officers list window (see Figure 14-24).  

 
Figure 14-24. Officers List Window 

You can add values by pressing INSERT or choosing Add from the right mouse button 
menu.  Trns•port displays the Add Officer window (see Figure 14-25).  

 
Figure 14-25. Add Officer Window 

Maintaining Reference Tables - PES  14-23 



Proposal Estimating System and Letting & Award System Guide              12/22/2006 

To create a complete record you must enter information in this field: 

Vendor Officer The name of an officer for a vendor. 

 You are not required to, but you can enter information in these fields to record 
additional information about a vendor officers:  

Address Seq. No. A sequential number used to identify 
one of multiple addresses for a single 
vendor, which corresponds to the 
vendor officer’s address. 

Address Type A value, which must be selected from 
the ADDRTYP code table that 
indicates the type of address for the 
vendor (for example, billing or 
shipping) when a vendor has multiple 
addresses 

Officer's Address Number  

 

The vendor address sequence 
number identifying the vendor 
officer's address.  

Social Security Number  

 

The social security number of the 
vendor officer. 

Title of Officer The title of a vendor officer. 

Click OK to add the officer information and return to the Officers list window or click ADD 
MORE to add another officer. Click the CLOSE button on the button bar to close the 
Officers list window and return to the Vendors list window.  

14.5.10 Producing a List of Vendors and Vendor Insurance Data Reports  

To produce a list of vendors and a list of vendor insurance data, select one or more 
vendors from the Vendors list window.  (You can select more than one vendor by holding 
down CTRL while you select vendors with the mouse.)  Choose Run Process from the 
File menu to display the Processes window.  

To produce a list of vendors, choose List Vendors and click OK to display the Select 
Vendor Listings window (see Figure 14-26).  

 
Figure 14-26. Select Vendor Listings Window 
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Select the parts of the report you want to print by clicking in the boxes. Then click 
SUBMIT to submit the process, PARAMETERS to change process submission information, or 
CANCEL to return to the Vendors list window without submitting the process. 

To produce a list of vendor insurance data, select List Vendor Insurance from the 
Processes window as described above.  

14.5.11 Producing an Alphabetized List of Vendors  

To produce an alphabetized list of vendors, select the vendors you want listed in the 
report from the Vendors list window.  (You can select more than one vendor by holding 
down CTRL while you select vendors with the mouse.)  Choose Run Process from the 
File menu to display the Processes window.  

Choose List of Alphabetized Vendors and click OK to submit the batch process. 

14.5.12 Generating Vendor Mailing Labels  

To generate mailing labels, select one or more vendors from the Vendors list window.  To 
produce a list of vendors, choose List Vendors and click OK to display the Select Vendor 
Listings window.  

Select the vendors for which you want mailing labels generated.  (You can select more 
than one vendor by holding down CTRL while you select vendors with the mouse.)  Then 
choose Run Process from the right mouse button menu to display the Processes 
window.  

Choose Generate Vendor Mailing Labels from the Processes window.  Trns•port displays 
the Mailing Label Parameters window (see Figure 14-27).  

 
Figure 14-27. Mailing Label Parameters Window 

Enter the number of labels you want generated for each vendor (1,2,3 or a whole page) 
and the address number to be used in the labels (the default is “01”).  Then click SUBMIT 
to submit the process, PARAMETERS to change process submission information, or CANCEL 
to return to the Vendors list window without submitting the process.   

14.6 Price Index List  

If you choose Price Index List from the Reference Tables menu, Trns•port displays 
the Price Indices list window (see Figure 14-28).  
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Figure 14-28. Price Indices List Window 

14.6.1 Adding a Price Index  

To add a new price index, press INSERT or choose Add from the right mouse button 
menu.  Trns•port displays the Add Price Index window (see Figure 14-29).  

 
Figure 14-29. Add Price Index Window 

To create a complete record you must enter information in these fields:   

Description A short description of the price index. 

Price Index Unit  

 

A value, which you must select from 
the attached list, that indicates 
Trns•port  should automatically 
adjust item prices for inflation 
according to the index.  Choose from 
the attached drop-down list. 

When you finish adding information, click OK to save the record, ADD MORE to add another 
price index, or CANCEL to return to the Price Indices list window without saving.  
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14.6.2 Changing a Price Index  

To change an existing record, select the record in the Price Indices list window and click 
the PRCIDX button or choose Price Index from the right mouse button menu.  Trns•port 
displays a Price Index window (see Figure 14-30).  

 
Figure 14-30. Price Index Window 

You can change information in any field except the Price Index field.  When you finish 
making changes, click OK to save the changes or CANCEL to return to the Price Indices list 
window without saving.  

14.6.3 Deleting a Price Index  

To delete a price index, select the record in the Price Indices list window and select 
Delete from the right mouse button menu.  Trns•port displays a series of delete warning 
windows. Click YES in each of the windows if you are sure you want to delete the record.  

14.6.4 Adding Item Price Index Adjustments  

To add item price index adjustments, select a price index from the Price Indices list 
window and click the IDXADJ button or choose Price Index Adjustment List from the 
right mouse button menu.  Trns•port displays the Item Price Index Adjustments list 
window (see Figure 14-31).  

 
Figure 14-31. Item Price Index Adjustments List Window 
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To add an item price index adjustment, press INSERT or choose Add from the right 
mouse button menu.  Trns•port displays the Add Price Index Adjustment window (see 
Figure 14-32).  

 
Figure 14-32. Add Price Index Adjustment Window 

To create a complete record you must enter information in these fields:  

Spec Year This field tells which specification year’s 
item list is to be used for this particular 
item and is vital to Trns•port processing.  
All items within a single project must 
have the same spec year and must 
match the spec year for the project. 

Item Number The number used in your agency’s 
documents to identify a particular item.    

Index Percent of Item Value  

 

A method of expressing the relationship 
of the item to the index.  This value is 
the percentage of the item (in terms of 
its value) that the index affects.  For 
example, if 25 percent of an item is gas, 
and this were a gas adjustment index, a 
value of 25.00 would be entered. 

Adjustment Type Code  

 

A coded value representing the kind of 
price adjustment applied to the item.  

Index Quantity Per Item Unit  

 

Another method of expressing the 
relationship of the item to the index.  
This value is the number of units of the 
index per units of the item.  In the 
example used above for the Index 
Percent of Item Value field, one unit of 
gas would be used for every four units of 
the item.  
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Threshold Percent  

 

If the percentage change between the 
adjustment payment for the item and the 
original price of the item is less than or 
equal to this value, then no adjustment is 
made in the payment process.  The 
percentage difference between the 
original item cost and the adjusted cost 
must be greater than this threshold 
percent to take the index into account.  
The default Threshold Percent is none. 

Comment A short description or comment about the 
particular index. 

When you finish adding information, click OK to save the record, ADD MORE to add another 
record, or CANCEL to return to the Item Price Index Adjustments list window without 
saving.  

14.6.5 Changing Item Price Index Adjustments  

To change information, select an item price index adjustment and click the IDXADJ button 
or choose Item Price Index Adjustment from the right mouse button menu.  
Trns•port displays the Adjustment window.  

You can change information in any fields except Spec Year, Item Number, or Item 
Description. When you finish making changes, click OK to save your changes or CANCEL to 
return to the Item Price Index Adjustments window without saving.  

14.6.6 Deleting Item Price Index Adjustments  

To delete a price index adjustment, select the record in the Item Price Index 
Adjustments list window and select Delete from the right mouse button menu.  
Trns•port displays a series of delete warning windows. Click YES in each of the windows if 
you are sure you want to delete the record.  

14.6.7 Adding Price Index Histories  

To work with price index histories, select a price index from the Price Indices list window 
and click the HISTORY button or choose Price Index History List from the right mouse 
button menu.  Trns•port displays the Price Index Histories list window (see Figure 14-
33).  
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Figure 14-33. Price Index Histories List Window 

To add a price index history, press INSERT or choose Add from the right mouse button 
menu.  Trns•port displays the Add Price Index History window (see Figure 14-34).  

 
Figure 14-34. Add Price Index History Window 

To create a complete record you must enter information in these fields:   

Date The date the index becomes 
effective.  If the payment of the item 
is prior to this date, no adjustment 
will be made.  The date and time will 
automatically be entered into 
Trns•port.  

Value as of this Date  

 

The price of the item as of the date 
stated.  This value will be used based 
on the payment date and the value 
associated with the item at that time.  

Click OK to save the index history, ADD MORE to add another record, or CANCEL to return to 
the Price Index Histories list window without adding a record.  
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14.6.8 Changing Price Index Histories  

To change an existing price index history record, select the record from the Price Index 
Histories list window and click the HISTORY button or choose Price Index History 
Record from the right mouse button menu.  Trns•port displays a History Record 
window.  

You can only change the Value as of this Date field. When you finish making changes, 
click OK to save the changes or CANCEL to return to the Price Index Histories list window 
without saving.  

14.6.9 Deleting Price Index Histories  

To delete a price index history, select the record in the Price Index Histories list window 
and select Delete from the right mouse button menu.  Trns•port displays a series of 
delete warning windows. Click YES in each of the windows if you are sure you want to 
delete the record.  

14.6.10 Producing A Price Indices List  

To produce a Price Indices report listing, select the price index or indexes for which you 
want to generate the listing. Choose Run Process from the right mouse button menu to 
display a Processes window.  

Select List Price Indices and click OK to run a process and print the listing.  

14.7 Special Provisions List  

If you choose Special Provisions List from the Reference Tables menu, Trns•port 
displays the Special Provisions list window (see Figure 14-35).  

 
Figure 14-35. Special Provisions List Window 

 Note:  Currently NJ does not use Special Provisions.  The information here is 
meant for reference only. 

14.7.1 Adding a Special Provision  

To add a special provision to the reference table, press INSERT or choose Add from the 
right mouse button menu.  Trns•port displays the Add Special Provision window (see 
Figure 14-36).  
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Figure 14-36. Add Special Provision Window 

To create a complete record you must enter information in these fields:   

Description A short description of the special 
provision. 

Special Provision Code  

 

A unique identifier for a special provision.  

Special Provision Type  

 

A coded value indicating the type of 
special provision.    

You are not required to, but you can enter information in these fields to record additional 
information about a special provision:  

Number of 
Pages  

The number of pages of the special provision.    

Obsolete  Indicates whether the special provision is in effect or obsolete.  

Original Date 
of 
Specification  

The date a special provision is effective.  

Special 
Provision Text 
File Name  

A field that identifies the library member of which the special 
provision is a part.  

When you finish adding information, click OK to save the new special provision, ADD MORE 
to add another record, or CANCEL to return to the Special Provision list window without 
saving.  

14.7.2 Changing Special Provisions  

To change a special provision record, select the record from the Special Provision list 
window and click the SPECPROV button or choose Special Provision from the right 
mouse button menu.  

Click CHANGE to begin changing information.  You can change information in any field 
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except the Special Provision Code field. When you finish making changes, click OK to 
save the changes or CANCEL to return to the Special Provisions list window without 
saving.  

14.7.3 Deleting Special Provisions  

To delete a special provision, select the record in the special Provisions list window and 
select Delete from the right mouse button menu.  Trns•port displays a series of delete 
warning windows. Click YES in each of the windows if you are sure you want to delete the 
record.  

14.7.4 Adding or Changing the Long Description  

To add or change special provision text, select a special provision from the Special 
Provisions list window and click the TEXT button or choose Special Provision Text from 
the right mouse button menu.  Trns•port displays a Long Description window (see Figure 
14-37).  

 
Figure 14-37. Long Description Window 

You can click anywhere in the window to begin typing in new information.  To change 
existing text, drag over it to select it and begin typing. Text will wrap automatically at 
the end of each line. If you want to begin typing a new paragraph, press ENTER.  

When you finish changing the text, click OK to save the changes or CANCEL to return to 
the Special Provisions list window without saving.  

14.7.5 Producing a Special Provisions List  

To produce the Special Provisions report listing, select the provision or provisions for 
which you want to generate the listing. Choose Run Process from the right mouse 
button menu to display a Processes window.  

Select Special Provisions and click OK to run a process and print the listing.  

14.8 Code Table List  

Only authorized staff will be able to add and change code table information.  If you are 
authorized to change code tables and you choose Code Table List from the Reference 
Tables menu, Trns•port displays the Code Tables list window (see Figure 14-38).  
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Figure 14-38. Code Tables List Window 

14.8.1 Adding a Code Table  

To add a code table, press INSERT or choose Add from the right mouse button menu.  
Trns•port displays the Add Code Table window (see Figure 14-39).  

 
Figure 14-39. Add Code Table Window 

To create a complete record you must enter information in these fields:   

Code Table A unique identifier of the code table that 
contains the code values and descriptions 
within this code table. 

Description A forty-character field containing the long 
description of the code value. 

Click OK to save the record, ADD MORE to add another code table, or CANCEL to return to the 
Code Tables list window without saving.  
14.8.2 Changing a Code Table  

To change a code table record in the reference table, select a code table from the Code 
Tables list window and click the CODETBL button or choose Change from the right mouse 
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button menu.  Trns•port displays a Code Table window.  

Click the CHANGE button to make changes.  You can change the description, but not the 
Code Table field. When you finish changing the description, click OK to save the changes 
or CANCEL to return to the Code Tables list window without making changes.  

14.8.3 Deleting a Code Table  

To delete a code table, select the record in the Code Table list window and select Delete 
from the right mouse button menu.  Trns•port displays a series of delete warning 
windows. Click YES in each of the windows if you are sure you want to delete the record.  

14.8.4 Adding a Code Table Entry  

To add an entry in a code table, select the code table from the Code Tables list window 
and click the ENTRY button. (You can also select Code Table Entries from the right 
mouse button menu.) Trns•port displays an Entries list window (see Figure 14-40).  

 
Figure 14-40. Entries List Window 

To add an entry, press INSERT or choose Add from the right mouse button menu.  
Trns•port displays the Add Entry window (see Figure 14-41).  

 
Figure 14-41. Add Entry Window 
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To create a complete record you must enter information in these fields:   

Code Value 

 

A four-character identifier of the longer 
description. This field can be either 
numeric or alphabetic, and uniquely 
identifies the code entry. 

Code Description A forty-character field containing the long 
description of the code value. 

 
When you finish adding information, click OK to add a new code table entry, ADD 
MORE to add another record, or CANCEL to return to the Code Tables list window 
without adding a record.  

14.8.5 Changing a Code Table Entry  

To change an entry in a code table, select the code table from the Code Tables list 
window and click the ENTRY button. (You can also select Code Table Entries from the 
right mouse button menu.) Trns•port displays the Entries list window.  

Choose Change from the right mouse button menu.  Trns•port displays an Entry 
window.  

You cannot change the Code Value field. Click OK when you finish adding information.  
Click ADD MORE to add another entry or CANCEL to return to the Entries list window without 
changing an entry.  

14.8.6 Deleting a Code Table Entry  

To delete a code table entry, select the record in the Entries list window and select 
Delete from the right mouse button menu.  Trns•port displays a series of delete warning 
windows. Click YES in each of the windows if you are sure you want to delete the record.  

14.8.7 Producing a Code Tables List  

To produce a code tables report listing, select the code table or code tables you want to 
list in the Code Tables list window and choose Run Process from the right mouse button 
menu to display a Processes window.  

Select List Code Tables and click OK to run a process to print the listing.  
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Appendix A. Contract and Project Work Types Contract 
Classification 

Frequently, highway construction projects and contracts are classified into 
general classifications such as new construction, rehabilitation, widening, 
preventative maintenance, etc. While these improvement type classifications 
are important for program budgeting and reporting purposes, they are 
limited for the purpose of classifying contracts based on task functionality. 
For example, some widening jobs are heavy on asphalt items while others 
are heavy on earthwork, drainage and/or concrete items. Better functional 
classification of contracts allows more accurate market determination, which 
will improve the State’s ability to examine competition and bidding issues 
using the BAMS/DSS system. From an estimating perspective, work type 
(and major item) classifications can be used effectively to improve project 
cost estimation using CES and/or Trns•port Estimator®. 

A recommended list of contract work types is provided in the following table. 
Using these functional work types allows for better identification and 
grouping of like contracts for the purpose of determining and analyzing the 
markets where like contractors interact for various contracting functions (e.g. 
asphalt, earthwork, structures). Also, since Trns•port BAMS/DSS® is the 
source for historical bid prices, consistent use of work type and item 
classifications across all Trns•port modules facilitates enhanced bid-based 
pricing for cost estimating. 

The Job Work Type variable (JOB.jobworktype) in CES, which corresponds to 
the Contract Work Type variable (DPROPOSL.cnprpwrk) in BAMS/DSS, can be 
used to store the functional classification. 

The general construction classifications (new construction, widening and 
resurfacing, etc.) should also be entered for each project. For example, the 
Job Type variable (JOB.jobtype) in CES can be used to store these 
improvement type classifications. 

To a large extent, the functional classification of contracts is a subjective 
process that requires the exercise of judgment. Generally, we can classify the 
contracts according to what functions are likely to control the award of the 
job as measured by the major item dollar percentages. Absent special 
circumstances, such as a high degree of specialty work or lump sum items, a 
major item concentration of 35 percent or greater is usually considered as 
determinative of work type classification. Many contracts will not fall neatly 
into any particular category, with the dollars evenly divided across more than 
one major item. In such cases, a General Construction work type code may 
be appropriate. 

In practice, contract work types initially assigned in CES can be reviewed and 
revised later when the detailed line items have been fully specified for the 
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project.  For example, when the data is finally passed to BAMS/DSS, work 
type coding can be re-evaluated for data analysis purposes using the 
Contract Profile Ad Hoc program that summarizes the contract dollar 
percentages by item classification.  

Table A-1. NJDOT Project and Contract Work Types 

Work Type 
Code 

Work Type Classification Description Examples 

ASPH Primarily asphalt work.  
Typically over 35 percent asphalt item dollars. 

NEW 
CONSTRUCTION 
RESURFACING 
RECONSTRUCTION 
BITUMINOUS 
PAVEMENT 

BRPT Bridge painting and cleaning BRIDGE PAINTING 
BRIDGE 
CLEANING 

CONC Primarily Portland cement concrete work CONCRETE 
PAVEMENT 

CURB Curbs, sidewalks, and gutters CURB & GUTTER 

DRNG Drainage work and Erosion control 
Drainage projects are those involving primarily 
the non-incidental improvement to drainage or 
erosion control. Drainage projects may include 
the installation/rebuilding of box culverts, 
ditches, inlets, gutters, and/or piping 
structures. Erosion control may include the 
installation of rip rap, wire mesh netting, 
construction of sediment ponds, slope 
stabilization, retaining walls, etc. 

CULVERTS 
DITCHES 
DRAINAGE 
EROSION 
CONTROL 

ERTH Earthwork EARTHWORK 
EXCAVATION 
GRADING 

FENC Fencing FENCES 
GATES 

GDRL Guiderail 
Guiderail refers to the non-incidental 
installation of guiderail upon an existing facility. 
Installation of guiderail should be the primary 
activity related to contracts of this 
classification. 

GUIDERAIL 
MEDIAN 
CROSSOVER 
PROTECTION 

GENC General construction 
Typically 20 percent or more individually 
allocated to paving (asphalt or concrete), 
earthwork (and/or drainage), and structures. 
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Work Type Work Type Classification Description Examples 
Code 

INTC Interchange 
Interchange work includes new interchange 
construction and the reconstruction or widening 
of an existing interchange. New interchange 
projects involve the construction of a new 
facility or structure that allows the junction of 
highways, usually on different levels – thereby 
permitting traffic to move from one to another 
without crossing traffic streams. The facility 
construction includes the connected entrance 
and exit ramps. Interchange projects will be of 
varying complexity and widely varying cost 
depending on the nature and location of the 
conjoining roadways and the nature of the 
improvement. Typical interchange projects 
include improvements made to “diamond” and 
“at-grade” interchanges, while complex 
interchange projects include improvements 
made to cloverleaf interchanges and 
interchanges at the junction of two interstate 
highways, and the like. 

INTERCHANGE 

ITS Intelligent Transportation Systems ITS FACILITIES 
CCTV TRAFFIC 
MONITORING 

JNTS Joints PAVEMENT CRACK 
SEAL 
JOINT REPAIR 

LAND Landscaping LANDSCAPING 
MOWING 

LTNG Lighting LIGHTING 
RELAMPING 

MISC Miscellaneous 
Includes non-incidental specialty work in 
separate contracts not covered by another work 
type classification.  

EMERGENCY 
STANDBY 
MACHINE 
SWEEPING 
NOISE BARRIERS 
PAVEMENT 
CLEANING 
REST AREAS 

PVMK Pavement marking PAVEMENT 
MARKING 

RMVL Removal of buildings DEMOLITION OF 
BUILDINGS 

SGNL Signals 
Non-incidental improvements to signalization at 

TRAFFIC SIGNALS 
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Work Type Work Type Classification Description Examples 
Code 

intersections. 

SIGN Signs 
Non-incidental improvements to signing. 

SIGNING 

SRFP Surface prep MILLING 
RUMBLE STRIPS 

STRL Structures – large 
Typically over $500,000, but more importantly 
bid on by large structures contractors. 

BRIDGE 
REPAIR/REHAB 
BRIDGE 
RECONSTRUCTION 

STRS Structures – small 
Typically under $500,000, but more importantly 
bid on by small structures contractors. 

BRIDGE 
REPAIR/REHAB 

UTIL Utility work 
Includes potable water, gas mains, telephone 
and electric utility work. 

UTILITIES 
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Appendix B. NJDOT Project/Job/Proposal Construction 
Classifications   

Table B-1. NJDOT Project/Job/Proposal Construction Classifications 

Type Description 

1. New Construction New construction or major reconstruction of 
divided or undivided highways. Includes all major 
phases of construction site preparation, earthwork, 
drainage, structures, paving, etc. whether 
contracted separately or as a complete project. 
Minor items such as signing, landscaping and 
guiderail are included unless they are in separate 
specialty contracts. If Maintenance of Traffic will 
include two or more stages or if extensive 
Maintenance of Traffic equipment is needed, use 
Class 2. 

2. Reconstruction, 
Widening and 
Dualization  

The removal and replacement, rebuilding or 
upgrading of an existing facility, including 
intersections. There may be grade changes but 
normally the changes will not be significant. 
Includes all phases of construction. May include 
short utility relocations, placement and/or 
relocations of Intelligent Transportation Systems 
(ITS) facilities. Includes widening equivalent to one 
lane width or wider. Includes structures when 
decks are replaced on existing substructures or 
decks are widened and substructures extended. 
Includes intersection improvements when roadway 
area is also rebuilt. 

3. Widening and 
Resurfacing  

Widening and resurfacing of existing highway 
facilities when the total added width is equivalent 
to less than one lane width in each direction and 
grades are not changed. Includes minor grading, 
extending culverts, curb and gutter, etc. Includes 
bridge deck widening possibly without substructure 
changes. May require relocations of ITS facilities. 
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Type Description 

4. Resurfacing Overlaying existing highways, and surfacing or 
overlaying existing shoulders with asphaltic 
material. Includes joint repair, minor widening with 
asphaltic materials, some base corrections or 
asphaltic base, curb and gutter replacement, and 
adjustments at structures, drives and street 
returns. Does not include extensive reconstruction, 
pavement replacement or construction of new 
pavements, excavation, utility or sewer work. 
Projects with milling operations may involve 
reconstruction of ITS device pavement sensors. 

5. Bridge Repair Repair of bridges, includes repairs to decks, curbs, 
rails, beams and structures. If total deck removal 
and replacement is required, the contract should 
be classified as reconstruction. Bridge Repair also 
includes bridge painting, which consists of the 
removal of lead based paint and the application of 
a high performance coating system. 

6. Intersection 
Improvements 

Minor construction or reconstruction of street or 
highway intersections. Normally includes some 
removal, grading, drainage and paving. May 
include curb and sidewalk along with traffic signals 
installed at the intersection. If intersection 
pavement is to be rebuilt, the contract should be 
classified as reconstruction. 

7. Electrical, Safety, and 
Traffic Control 

Placement, replacement and betterment of 
guiderail, signs, striping, traffic signals, highway 
lighting, sign lighting, electrical signs, movable 
bridge electrical systems and other safety and 
traffic control devices, along streets and highways, 
when let on a specialty contract basis. If electrical, 
safety and traffic control devices are included as 
part of a major contract type, they should be 
included under the miscellaneous activities for that 
type. 

8. Miscellaneous  Construction activities, let on a specialty contract 
basis, not assignable to other work classes. 
Includes demolition of buildings, removal of 
asbestos, and railroad pavement painting. 
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Type Description 

9. Unique Construction activities of a distinctive nature, 
which is let on a specialty contract basis. Includes 
wetland replacement and restoration. 

10. Intelligent 
Transportation 
Systems (ITS) 

Construction of ITS devices and communication 
networks. Systems include computerized traffic 
signal control, dynamic message signs, closed 
circuit television, highway advisory radio, fiber 
optics and wireless technologies, traffic detection, 
weather station and data development traffic 
monitoring. Includes the integration of proposed 
devices with Traffic Operation Centers central 
control systems and interagency resource sharing 
through the regional and statewide ITS 
Architectures. If ITS systems are included as part 
of a major contract type, they should be included 
under the miscellaneous activities for that type. 

11. Landscape Design and installation of landscape architectural 
elements to enhance transportation facilities or to 
mitigate environmental and negative effects 
caused by transportation facility improvements. 
Work includes functional, aesthetic and safety 
plantings, reforestation, wetland mitigation, urban 
streetscapes, bicycle and pedestrian 
improvements, and structures aesthetics. This 
work may be part of other contracts or as 
independent contracts. 

12. Demolition Advanced Demolition of Buildings - the demolition 
and removal of buildings and appurtenances within 
acquired ROW, in advance of the main construction 
contract. Clearing Site, Underground Storage Tank 
Removal, Sealing of Abandoned Wells, and 
Asbestos Remediation could be included in this 
type of project. 

13. Drainage Includes cleaning, inspecting, capacity restoration 
and in-kind repairs to highway drainage facilities. 
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Appendix C. Sample Output and Explanations of Weighted 
Averages and Regression Analysis 
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